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Preface

Audience for This Guide
Welcome to Release 11i of the Oracle Scripting Implementation Guide.

This guide assumes you have a working knowledge of the following:

� The principles and customary practices of your business area.

� Oracle Scripting

If you have never used Oracle Scripting, Oracle suggests you attend one or 
more of the Oracle Scripting training classes available through Oracle 
University.

� The Oracle Applications graphical user interface.

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This guide contains the information you need to understand and use Oracle 
Scripting. Sections include:

Dependency Requirements and Verification includes information on mandatory 
and conditional dependencies, installation and verification.

The Introduction includes overviews of Oracle Interaction Center and Oracle 
Scripting, including what’s new and what is obsolete in this release of Oracle 
Scripting.
xi



Technology, Requirements, and Performance includes an architectural overview, 
as well as minimum software and hardware requirements, and scalability and 
performance guidelines.

Dependency Requirements and Verification includes mandatory and conditional 
dependencies, as well as installation and dependency verification information.

The Implementation Overview includes a process Description and an overview of 
the implementation tasks for various components of Oracle Scripting.

Implementing Oracle Scripting includes a description of top-level implementation 
steps, and specific tasks for implementing each Scripting component: the Script 
Author, the Scripting Engine Component, and the Survey Component.

Administering Oracle Scripting includes Oracle Applications-level administration 
tasks directly related to implementing Oracle Scripting. These are all required for 
the Survey component of Oracle Scripting only.

Verifying the Implementation includes a description of tasks to verify each 
component of Oracle Scripting.

Diagnostics and Troubleshooting includes troubleshooting tips and problem 
remediation tasks for implementing Oracle Scripting.

Appendix A, Upgrading from Previous Releases, provides specific information for 
upgrading from a previous11i release of Oracle Scripting.

There are also Glossary and Acronyms appendices to assist you in decoding many 
terms, acronyms and abbreviations.

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/. 
xii
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Accessibility of Code Examples in Documentation
JAWS, a Windows screen reader, may not always correctly read the code examples 
in this document. The conventions for writing code require that closing braces 
should appear on an otherwise empty line; however, JAWS may not always read a 
line of text that consists solely of a bracket or brace. 

Accessibility of Links to External Web Sites in Documentation 
This documentation may contain links to Web sites of other companies or 
organizations that Oracle Corporation does not own or control. Oracle Corporation 
neither evaluates nor makes any representations regarding the accessibility of these 
Web sites. 

Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Scripting.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Some 
online help patches are available on OracleMetaLink. Oracle Scripting online help is 
only available with installation of Oracle Scripting release 11.5.6 or later.

Related Documentation
Oracle Scripting shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle Scripting.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.
xiii

http://oraclestore.oracle.com


Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Scripting (and 
any other Oracle Applications products). This guide also includes information on 
setting user profiles, as well as running and reviewing reports and concurrent 
processes.

You can access this user’s guide online by choosing "Getting Started with Oracle 
Applications" from any Oracle Applications help file.

Documents Related to This Product

Oracle Scripting Implementation Guide 11i
This guide describes how to implement Oracle Scripting components and test the 
implementation appropriately.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.
xiv



Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the 
CRM products. The steps should be done immediately following that tasks given in 
the Installing Oracle Applications guide.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
xv



products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Multiple Reporting Currencies in Oracle Applications
If you use the Multiple Reporting Currencies feature to record transactions in more 
than one currency, use this manual before implementing Oracle Scripting. This 
manual details additional steps and setup considerations for implementing Oracle 
Scripting with this feature.

Multiple Organizations in Oracle Applications
This guide describes how to set up and use Oracle Scripting with Oracle 
Applications' Multiple Organization support feature, so you can define and support 
different organization structures when running a single installation of Oracle 
Scripting.

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes.You also use 
this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Scripting implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This manual also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on OracleMetaLink
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Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Scripting 
and reach full productivity quickly. You have a choice of educational environments. 
You can attend courses offered by Oracle University at any one of our many 
Education Centers, you can arrange for our trainers to teach at your facility, or you 
can use Oracle Learning Network (OLN), Oracle University's online education 
utility. In addition, Oracle training professionals can tailor standard courses or 
develop custom courses to meet your needs. For example, you may want to use 
your organization structure, terminology, and data as examples in a customized 
training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Scripting working for 
you. This team includes your Technical Representative, Account Manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle8i server, and your hardware and software 
environment.
xvii



OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use OracleMetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.
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About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
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Introd
1

Introduction

The following topics are included in this topic group:

� Oracle Interaction Center Overview

� Oracle Scripting Overview

� New in this Release

� Obsolete in this Release

1.1 Oracle Interaction Center Overview
Every customer interaction — a telephone call, an e-mail message, or a Web chat 
conversation — presents an opportunity to win new business or improve customer 
satisfaction. The Oracle Interaction Center supports the management and 
processing of customer relationship activity across all channels of customer contact.

The Oracle Interaction Center integrates with several customer relationship 
business applications in the Oracle eBusiness Suite. The Oracle Interaction Center 
consists of several modules. The modules relating to inbound telephony and 
outbound telephony are bundled separately.

The Oracle Interaction Center allows access to centralized customer information 
and business application functionality. Oracle Interaction Center integrates with 
front office applications (known as Customer Relationship Management or CRM), 
and back office applications (Enterprise Relationship Planning or ERP), thereby 
enabling a workflow powered, end-to-end strategic e-business solution.

 The Oracle Interaction Center products include:

� Oracle Advanced Inbound

� Oracle Advanced Outbound
uction 1-1
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� Oracle eMail Center

� Oracle Scripting

� Oracle Interaction Center Intelligence

1.1.1 Oracle Advanced Inbound
Oracle Advanced Inbound (AI) is required to telephony enable business 
applications in the Oracle eBusiness Suite. "Telephony-enabled" means that the 
product has the capability of communicating with a telephone system for inbound 
calls, outbound calls, or both via the CTI middleware that handles the messaging 
between a telephone switch and the user's application. Oracle Advanced Outbound 
provides the corresponding outbound telephony capability.

The Oracle Advanced Inbound bundle consists of the following products: Call 
Center Technology, Oracle Universal Work Queue, Oracle Telephony Manager, 
Oracle Call Center Connectors, and Oracle Interaction Blending.

See Also
� Oracle Advanced Outbound

� Oracle eMail Center

� Oracle Scripting

� Oracle Interaction Center Intelligence

1.1.2 Oracle Advanced Outbound
Oracle Advanced Outbound (AO) is another key part of the Oracle eBusiness Suite 
of applications. It is the module of Oracle Interaction Center that addresses 
outbound telephony. AO consists of two main components: 

� A tactical list manager, which determines who to call and when to call them 

� An outbound dialing engine, which dials numbers and transfers live contacts to 
call center agents 

Advanced Outbound integrates with and relies on Oracle Marketing Online (OMO) 
to create campaigns and lists to execute. AO serves as the execution arm for these 
marketing lists to maximize both outbound list penetration and agent productivity. 
AO also integrates with desktop applications like Oracle TeleSales and Oracle 
Collections to handle the actual customer interactions. Oracle Advanced Outbound 
can be used any time agents need to contact parties via the telephone. 
1-2 Oracle Scripting Implementation Guide



Oracle Interaction Center Overview
AO also integrates with Oracle Interaction History to provide feedback that 
marketers can use to analyze and measure the success of the marketing campaign, 
thereby providing a closed-loop marketing process. 

Oracle Advanced Outbound does not include any other telephony management 
modules, and thus requires the use of Oracle Advanced Inbound.

See Also
� Oracle Advanced Inbound

� Oracle eMail Center

� Oracle Scripting

� Oracle Interaction Center Intelligence

1.1.3 Oracle eMail Center
Oracle eMail Center (eMC) is designed to satisfy requirements for inbound 
customer support, e-mail interaction management, and outbound sales and 
marketing e-mail message processing.

Oracle eMail Center helps your business respond to e-mail queries with clear and 
comprehensive replies in a much more efficient manner. eMC automatically 
generates suggested responses and scores them according to how closely they 
match the requirements.

See Also
� Oracle Advanced Inbound

� Oracle Advanced Outbound

� Oracle Scripting

� Oracle Interaction Center Intelligence

1.1.4 Oracle Scripting
Oracle Scripting is a set of tools to facilitate the process of gathering of information 
for the benefit of the enterprise. Oracle Scripting is composed of three components: 
the Script Author, the Scripting Engine, and the Survey component.

Each implementation of Oracle Scripting employs at least one customized script 
built by Oracle Consulting, consulting partners, or the enterprise.
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The Script Author is the development tool with which customized business 
requirements are translated into miniature programs known as "scripts." 

The Scripting Engine is responsible for displaying the script to the end user, 
interpreting the end user’s responses to questions and answers, and processing 
custom code developed in support of the script.

The Survey component provides the ability to create, deploy, and manage survey 
campaigns that are based on a single customized script.

See Also
� Oracle Advanced Inbound

� Oracle Advanced Outbound

� Oracle eMail Center

� Oracle Interaction Center Intelligence

1.1.5 Oracle Interaction Center Intelligence 
Oracle Interaction Center Intelligence is a Web-based reporting solution that 
provides intelligent reports that facilitate day-to-day operational and long-term 
strategic decisions.

The data is presented to the user in a easy-to-use portal format. This format gives 
the user a unified, role-based, easily customized view of Interaction Center 
information, including Oracle Universal Work Queue information, key performance 
measures relating to agent productivity, speed to answer, and abandon rate.

The product is built on an Oracle proprietary Java-based technology stack (Oracle 
CRM Foundation, sometimes referred to as Java Technology Foundation or 
JTF).Users of Interaction Center Intelligence require minimal training, and no 
additional software is needed on the user's machine other than a Web browser. 

Oracle Interaction Center Intelligence is based on a three-tier architecture: 

� The front end (client) using the system via an Oracle Applications-compliant 
Web browser. 

� The middle tier, which contains the Apache Web server and application server, 
included as part of the installation of Oracle Applications release 11i. 

� The database tier, using an Oracle 8i or 9i database. 
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See Also
� Oracle Advanced Inbound

� Oracle Advanced Outbound

� Oracle eMail Center

� Oracle Scripting

1.2 Oracle Scripting Overview
This topic group includes the following topics:

� Components of Oracle Scripting

� Oracle Scripting Features

� Oracle Scripting Users

See Also
Oracle Interaction Center Overview

New in this Release

Obsolete in this Release

1.2.1 Components of Oracle Scripting
Oracle Scripting is a set of tools to create and display information sequentially to its 
end users. The information displayed is based (1) on a predetermined set of 
requirements that have been programmed into a script, and (2) on responses 
provided by the end user. End users are guided through a specific flow, which can 
either be rigidly prescribed to enforce consistency, or which can be dynamically 
determined based on answers entered into the graphic user interface (GUI). 

Oracle Scripting is composed of three components: 

� Script Author Component

� Scripting Engine Component

� Survey Component

1.2.1.1 Script Author Component
Script Author is a powerful authoring environment of graphical layout tools to 
create, modify, and deploy scripts. The Script Author is a two-tiered script 
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development studio built in Java. The script developer inserts objects into the script 
in a work area known as the canvas, using an intuitive interface. The developer then 
associates properties to each object. These properties range from the simple (object 
names, labels, or text to display at run time) to the complex (such as Java, PL/SQL, 
or other commands). The objects in the Script Author are linked by various branch 
types to provide a graph that looks similar to a flowchart. In this manner, the 
objects embedded in the script control complicated processing, such as rules-based 
branching and data integration. Scripts built in the Script Author can be run in 
either interface of the Scripting Engine.

See Also
� Scripting Engine Component

� Survey Component

1.2.1.2 Scripting Engine Component
The Scripting Engine is a set of base Java classes that provide for processing of a 
script in runtime. The script provides a customized set of pre-programmed actions 
to take based in part on responses provided by the end user. At runtime, the 
Scripting engine interprets:

� Instructions in the script,

� The end user’s responses to questions and answers, and 

� Custom code referenced in the script. 

Interpretation of Custom Code
Custom code is referenced in the script using commands programmed into the 
script in the Script Author before it is deployed to the database. Based on the type 
of command, the code may be stored in the metadata of the script itself (e.g., 
constant commands or PL/SQL commands), in the Scripting session (Blackboard 
commands), in custom code deployed to the applications server (Java commands), 
or in the database (commands referencing stored PL/SQL packages).

What Information Is Displayed?
Based on the design created in the Script Author, the Scripting Engine can display 
formatted text (including "spoken text" and "instructional text") in each panel of the 
script, and at least one question and answer, to the end user's graphic user interface. 
New to release 11.5.6, the WYSIWYG (What You See Is What You Get) interface 
allows liberally customized display and distribution of formatted text, questions 
and answers in each panel.
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Two Runtime Interfaces
There are two runtime interfaces, both of which receive information from the base 
Java methods that together comprise the Scripting Engine. 

The first is the interaction center agent interface. This is a Java-based GUI launched 
from an Oracle Applications session when an agent starts a script – typically from 
within one of three business applications in the CRM Suite: Oracle TeleSales, Oracle 
TeleService, or (new to release 11.5.6) Oracle Collections. Agents can also launch a 
script in "stand-alone" mode from within an Oracle Applications session, although 
this is recommended primarily for script testing. In current releases, scripts viewed 
in this model present as a Java bean wrapped in an Oracle form. HTML 
interpretation and rendering is provided by Java classes in the SWING library of 
JavaSoft's Java Development Kit (JDK) 1.1.8.

The second interface is the Survey runtime interface, which is essentially HTML 
running Java Server Pages (JSP) in an Oracle Applications 11i-compliant Web 
browser. This runtime interface is intended for individuals to view a script to 
participate in a survey, using their Web browser to access a particular URL. The 
URL specifies a set of parameters that identify an enterprise's Oracle 
Applications-specific Apache Web server, invoke a JSP page for survey operations, 
specify a deployment identification code (or dID), and (for list-based survey 
campaigns), a unique respondent identification code or rID). Accessing this URL 
allows a survey respondent to log into an Oracle Applications session as a guest 
user with survey-specific privileges. In this model, the Scripting Engine interprets 
the respondent's responses, the script, and custom code, passing metadata and 
instructions to the Web browser to be interpreted on the respondent's client 
computer. In addition to a script, survey execution of scripts requires a survey 
campaign to be established and deployed, and requires the presence of additional 
JSP resources (to provide a header for each survey page, an error page to display if 
required, and a final page after completion of the survey).

See Also
� Script Author Component

� Survey Component

1.2.1.3 Survey Component
The survey component of Scripting was previously known as iSurvey. This 
component relies on the concept of a campaign— a focused effort to achieve a 
particular goal from a targeted population over a specific period of time for a 
particular business purpose. The goal of a survey campaign is typically for an 
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enterprise to obtain specific data by polling a target market segment or population 
for subsequent analysis and subsequent action. Typical actions might include the 
offering of a new product or service, or a change in business processes to improve 
satisfaction.

Survey campaigns have requirements that must be defined based on the campaign 
goals (for example: target population, purpose for obtaining the information, which 
information will be gathered, for what purpose, how long the campaign will be 
conducted, and in how many separate deployments of the same requirements). 

The campaign goals are achieved by two processes: creating a survey questionnaire 
built with the campaign goals in mind, and in administering the campaign from the 
enterprise.

The Survey Questionnaire
The survey questionnaire is a Script Author script created to obtain specific 
information. End users of the Survey component are customers or prospects 
viewing a survey questionnaire using any Oracle Applications 11i-compliant Web 
browser. As the individual participating in a survey ("survey respondent") moves 
effortlessly through each HTML page (corresponding to a single script panel in the 
Script Author), the objects embedded in the script control complicated processing.

On the survey respondent’s desktop, the respondent is guided through the script 
either through a rigidly prescribed order, or through a dynamically determined 
path in the survey (as determined by the custom script built based on the needs of 
the enterprise). The survey questionnaire script displays as a series of Java Server 
Pages (JSP) files in an HTML-based interface (the Web browser).

On the Apache Web server associated with the Oracle Applications instance for the 
enterprise conducting the survey, all business logic is executed dynamically. This 
includes the business rules embedded in the survey questionnaire script (such as 
rules-based branching, data integration, and commands associated with specific 
objects and events), the respondent’s answers, and any custom Java or PL/SQL 
code.

The Survey Admin Console
Survey administrators must define the survey campaign requirements in an HTML 
administrative console in order to get this survey questionnaire to its target 
segments. The Survey Admin console is a JSP/HTML-based survey campaign 
administrative interface accessed from the Oracle eBusiness Center HTML login by 
a user with the Survey Administrator Oracle Applications responsibility. In this 
interface, a survey campaign is created and its dependencies (JSP resources, Script 
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Author script designated as the questionnaire, and so on) are defined. Additionally, 
results from a survey (ongoing or completed) can be viewed in various ways from 
the Survey Admin console. Answers provided by respondents are stored in the 
Oracle Applications database schema. A survey administrator can view individual 
responses by accessing the Response tab in the GUI. Survey respondent data is also 
summarized for optimum performance and made available to administrators 
through a set of preexisting Survey reports under the Analysis tab. Additionally, 
custom reports can be generated from tables in the Oracle Applications schema as 
desired.

See Also
Oracle Scripting Features

Oracle Scripting Users

1.2.2 Oracle Scripting Features
This topic group includes the following topics:

Component Features

Oracle Scripting and the Interaction Center Suite

1.2.2.1 Component Features
The Script Author is used to develop scripts for execution in either the Scripting 
Engine or as a survey using the Survey component of Oracle Scripting.

The Scripting Engine can be used in inbound, outbound, or blended interaction 
centers in order to guide agents in their interactions with customers or prospects. 

The Survey component of Oracle Scripting can be used for any purpose for which 
information must be collected and analyzed. Typical uses include customer 
satisfaction surveys, customer interest surveys, new product concept surveys, 
vendor surveys, etc. Survey is helpful not only in obtaining relevant information 
from customers, prospective customers, consumers using competing products or 
services, and the general public, but also from more clearly targeted populations 
such as the employees within a company, shareholders of stock, and so forth.

The applications of the product are unlimited in terms of benefits to enterprises that 
need to survey general or specific populations and process the return data.

� Oracle Scripting release 11.5.6 includes four out-of-the-box reports available to 
assist in analysis from use of Oracle Scripting. All are applicable to survey 
campaigns, and the Footprinting report is useful for interaction center reporting 
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(use of the Scripting Engine). More reports are expected to be available in future 
releases. The information obtained from a survey is stored in the Oracle 
Applications database, and can be accessed using customized SQL scripts or by 
using any tool that can access an Oracle database. 

See Also
Oracle Scripting and the Interaction Center Suite

1.2.3 Oracle Scripting and the Interaction Center Suite
The Scripting Engine provides enterprises a method of scripting interactions with 
customers or prospects and integrating desktop workflow between various 
applications. It is intended to be used in combination with integrated Oracle 
eBusiness applications in the CRM Suite of applications (Oracle TeleSales, Oracle 
TeleService, and Oracle Collections) to take full advantage of the contact handling 
and sales or service features of those applications, respectively. Interaction centers 
leveraging business applications and the Scripting Engine therefore have the full 
benefit of interaction center communications. Both the Scripting Engine and the 
Survey component of Oracle Scripting allow an enterprise to capture customer 
needs, perform market research, and measure customer satisfaction. The Survey 
component is a powerful information gathering tool that allows rapid deployment 
of tailored questionnaires to gather data from various targeted populations. 
Information gained as a result of executing a survey campaign can be used to drive 
new business initiatives, immediately spot customer satisfaction issues, test new 
products or ideas, and provide baseline measures for satisfaction improvement 
programs. This makes the Survey component a strong tool in the CRM toolbox, 
bringing another dimension of intelligence to the 360-degree view of the customer.

See Also
Component Features

1.2.4 Oracle Scripting Users
This topic group includes the following topics:

� Script Author Users

� Scripting Engine Users

� Survey Runtime Users

� Survey Administrative Users
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1.2.4.1  Script Author Users
The Script Author is intended for the functional user with some technical 
knowledge. The Script Author development environment provides for reuse of 
defined commands and existing Scripting components. The script developer will 
define these commands. Hooks in the GUI reference technical components (for 
example, Oracle Forms, custom Java methods, and PL/SQL packages stored in the 
database) which are primarily developed external to the Script Author. These 
components provide sophisticated functions to accomplish the functionality most 
enterprises want. They must be developed by individuals certified and 
knowledgeable in the relevant technologies. The script developer must work with 
these highly technical resources to ensure the custom components are appropriately 
integrated into the script. The script developer must also ensure the code is 
appropriately loaded on the server and referenced in the script. This will ensure the 
code is available to the base Java classes that provide Scripting runtime 
functionality for the Scripting Engine and the Survey component at runtime.

Users of the Script Author may be campaign administrators, Java developers or 
database programmers, business process engineers, or experienced interaction 
center agents with technical aptitude. The keys to successful script development 
are: (1) familiarity with how Oracle Scripting captures and processes data, (2) 
knowledge of associated technologies (including access to experts in these 
technologies), and (3) adequate training and familiarity with existing 
documentation.

No Oracle Applications responsibilities are required to use the Script Author, as this 
is an independent Java environment not requiring login to an Oracle Applications 
session.

See Also
� Scripting Engine Users

� Survey Runtime Users

� Survey Administrative Users

1.2.4.2 Scripting Engine Users
End users of the Scripting Engine are trained interaction center agents ("agents"). 
These are non-technical users who have received simple but thorough training in 
the Java-based Scripting Engine interface. These individuals include call center 
agents taking or presenting information over the telephone, as well as interaction 
center agents taking advantage of other media such as Intranets, enterprise portals 
over the World-Wide Web, and so forth.
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These agents must have access to the appropriate Oracle Applications responsibility 
to launch the integrated business application from which Oracle Scripting is 
integrated. For more information about establishing responsibilities, please refer to 
the Implementation Guide for each specific business application.

See Also
� Script Author Users

� Survey Runtime Users

� Survey Administrative Users

1.2.4.3 Survey Runtime Users
End users of the Survey component of Oracle Scripting from a runtime perspective 
are customers or prospects viewing a script (typically a survey questionnaire) in 
any Oracle Applications-compliant Web browser. These may have been invited to 
participate in a survey through an e-mail message or through navigation to a 
survey-enabled site, or they may have accessed the survey through a self-service 
Web application scenario such as Oracle iSupport. 

No Oracle Applications responsibilities are required to execute a script as a survey 
in a Web browser.

See Also
� Script Author Users

� Scripting Engine Users

� Survey Administrative Users

1.2.4.4 Survey Administrative Users
Users of the JSP/HTML-based survey campaign administrative console are 
non-technical users with access to detailed project requirements. These individuals 
are typically interaction center campaign administrators or system administrators.

To access the Survey Campaign administrative interface from the HTML Login 
URL, these users must have the Survey Administrator Oracle Applications 
responsibility.

See Also
Components of Oracle Scripting
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Oracle Scripting Features

Oracle Scripting and the Interaction Center Suite

1.3 New in this Release
Listed below are new and changed features of Oracle Scripting Release 11i. This 
topic group includes the following topics:

Script Author Installation Package Location

Sticky Mode

Panel Text Editor Access and Label

Data Dictionary Access

Connection Dialog Modifications

Reusable Commands

Reporting Features

Apache Mid-Tier Architecture

WYSIWYG Panel Layout

Profile Setting Modifications

Compiling Custom Code Using JDK 1.1.8

Supported Methods of Packaging Java Bean Code Into a JAR File

See Also
Oracle Interaction Center Overview

Oracle Scripting Overview

Obsolete in this Release

1.3.1 Script Author Installation Package Location
Installation of the Script Author is accomplished using the Oracle Universal 
Installer. As of release 11.5.6, this is obtained as a ZIP file from the APPL_TOP 
(Oracle Applications file system). 
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This is in contrast to earlier releases of Oracle Applications 11i, in which the only 
way to access the Script Author installation package was on the 11i Call Center 
Applications Install CD, or as a ZIP file downloaded from OracleMetalink.

As before, the Script Author can be installed on a computer running any Microsoft 
Windows 95, 98, 2000, or NT operating system.

Download the iesauthr.zip file from the Oracle Applications 11.5.6 or later APPL_
TOP using an Oracle Applications 11i-compliant Web browser by accessing 
http://<server>.<domain>:<port>/OA_HTML/download/ ies/iesauthr.zip. 

For specific information regarding installing the Script Author using the Oracle 
Universal Installer, see the Oracle Applications Supplemental CRM Installation Steps 
Guide for release 11.5.6.

See Also
Sticky Mode

Panel Text Editor Access and Label

Data Dictionary Access

Connection Dialog Modifications

Reusable Commands

Reporting Features

Apache Mid-Tier Architecture

WYSIWYG Panel Layout

Profile Setting Modifications

Compiling Custom Code Using JDK 1.1.8

Supported Methods of Packaging Java Bean Code Into a JAR File

1.3.2 Sticky Mode
This feature affects the behavior in the Script Author GUI in which Script Author 
objects selected from the tool palette are inserted into the visual work area (the 
Script Author "canvas"). Prior to release 11.5.6 of the Script Author, script objects 
such as panels, groups, blocks, or the termination node would default to "sticky 
mode." When a script object is selected in the tool palette, that object tool remains 
"stuck" (selected) until explicitly turned off (by selecting the Toggle Selection Mode 
tool in the tool palette). For example, if the Script Author is open and you select the 
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panel object in the tool palette, each time you click on the canvas, a new panel object 
is inserted. This can result in the unwanted effect of inserting multiple panels when 
your intended result may be to designate properties for a single panel.

The ability to toggle on or off the "sticky mode" attribute of Script Author object 
toolbars is a helpful new feature. Sticky mode is enabled by default in every new 
Script Author session, providing the same functionality as in previous versions. 
However, by deselecting the checkbox next to the new "Sticky Mode" menu item 
(located under the File menu of the Script Author), sticky object menus are 
deselected. This feature remains for the duration of your Script Author session.

See Also
Script Author Installation Package Location

Panel Text Editor Access and Label

Data Dictionary Access

Connection Dialog Modifications

Reusable Commands

Reporting Features

Apache Mid-Tier Architecture

WYSIWYG Panel Layout

Profile Setting Modifications

Compiling Custom Code Using JDK 1.1.8

Supported Methods of Packaging Java Bean Code Into a JAR File

1.3.3 Panel Text Editor Access and Label
The Panel Text Editor in Script Author release 11.5.6 is accessible from the panel 
properties dialog as well as from the main menu and from the toolbar.

Additionally, the Panel Text Editor title bar now displays the name of the panel for 
which the text is associated.

See Also
Script Author Installation Package Location

Sticky Mode
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Data Dictionary Access

Connection Dialog Modifications

Reusable Commands

Reporting Features

Apache Mid-Tier Architecture

WYSIWYG Panel Layout

Profile Setting Modifications

Compiling Custom Code Using JDK 1.1.8

Supported Methods of Packaging Java Bean Code Into a JAR File

1.3.4 Data Dictionary Access
The data dictionary is used to define lookup values, constant commands, validation 
or other commands, or provide database table lookup information. All of these are 
associated with a specific answer for a specific panel. Access to the data dictionary is 
now attained from within the Answer Entry dialog for a specific answer. Access is 
no longer provided from this dialog’s parent window (the Answers pane of the 
Panel Properties dialog).

See Also
Script Author Installation Package Location

Sticky Mode

Panel Text Editor Access and Label

Connection Dialog Modifications

Reusable Commands

Reporting Features

Apache Mid-Tier Architecture

WYSIWYG Panel Layout

Profile Setting Modifications

Compiling Custom Code Using JDK 1.1.8

Supported Methods of Packaging Java Bean Code Into a JAR File
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1.3.5 Connection Dialog Modifications
The Connection dialog (included in the Deploy Script To dialog and in the 
Command properties dialog for a PL/SQL command) has been modified. In 
previous versions, a driver was required to be specified for JDBC to connect to the 
database (oracle.jdbc.driver.OracleDriver). This property is now passed 
automatically by the Script Author application. Further, prior to release 11.5.6, the 
URL field required the following specific syntax string:

jdbc:oracle:thin:@<Server Hostname>:<TNS Port>:<SID>

The URL field has been replaced with separate fields for Server Hostname, TNS 
Port, and SID. The remaining parameters of the retired URL field are now also 
passed automatically by the Script Author application.

See Also
Script Author Installation Package Location

Sticky Mode

Panel Text Editor Access and Label

Data Dictionary Access

Reusable Commands

Reporting Features

Apache Mid-Tier Architecture

WYSIWYG Panel Layout

Profile Setting Modifications

Compiling Custom Code Using JDK 1.1.8

Supported Methods of Packaging Java Bean Code Into a JAR File

1.3.6 Reusable Commands
New to release 11.5.6 of the Script Author is the reusable command framework. The 
full range of Script Author commands (Java, PL/SQL, Blackboard, Forms, and 
Constant commands) can be defined in the command library, which stores the 
commands in the applications database.

Once defined in the command library, commands can be copied and modified in 
the library, removed from the library, and imported into an existing or new script. 
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You must access the command library using Script Author 11.5.6 or later. Accessing 
the command library requires you to enter database connection parameters for the 
specific database instance of the Oracle Scripting command library you wish to use. 
You will remain connected for the duration of the Script Author session.

Defining a Command In the Command Library
Commands are defined in the command library from Script Author 11.5.6 or later. 
You can create a command in the command library from the Script Author at any 
time, and import it to the appropriate location in the script. Select Command 
Library from the Tools menu. Enter database connection information for the 
database instance of the Oracle Scripting command library you wish to access 
(required once per Script Author session). In the Command Library dialog, click 
Add, and define your command as usual. This places the command in the 
command library for immediate or subsequent reuse. 

Importing a Command Into a Script from the Command Library
Once a command (of any type supported by Scripting) is defined in the command 
library, it can be reused by a script developer using the Script Author. In release 
11.5.6, the Script Author Command properties dialog includes a prominent new Use 
Library Command button.

To import a command already defined in the library, click Use Library Command to 
access the list of existing commands. If not connected, you will be prompted for 
database connection parameters to access the appropriate instance. Once entered, 
this connection is maintained for the duration of your Script Author session. 
Highlight the desired command in the resulting list, and click OK. The Command 
properties dialog is now populated with the parameters from the predefined library 
command. At this point, you can save the command in the script as it was 
imported, or modify the command as necessary. 

Note: You must first enter your command in the command library 
to make it available to all scripts, including the current script. In this 
release, there is no method provided to move an already defined 
command from a script to the command library.
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See Also
Script Author Installation Package Location

Sticky Mode

Panel Text Editor Access and Label

Data Dictionary Access

Connection Dialog Modifications

Reporting Features

Apache Mid-Tier Architecture

WYSIWYG Panel Layout

Profile Setting Modifications

Compiling Custom Code Using JDK 1.1.8

Supported Methods of Packaging Java Bean Code Into a JAR File

1.3.7 Reporting Features
New to release 11.5.6 of Oracle Scripting is the ability to generate reports. For 
interaction centers using the Scripting Engine, a new Footprinting report is 
available to display visited panels in a Scripting Engine session. For enterprises 
using the survey component of Oracle Scripting, there are three "canned" reports 
available. Reporting is accessed from the HTML Login URL (sometimes referred to 
as the eBusiness Suite login for CRM HTML-based applications), and requires the 
survey component to be implemented. For the three survey reports, additional 
requirements include execution of concurrent programs and, for any useful data, 
that survey deployments have been executed by one or more survey respondents.

Note: Any modifications you make to the imported command are 
associated with the specific script into which you imported it, not 
the command library. To add new commands to the library, you 
must enter them directly from the Command Library selection from 
the Script Author Tools menu.

The Command Library interface also allows for modifying an 
existing command, via the Update button. 
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See Also
Script Author Installation Package Location

Sticky Mode

Panel Text Editor Access and Label

Data Dictionary Access

Connection Dialog Modifications

Reusable Commands

Apache Mid-Tier Architecture

WYSIWYG Panel Layout

Profile Setting Modifications

Compiling Custom Code Using JDK 1.1.8

Supported Methods of Packaging Java Bean Code Into a JAR File

1.3.8 Apache Mid-Tier Architecture
Supported beginning with release 11.5.6 of Oracle Scripting is an architectural 
improvement for the Scripting Engine. In this model, business logic is executed on 
the enterprise Web server rather than in the Java Virtual Machine (JVM) provided 
on the client by Oracle JInitiator. Business logic is deployed as a servlet in the 
Apache JServ. This architecture improves scalability, reduces customization, and 
enables the Scripting Engine to be executed through a firewall or using HTTPS. 

See Also
Script Author Installation Package Location

Sticky Mode

Panel Text Editor Access and Label

Data Dictionary Access

Connection Dialog Modifications

Reusable Commands

Reporting Features

WYSIWYG Panel Layout

Profile Setting Modifications
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Compiling Custom Code Using JDK 1.1.8

Supported Methods of Packaging Java Bean Code Into a JAR File

1.3.9 WYSIWYG Panel Layout
Prior to release 11.5.6 of Oracle Scripting, a script in runtime displayed two distinct 
sets of data:

� Panel text, displayed at the top horizontal hemisphere of the current panel, and 

� Panel nodes, also referred to as answer definitions, displayed at the bottom 
horizontal hemisphere of the current panel. 

A node may have a text-based User Interface (UI) label associated with it. If such a 
label is defined, it appears to the left of the answer definition. Each panel must have 
at least one answer definition (node) and may contain many (limited only by its 
usefulness to the user). If a panel contains multiple nodes, they appear as rows in a 
table (whose borders are transparent).

Regardless of whether a script in runtime executed in the Java-based Scripting 
Engine or the HTML-rendered Survey component, panel text and nodes could not 
be mixed or matched.

With release 11.5.6, a WYSIWYG panel editing ability in the Script Author allows 
the developer of a script to display panel text or images in any location in a panel, 
interspersed with answer controls for each node. 

This affects the way a script is built in the Script Author and how answers are 
recorded in the execution interface for a script. Each panel will now automatically 
display a Continue button that must be clicked during runtime in order to progress 
to the next panel. 

See Also
Script Author Installation Package Location

Sticky Mode

Note: The single exception to this rule is a panel using the "push 
button" answer UI control type. Clicking this push button during 
runtime (in either runtime GUI) has the same effect as clicking the 
Continue button. This answer control must only be used with panels 
containing a single node.
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Panel Text Editor Access and Label

Data Dictionary Access

Connection Dialog Modifications

Reusable Commands

Reporting Features

Apache Mid-Tier Architecture

Profile Setting Modifications

Compiling Custom Code Using JDK 1.1.8

Supported Methods of Packaging Java Bean Code Into a JAR File

1.3.10 Profile Setting Modifications
When implementing or administering Oracle Scripting, it is a requirement to 
establish system profile settings. Setting system profiles determines the behavior of 
Oracle Applications. System profile settings can be set at a site, application, 
responsibility, or user level. These settings affect the behavior of Oracle 
Applications, respectively, from the highest and broadest level (site) down to the 
lowest and most specific level (user). System profiles can be set for a high level (for 
example, application, for all users of the specified application), and also set at a 
lower level (for example, user, in which the settings only affect individual users 
based on their Oracle Applications login). The lowest level setting for a particular 
profile always takes precedence, superseding any value for that profile set at a 
higher level. This Implementation Guide may specify settings and recommend they 
be set at the Site level. Note, however, that in most cases a lower level setting will 
also suffice.

Oracle Scripting 11.5.6 introduces some changes to the profile settings as discussed 
below.

Topics for this group include:

� Changed Lookup Values for IES Profile Settings

� New IES Profile Settings

See Also
Fewer IES Profile Settings Required

Script Author Installation Package Location
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Sticky Mode

Panel Text Editor Access and Label

Data Dictionary Access

Connection Dialog Modifications

Reusable Commands

Reporting Features

Apache Mid-Tier Architecture

WYSIWYG Panel Layout

Compiling Custom Code Using JDK 1.1.8

Supported Methods of Packaging Java Bean Code Into a JAR File

1.3.10.1 Changed Lookup Values for IES Profile Settings
The values for the profile setting IES : IES ARCHITECTURE TYPE have changed. 
The new possible values are Apache mid tier/Servlet architecture and Caching 
Architecture (replacing Two Tier Mode).

The value Three Tier Mode has been removed.

See Also
� Changed Lookup Values for IES Profile Settings

� New IES Profile Settings

� Fewer IES Profile Settings Required

1.3.10.2 New IES Profile Settings

Web Security
The following profiles have been added for Oracle Scripting to support the 
Scripting Engine’s new ability to function through a firewall:

� IES: PROXY SERVER NAME

� IES: PROXY SERVER PORT

For more information, see your Web server or Systems administrator. 
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Web Server Servlet Zone
The Apps Servlet Agent profile has been added for Oracle Scripting to support the 
Apache Mid-Tier architecture. This profile must be populated with the URL to 
connect to the Servlet Zone of the Apache Web server.

The syntax for this profile, as well as an example, are provided below. For more 
information, see your Web server or Systems administrator.

Syntax:   http://<servername>.<domain>:<Apache Web server port>/ 
<servlet_zone>.

Example: http://server1.yourcompany.com:7777/oa_servlets

Debug Message Monitoring
The IES : Debug Mode profile has been added for Oracle Scripting to provide error 
and informational messages to the server logging portions of Oracle Call Center 
Technologies. Setting this mode on will enable additional IES-related informational 
messages to be visible to a user with the Interaction Center Server Log Viewer or 
Interaction Center Server Manager responsibility.

See Also
� Changed Lookup Values for IES Profile Settings

� New IES Profile Settings

� Fewer IES Profile Settings Required

1.3.11 Compiling Custom Code Using JDK 1.1.8
Oracle Scripting information renders in HTML using different HTML rendering 
engines. For scripts executed in HTML as a survey, the Oracle Applications 
11i-certified Web browser provides HTML rendering and interpretation. For all 
Oracle Applications 11i releases to date, including release 11.5.6, scripts run in the 
Scripting agent application use the Java classes in the SWING library of JDK 1.1.8 to 
render the HTML. 

For this reason, Oracle Corporation recommends:

Note:  Setting this profile to Debug on will result in error message 
dialogs appearing with debug message information upon runtime 
of the Scripting agent application.
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a. Testing scripts in the lowest common denominator (the Scripting agent 
interface) to ensure expected interpretation of HTML elements.

b. Compile custom Java code against JDK 1.1.8 to ensure compatibility for 
custom code using the Scripting agent interface.

c. For Scripting implementations using the Caching Architecture, the Java 
Virtual Machine for executing Scripting is provided by JInitiator, which at 
the time of this writing is not available at versions above JDK 1.1.8.x. Thus, 
all custom code to be executed in this architecture must be compiled to JDK 
1.1.8 or earlier to ensure compatibility. This requirement will relax if 
JInitiator versions compiled against higher JDK versions than 1.1.8 are 
released and certified by Oracle Corporation. 

For this and other certification information, refer to OracleMetaLink or 
contact your Oracle Support Services representative.

See Also
Script Author Installation Package Location

Sticky Mode

Panel Text Editor Access and Label

Data Dictionary Access

Connection Dialog Modifications

Reusable Commands

Reporting Features

Apache Mid-Tier Architecture

WYSIWYG Panel Layout

Profile Setting Modifications

Supported Methods of Packaging Java Bean Code Into a JAR File

1.3.12 Supported Methods of Packaging Java Bean Code Into a JAR File
Oracle recommends compiling custom Java code in support of Oracle Scripting 
against the Java Development Kit (JDK) 1.1.8. Due to a limitation in JDK 1.1.8, there 
are only two supported methods of packaging the Java Archive (JAR) file 
appropriately. This process is discussed in detail in the Oracle Scripting online help 
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and Oracle Scripting Concepts and Procedures, in the section Packaging Java Bean 
Code Into a JAR File.

See Also
Script Author Installation Package Location

Sticky Mode

Panel Text Editor Access and Label

Data Dictionary Access

Connection Dialog Modifications

Reusable Commands

Reporting Features

Apache Mid-Tier Architecture

WYSIWYG Panel Layout

Profile Setting Modifications

Compiling Custom Code Using JDK 1.1.8

1.4 Obsolete in this Release
Topics in this group include:

� Startup Form Removed

� Fewer IES Profile Settings Required

� Substituting a Java Bean for an Answer

See Also
Oracle Interaction Center Overview

Oracle Scripting Overview

New in this Release

1.4.1 Startup Form Removed
Although recommended to be used with integrated CRM applications such as 
Oracle TeleSales and Oracle TeleService, scripts can also be launched from an Oracle 
Applications session with no other business application. This requires an 
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applications login with the Scripting User or the Scripting Agent, Vision Enterprises 
responsibility.

Logging into Oracle Applications and selecting the appropriate responsibility will 
result in the Demo Form option in the Navigator. Selecting this option will display a 
Forms window that contains a list of all scripts deployed to that environment. From 
here you select the appropriate script and click Start Scripting.

If Upgrading From Releases Prior to 11.5.6
The following issues are only relevant for enterprises upgrading from releases of 
Oracle Scripting prior to release 11.5.6:

� Scripting Release 11i versions prior to 11.5.6 also contained a Navigator option 
for the Startup Form. Selecting this option resulted in the display of a form 
(entitled SCRIPTING) which contained script information and database 
information parameters. Launching a script by filling in the parameters in this 
form and clicking Start Scripting resulted in the launch of the script using older 
Scripting Engine code. The Startup Form has been removed in 11.5.6 and 
subsequent releases.

� Once you upgrade Oracle Scripting to release 11.5.6 or later, only scripts 
compiled and deployed to the database using the 11.5.6 or later release of the 
Script Author 11.5.6 will execute. If scripts were deployed to the database from 
any previous version, they will display in the list but will result in an error when 
you attempt to execute. You will need to open, recompile, and redeploy scripts 
created prior to upgrading to 11.5.6.

See Also
� Fewer IES Profile Settings Required

� Substituting a Java Bean for an Answer

1.4.2 Fewer Required IES Profile Settings
In previous versions of Scripting, implementation included seven parameters that 
were required to be established for the application. While these values were not 

Note:  While the Forms window displaying the list of deployed 
scripts is labeled SCRIPTING_WINDOW in the title bar, it is 
commonly referred to as the Script Chooser. 
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always used, the fields nonetheless were required to be not null. This no longer 
applies to:

� IES : JNDI name used for Scripting application

� IES : SID of Oracle Scripting Database

� IES : Port for Oracle Scripting application

� IES : Server Host Name for Scripting application

� IES : Scripting Bean Display Mode

See Also
� Startup Form Removed

� Substituting a Java Bean for an Answer

1.4.3 Substituting a Java Bean for an Answer
Substituting a Java bean for an answer (or panel node) is no longer supported in 
Oracle Scripting as of release 11.5.6 and subsequent releases, due to the new 
WYSIWYG editing feature of the Script Author.

Note that substitution of an entire panel with a Java Bean is still supported.

See Also
� Startup Form Removed

� Fewer IES Profile Settings Required
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Technology, Requirements, and

Performance

The following topics are included in this topic group:

Architectural Overview

Minimum Software Requirements

Minimum Hardware Requirements

Scalability and Performance Guidelines

2.1 Architectural Overview
Oracle Scripting 11.5.6 introduces the Apache Mid-Tier Architecture. This 
architectural improvement only affects agents using the Scripting Engine. In this 
model, business logic is executed on the enterprise Web server rather than in the 
Java Virtual Machine (JVM) provided on the client by Oracle JInitiator. 

Business logic is deployed as a servlet in the Apache JServ. This architecture 
improves scalability, reduces customization, and enables the Scripting Engine to be 
executed through a firewall or using HTTPS. 

Impact of Architecture Change
Impact is minimal. Instead of referencing custom Java code in the appsweb.cfg 
file (as required in the Caching Architecture), you must reference custom Java in the 
class path of the jserv.properties file. This configuration file is located on the 
Apache Web server, as discussed in detail later in the section Adding Custom Java 
Class Path to jserv.properties File.
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Custom Java must still be compiled into one or more Java class files. These in turn 
must be compressed into one or more JAR files. For more information, see the 
"Packaging Java Bean Code Into a JAR File" subtopic in the Using Oracle Scripting 
section of the Oracle Scripting Concepts and Procedures Manual. Custom Java is stored 
on the applications server, typically in a directory such as <JAVA_TOP>/ies_
custom.

Finally, the IES : IES ARCHITECTURE TYPE system profile values have changed as 
described in Changed Lookup Values for IES Profile Settings. To implement the 
agent component of Oracle Scripting 11.5.6, you must use the value Apache Mid 
Tier/Servlet Architecture in this profile setting.

See Also
Minimum Software Requirements

Minimum Hardware Requirements

Scalability and Performance Guidelines

2.2 Minimum Software Requirements
The following are the minimum software requirements for using Oracle Scripting 
release 11.5.6:

� You must have Oracle Applications that was installed using a Rapid Install.

� You must have Oracle Scripting 11.5.6 or higher (IES MiniPack L or later).

� You must have an Oracle Applications 11i-compliant Web browser.

� In order to deploy scripts to the applications database, you must have Script 
Author 11.5.6 or later installed. To use the Scripting Engine agent interface or to 
use the Survey component, scripts developed in versions prior to Script Author 
11.5.6 must be opened, recompiled, and redeployed to the applications 
database.

� JavaSoft’s Java Development Kit (JDK) 1.2 or higher must be on the 
Applications server to use Oracle Scripting 11.5.6.

� For compiling custom Java classes in support of Oracle Scripting, Oracle 
Corporation recommends JDK 1.1.8.

See Also
Architectural Overview
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Minimum Hardware Requirements

Scalability and Performance Guidelines

2.3 Minimum Hardware Requirements
Oracle Applications must be installed (using a Rapid Install) on an appropriate 
server-class UNIX or Windows NT server. The server must have suitable memory 
(RAM) and storage (hard drive space) for enterprise-specific tasks, as determined 
by enterprise system administrators. Guidance can be found for minimum 
requirements in Installing Oracle Applications.

See Also
Architectural Overview

Minimum Software Requirements

Scalability and Performance Guidelines

2.4 Scalability and Performance Guidelines
Oracle Scripting has the same scalability and performance guidelines as other 
Oracle Applications CRM release 11i products. For other scalability and 
performance guidelines, refer to Installing Oracle Applications.

Some implementations install the database tier of Oracle Applications on a separate 
physical host machine to improve performance. Technically, each tier in a Rapid 
Install may be installed on a separate host machine for additional performance 
gains, although this is a rare occurrence. Detectable performance gains for 
multi-server implementations are likely if load on the applications database is 
heavy. For medium to light load there should be little appreciable gain. Regardless 
of whether you have a single or multiple configuration, Rapid Install is a 
prerequisite. Consult with your systems administrator for more information.

See Also
Architectural Overview

Minimum Software Requirements

Minimum Hardware Requirements
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Dependency Requirements and Verification

The following topics are included in this topic group:

Mandatory Dependencies

Conditional Dependencies

Installation and Dependency Verification

3.1 Mandatory Dependencies
� Oracle Applications must have been installed using either Oracle Applications 

Rapid Install release 11.5.6, or any release 11i Rapid Install or release 11i 
Platinum, followed by appropriate upgrades to release 11.5.6 or later.

� In order to execute scripts using Oracle Scripting 11.5.6 or later, scripts must 
have been compiled and deployed using Script Author 11.5.6.

� All deployed scripts will display in the Script Chooser, including any 
scripts deployed using previous versions of Oracle Scripting. However, 
scripts compiled in versions of the Script Author prior to 11.5.6 will not 
execute. Selecting a pre-11.5.6 script to run will result in a blank Scripting 
window with error messages (see troubleshooting).

� If a script from previous versions of the Script Author must be used, open 
the script using Script Author 11.5.6 or later, recompile, save the updated 
script, and redeploy to the appropriate applications database.

� For information on obtaining Script Author release 11.5.6, see Script Author 
Installation Package Location.

� For new implementations of Oracle Scripting 11.5.6 or later, you must specify in 
the system profile IES : IES ARCHITECTURE TYPE the value Apache mid 
tier/Servlet architecture to use the Scripting agent application.
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� For use of the reporting feature accessible from the Survey Admin console, you 
must have JavaSoft Java Development Kit 1.2 or later installed on the 
applications Web server.

� You must use an Oracle Applications 11i-compliant Web browser to launch 
Oracle Applications. For software certifications, see OracleMetaLink.

� You must have a certified version of Oracle JInitiator to launch Oracle 
Applications. If not present, you should be able to download the appropriate 
version when you attempt to access an Oracle Applications URL. For 
certifications, see OracleMetaLink.

3.2 Conditional Dependencies

3.2.1 Script Author Dependencies
� You must install the Script Author on a Microsoft Windows (95, 98, 2000, NT) 

development workstation that can connect to the database in order to deploy 
scripts appropriately. 

� If using custom Java code to write commands supporting the Scripting Engine 
in the agent interface, you must compile custom Java classes using JDK 1.1.8.

See Also
� For information on obtaining Script Author release 11.5.6, see Script Author 

Installation Package Location.

� For information on JDK 1.1.8 requirements, see Compiling Custom Code Using 
JDK 1.1.8.

3.2.2 Scripting Engine Agent GUI Dependencies
� If referencing custom Java code in a script:

� The custom JAR must be appropriately packaged.

� You must compile custom Java classes using JDK 1.1.8.

� You must deploy your custom Java to the applications server.

� You must reference the class path of any custom Java in the Apache Web 
server jserv.properties file.
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See Also
� For information on packaging JAR files, see Supported Methods of Packaging 

Java Bean Code Into a JAR File.

� For information on JDK 11.18 requirements, see Script Author release 11.5.6, see 
Compiling Custom Code Using JDK 1.1.8.

� For information on referencing the class path, see Adding Custom Java Class 
Path to jserv.properties File.

3.2.3 Survey Component Dependencies
If an implementation of the Survey component of Oracle Scripting requires the use 
of list-based survey campaigns, the following are dependencies:

� You must have Oracle One-to-One Fulfillment installed and implemented.

� You must have an appropriately configured Fulfillment server.

� You must have Oracle Marketing Online installed and implemented.

� You must have access to a user with the Survey Administrator responsibility.

� In order to use HTTPS, you must have proxy servers appropriately configured, 
and you must set the appropriate system profiles.

See Also
� For information on Oracle One-to-One Fulfillment requirements and 

implementation, see Oracle Foundation Implementation Guide.

� For information on using and administering Oracle One-to-One Fulfillment, see 
Oracle Foundation Concepts and Procedures.

� For information on Oracle Marketing Online requirements and implementation, 
see Oracle Marketing Online Implementation Guide.

� For information on using and administering Oracle Marketing Online, see 
Oracle Marketing Online Concepts and Procedures.

� For information on the appropriate system profiles for using HTTPS over a 
proxy server, see Implementing the Scripting Engine for the Agent Interface.

3.2.4 Unix Server Dependencies
If using a Unix server, you must identify an X Server as a display server to 
dynamically generate graphics using JFC/SWING and AWT.
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See Also
For information on the setting a display server, see Setting Display Server for Unix 
Environments.

3.3 Installation and Dependency Verification
You must verify an implementation using the procedures described in the section 
Verifying the Implementation. This includes:

For All Implementations
� Installing the Script Author 11.5.6 component.

� Obtaining the Regression Test Script from OracleMetaLink.

� Opening, compiling, and deploying the script to your applications database.

� Uploading custom JAR file to the server.

� Referencing custom Java class path in the Apache Web server jserv.properties 
file.

� For testing scripts in the agent interface, assigning the Scripting User or 
Scripting Agent responsibility to an existing or new Oracle Applications user.

� Successfully launching and executing the Regression Test Script in the Scripting 
Engine.

� For Survey operations, assigning the iSurvey User responsibility to an existing 
or new Oracle Applications user, to administer concurrent programs.

For Survey Implementations
� Assigning the Survey Administrator responsibility to an existing or new Oracle 

Applications user.

� Creating or modifying JSP survey resources and ensuring they are present in 
the $OA_HTML directory on the server.

� Defining survey resources, a survey campaign, cycle, and deployment in the 
Survey Admin console.

� Deploying a deployment.

� Ensuring you can participate in a survey using a Web browser.

� Ensuring survey response data has been accurately received.
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� Ensuring you can schedule or perform concurrent programs to update 
deployment status and move survey data to survey summary tables.

� Ensuring reporting data displays from summary tables.
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Implementation Overview

The following topics are included in this topic group:

Process Description

Implementation Task Sequence

4.1 Process Description
Implementing Oracle Scripting includes tasks required for all implementations, as 
well as Scripting component-specific implementation tasks, some administrative 
tasks, and implementation verification tasks. You must have an understanding of 
which Oracle Scripting components are required at the enterprise in order to 
implement successfully.

This implementation guide assumes that you have, at a minimum:

� Installed Oracle Applications (database, technology stack, and Oracle 
Applications files).

See Installing Oracle Applications or Upgrading Oracle Applications.

� Installed JInitiator on the agent desktop.

� Optionally, implemented Oracle Human Resources Management Systems.

See Implementing Oracle HRMS.

� Implemented CRM Foundation Resource Manager.

See Oracle CRM Foundation Implementation Guide.

� Implemented at least one CRM business application such as Oracle TeleSales, 
Oracle TeleService or Oracle Collections.
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See Oracle TeleSales Implementation Guide, Oracle Support Implementation Guide, or 
Oracle Collections Implementation Guide, respectively.

� If implementing Oracle Scripting at an enterprise for which a custom script and 
custom Java or PL/SQL code have already been developed, then deploying the 
custom code to the database and testing it may be a part of your 
implementation tasks, following standard implementation verification tasks.

 See the Oracle Scripting Concepts and Procedures Manual for specifics regarding 
business considerations for customized scripts and deploying custom code.

4.2 Implementation Task Sequence

High Level Sequence
In order to implement Oracle Scripting at the enterprise, you need to perform the 
following tasks, described in detail in the section Implementing Oracle Scripting:

Performing Top-Level Implementation Tasks. These include the creation and 
administration of users, and an understanding of how tasks are described in this 
implementation guide.

Implementation Tasks by Scripting Component. Implementation tasks vary 
according to which components of Oracle Scripting are required. Not all steps will 
be required for every implementation. Guidelines include the following:

� Implementing the Script Author Component: All Scripting implementations 
require the Script Author to be implemented in order to create, compile, and 
deploy scripts to the applications database.

� Implementing the Scripting Engine Component: All Scripting implementations 
require the Scripting Engine to be implemented. Some implementation tasks are 
common to all Scripting Engine implementations. Certain implementation tasks 
are required for implementing the agent interface, while others are required for 
implementing the Web interface for survey operations.

� Implementing the Survey Component: Perform Survey implementation steps 
only for Scripting implementations that require use of the Survey component. 
These are further broken down into steps required for non-list-based survey 
operations (fewer tasks) and steps required for list-based survey operations.

Implementation Verification. Implementation tasks must be verified to ensure 
appropriate implementation. These tasks differ based on which components were 
implemented.
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� Verifying the Script Author Component: If you can create and deploy a simple 
script, you have verified the Script Author is appropriately implemented.

� Verifying the Scripting Engine Component: If you can execute a simple script in 
the agent interface, you have performed Scripting Engine verification at the 
lowest and least abstract level. This is recommended for scripts regardless of 
which interface will be used in production. Other verification tests include 
administering, deploying, and testing a survey campaign. To verify reporting 
and analysis, administrative steps described in Administering Oracle Scripting 
will need to be performed.
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Implementing Oracle Scripting

This section describes all tasks that may be required to implement Oracle Scripting. 
You must have an understanding of which Oracle Scripting components are 
required at the enterprise in order to implement successfully.

The following topics are included in this topic group:

Performing Top-Level Implementation Tasks

Implementing the Script Author Component

Implementing the Scripting Engine Component

Implementing the Survey Component

5.1 Performing Top-Level Implementation Tasks
There are certain implementation tasks required for all interaction center 
implementations. These involve the creation of users from an Oracle Applications 
perspective, the creation of these users as resources in the enterprise employee 
database, the association of Oracle Applications users with resources in the 
enterprise, and ensuring the users meet CRM applications by importing them as 
CRM resources.

Performing these and other implementation tasks typically requires logging into 
Oracle Forms-based applications—which takes you to the Navigator— or into 
Oracle Customer Relationship Management HTML-based applications, which take 
to an appropriate administrative console. These top-level tasks are described in this 
section.

The following topics are included in this topic group:

Understanding Implementation Tasks
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Performing Top-Level Implementation Tasks
Creating and Administering Oracle Scripting Users

5.1.1 Understanding Implementation Tasks
Each implementation task in this document includes certain terminology and 
requires you to perform certain Oracle Applications tasks (for example, logging into 
Forms-based or HTML-based Oracle Applications). To understand this information 
better, read this section. If you are familiar with these terms, skip this section.

The following topics are included in this topic group:

Terminology to Assist in Performing Implementation Tasks

Logging Into Oracle Forms-Based Applications

Logging Into Oracle CRM HTML-Based Applications

See Also
Creating and Administering Oracle Scripting Users

5.1.1.1 Terminology to Assist in Performing Implementation Tasks
Each implementation task in this document includes, at minimum, information 
regarding which login URL to use, which responsibility must be assigned to your 
login, and any prerequisites to that task. This information is discussed below.

Login URL
All Oracle Applications tasks are accomplished by using an Oracle Applications 
11i-compliant Web browser to access a specific Uniform Resource Locator (URL) for 
a given environment. This URL is referred to as your login URL.

Login, User Name, and User ID

Upon accessing the URL, you are asked to provide a user name (or user ID) and a 
password. This combination is referred to as your login. 

Responsibility
Each Oracle Applications account associates a user’s login information with at least 
one Oracle Applications responsibility. Responsibilities determine what functions 
you can accomplish with a particular login.
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Self-Service Login URL
There are two different technology stacks used in Oracle Applications: Oracle 
Forms-based applications and HTML-based applications. Both access the same 
applications database and can share information.

SSWA, PHP, and the Navigator
There are different logins associated with accessing Forms-based applications and 
CRM HTML-based applications. To access Forms-based applications, you may use a 
direct Forms URL (if supported in your environment), or you may use an Oracle 
Self-Service Web Applications (SSWA) login. This is referred to as the Self-Service 
Login URL. From this login URL, you can access your Personal Home Page (PHP), 
which lists all responsibilities associated with your login. When you log into 
Forms-based applications and select the appropriate responsibility, the first screen 
you typically encounter is the Navigator.

Most steps for Forms-based applications are described from the Navigator. For 
specific steps to log into Oracle Forms-based applications to access the Navigator, 
see Logging Into Oracle Forms-Based Applications. 

HTML Login URL
When you access the login URL for CRM HTML-based applications, you will see an 
HTML page that reads, "Welcome to Oracle eBusiness Suite." This is referred to as 
the HTML Login URL. From here you can access Oracle CRM Java Server Pages 
(JSP) applications. These are typically referred to as administrative consoles or 
admin consoles.

Most steps for HTML-based applications are described from the admin console. For 
detailed instructions on logging into CRM HTML-based applications to access the 
admin console, see Logging Into Oracle CRM HTML-Based Applications. 

5.1.1.2 Logging Into Oracle Forms-Based Applications

Login
Log into Oracle Forms-based applications as appropriate for your environment. 
You may use the direct Forms URL if supported, or log into Oracle Self-Service Web 
Applications (SSWA) to access your Personal Home Page (PHP).
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Responsibility
You must use a login that has been assigned a particular responsibility, based on 
the function you wish to perform. Each specific implementation task will indicate 
the required responsibility.

For example, to create Oracle Applications users or add a responsibility to a user, 
use a login that has been assigned the System Administrator responsibility.

Prerequisites
� Each implementation task has its own prerequisites.

� The only prerequisite for logging into Forms-based applications is having a 
username and password. For creation of a new users, Oracle Applications ships 
with a default system administrator with the username sysadmin, password 
sysadmin.

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate URL for your environment to log into Oracle Forms-based 
applications.

The Oracle Applications 11i graphic appears, with fields for User Name and 
Password.

2. From the applications login screen, enter in the provided fields a User Name 
and Password for a user with the appropriate responsibility as indicated above, 
and click Connect. 

For users with multiple responsibilities, a list appears, indicating all 
responsibilities assigned to that resource or user. 

3. From the list of responsibilities, select the option required by your specific 
implementation task. If necessary, click OK to confirm your selection.

Caution:  If you use the URL in your environment to log into 
SSWA, you can access HTML-based Self-Service Web Applications 
or Forms-based applications. If you use a Forms-specific URL you 
will only have access to Forms-based applications. Either URL is 
sufficient to perform the required implementation steps.
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The Navigator will appear with the login responsibility in the title bar (e.g., 
Navigator — System Administrator).

5.1.1.3 Logging Into Oracle CRM HTML-Based Applications

Login
Log into Oracle CRM HTML-based applications as appropriate for your 
environment by accessing the HTML Login URL.

This is the HTML-based login page with the URL that ends with jtflogin.jsp. The 
title reads "Welcome to Oracle eBusiness Suite." For the purposes of this document, 
this login screen will be referred to as the HTML Login URL. In addition to being 
referred to as the HTML login, this is also sometimes known as the Apache or JTF 
login screen.

Responsibility
You must use a login that has been assigned a particular responsibility, based on 
the function you wish to perform. Each specific implementation task will indicate 
the required responsibility.

For example, to create Oracle Applications users or add a responsibility to a user, 
use a login that has been assigned the System Administrator responsibility.

Prerequisites
� Each implementation task has its own prerequisites.

� The only prerequisite for logging into CRM HTML-based applications is having 
a user ID and password. You can create logins from Forms-based applications 
using the default system administrator (username sysadmin, password 
sysadmin).

Caution:  If logging in a system administrator, take note: Based on 
environmental factors and the method you used to log in, you may 
see two categories in the list: Self Service and Applications. If you 
see a responsibility called System Administration in the Self Service 
category, do not select this choice (it is the wrong responsibility). 
Ensure you select the System Administrator responsibility, which is 
under the Applications category.
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� The first time you log into CRM HTML-based applications with a newly created 
login, you will be asked first to change your password, and second to 
determine the default responsibility for your login. You will need to sign out 
and log back in after providing this information in order to complete your task.

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the HTML 

Login URL appropriate for your environment.

2. From the eBusiness Center applications login screen, enter in the provided 
fields a User ID and Password for a user with the appropriate responsibility as 
indicated above, and click Go. 

The User ID in CRM applications is the same as a User Name in Oracle 
Forms-based applications.

If this is the first time you are logging into Oracle Applications with this user, 
you may be asked to change your password.

If this is the first time you are logging into CRM HTML-based applications, you 
may be asked to establish a default responsibility. In this case you will need to 
do so, log out, and log back in.

If you have already established a default responsibility, the admin console 
associated with that default responsibility appears.

If that HTML application has a Home tab, it will default. Otherwise, the 
primary function of that specific HTML console will be active.

In the CRM HTML interface, there are up to four levels of navigation.

� The first level is a set of icons at the top right of the page, including Sign 
Out.

� The second level, assuming the responsibility has multiple functions, is a 
set of tabs. If the responsibility has few functions, it is possible for only one 
tab to appear.

� The third possible level are hyperlinks beneath each tab. These are referred 
to as subtabs.

� The fourth possible level are a set of hyperlinks on the left-hand side of the 
page.

See Also
If You Cannot See the Survey Admin Console
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5.1.2 Creating and Administering Oracle Scripting Users

Required for All Implementations
The following tasks must be performed to create users and administer them 
appropriately:

1. Define Oracle Applications users.

2. Create employees in the enterprise.

3. Create a CRM resource. 

4. Associate employees in the enterprise database with Oracle Applications user 
accounts. 

These tasks listed in this section are described in detail in Oracle Applications 
Interaction Center Implementation Guide.

Prior to creating and administering users for Oracle Scripting, you must understand 
the types of users required, the applicable responsibilities to assign to the 
appropriate Oracle Applications login, and the specific tasks to accomplish.

Types of Users Required
From an Oracle Applications perspective, you must define users that can log into an 
Oracle Applications session, and assign each user with the appropriate 
responsibility or responsibilities to perform a particular set of functions.

At minimum, for each implementation, you will need to define two types of users:

� An administrator, and

� An interaction center agent, typically an employee in the enterprise.

The responsibilities associated with these users depends on how Oracle Scripting 
will be implemented at the enterprise, and which Oracle Applications functions will 
be required. 

Administrators
An administrator must have access to functions that the typical interaction center 
agent will not, and administers users and applications across the broad spectrum. 
For example, one function of an administrator is to create agent users. This 
necessitates the creation of an administrative user as the first step.

There are four specific tasks associated with creating and administering users:

� Define Oracle Applications users (usernames, passwords, and responsibilities)
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� Create employees in the enterprise database.

� Create (import) employees as a CRM resource. 

� Associate employees in the enterprise database with Oracle Applications user 
accounts. 

For implementation purposes, the administrator technically requires only the first 
of these four tasks to be accomplished. However, if the administrator user is an 
enterprise superuser that will perform work in CRM applications as well as 
administrative tasks with the same login, perform all of these tasks for the 
administrator.

Agents
For implementation purposes, the Oracle Scripting agent technically requires only 
the first of these four tasks to be accomplished if using Scripting in stand-alone 
mode. However, to test Scripting from integrated applications, and for actual 
Scripting agents in an enterprise, perform all of these task. Agent users will 
typically have access to at least one CRM business application, and many 
enterprises will require these users to be members of the enterprise database.

The order in which agent users are created is at your discretion. You may choose to 
create Oracle Applications users for each agent immediately following the creation 
of an administrative user, assuming you have all information required. 
Alternatively, agent users can be created immediately prior to use of an agent logins 
required to perform steps for administration or testing.

Implementation Responsibility Matrix
A matrix of administrative-level and agent-level users and the responsibilities most 
likely to be needed is included below.

Not all the responsibilities in the matrix are required to be assigned to users for 
Oracle Scripting purposes. For example, you may define different logins or have 
access to different logins with responsibilities for accomplishing various 
administrative tasks, such as for human resource management and Fulfillment 
administration.

User Type Responsibility Function For Component(s)

Administrator System 
Administrator

� Create and administer Oracle Applications 
users

� Establish or modify system profile settings

All
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Administrator HRMS Manager � Create employees in the enterprise human 
resources database, if Oracle Human 
Resources Management System (HRMS) is 
licensed and installed at the enterprise.

All

Administrator CRM Resource 
Manager

� Create employees in the enterprise human 
resources database, if HRMS is not installed 
at the enterprise.

� Import employees from the enterprise human 
resources database as CRM resources

All

Administrator Survey 
Administrator

Access the Survey Admin Console. This is 
required to:

� Define survey resources (headers, final pages, 
error pages in JSP format)

� Create survey campaigns

� Define survey cycles

� Define or deploy survey deployments

� View specific answers provided by survey 
respondents to a previously or currently 
active deployment

� Generate reports from survey respondent 
data or footprinting data

Survey

Administrator iSurvey User Schedule or run concurrent programs. Survey

Administrator JTF_FM_
ADMINISTRATOR

� Access the Fulfillment Admin console.

� Set up or change Fulfillment groups

� Set up or change mail servers associated with 
Fulfillment groups

� View failed Fulfillment requests after 
concurrent programs succeed in passing 
requests to the Fulfillment server.

Survey

These Fulfillment 
Administrator tasks 
are required for 
implementations 
using list-based 
survey campaigns

Agent Scripting User 

Scripting Agent

Launch scripts in "stand-alone mode" from Oracle 
Forms, typically to test deployed scripts.

Scripting Engine for 
agent application

Agent Customer Support For agents accessing Oracle Scripting from within 
the integrated Oracle TeleService application.

Scripting Engine for 
agent application

Agent TeleSales Agent For agents accessing Oracle Scripting from within 
the integrated Oracle TeleSales application.

Scripting Engine for 
agent application

User Type Responsibility Function For Component(s)
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Road Map to User Creation and Administration
The steps required for these tasks are described in Oracle Applications Interaction 
Center Implementation Guide.

Each of these requires logging into Forms-based Oracle Applications, with varying 
responsibilities (System Administrator, HRMS Manager, or CRM Resource 
Manager) based on the task and the presence of HRMS.

Steps
1. Create and administer an administrator user with the appropriate 

responsibilities for your implementation.

Use the Implementation Responsibility Matrix above as a guideline. Specific 
steps are detailed in Oracle Applications Interaction Center Implementation Guide, 
as described below.

2. Create and administer an agent user with the appropriate responsibilities for 
your implementation.

Use the Implementation Responsibility Matrix above as a guideline. Specific 
steps are detailed in Oracle Applications Interaction Center Implementation Guide, 
as described below.

See Also
� For detailed instructions on logging into Forms-based applications, see Logging 

Into Oracle Forms-Based Applications. 

� For detailed instructions on creating employees in the enterprise database:

a. If HRMS is installed, see Implementation Tasks > Creating an Employee in 
Oracle Human Resource Management Systems in Oracle Applications 
Interaction Center Implementation Guide. 

b. If HRMS is not installed, see Implementation Tasks > Creating an Employee 
in CRM Resource Manager in Oracle Applications Interaction Center 
Implementation Guide. 

Agent Collections Agent

Senior Collections 
Agent

For agents accessing Oracle Scripting from within 
the integrated Oracle Collections application.

Scripting Engine for 
agent application

User Type Responsibility Function For Component(s)
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� For detailed instructions on importing employees from the enterprise database 
as a CRM resource, see Implementation Tasks > Creating a CRM Resource for 
an Employee in Oracle Applications Interaction Center Implementation Guide. 

� For detailed instructions on creating a user (without instructions for associating 
a resource), see Implementation Tasks > Defining an Administrator for Oracle 
Interaction Center in Oracle Applications Interaction Center Implementation Guide. 

� For detailed instructions on creating Oracle Applications users, including 
instructions on how to associate an employee in the enterprise human resources 
database with an Oracle Applications user account, see Implementation Tasks > 
Creating an Oracle Applications User Account for an Employee in Oracle 
Applications Interaction Center Implementation Guide. 

� For detailed instructions on logging into CRM HTML-based applications, see 
Logging Into Oracle CRM HTML-Based Applications

See Also
Understanding Implementation Tasks

5.2 Implementing the Script Author Component
The tasks listed in this section are for implementing the Script Author component of 
Oracle Scripting. The following topics are included in this topic group:

Locating Script Author Installation Package

Downloading Script Author Installation Package

Preparing for Script Author Installation

Installing Script Author 11.5.6 or Later

See Also
Performing Top-Level Implementation Tasks

Implementing the Scripting Engine Component

Implementing the Survey Component

5.2.1 Locating Script Author Installation Package
Installation of the Script Author is accomplished using the Oracle Universal 
Installer. As of release 11.5.6, this is obtained as a ZIP file from the APPL_TOP 
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(Oracle Applications file system), specifically in the product top for Oracle Scripting 
(product code IES).

This is in contrast to earlier releases of Oracle Applications 11i, in which the only 
way to access the Script Author installation package was on the 11i Call Center 
Applications Install CD, or as a ZIP file downloaded from OracleMetaLink.

See Also
Downloading Script Author Installation Package

Preparing for Script Author Installation

Installing Script Author 11.5.6 or Later

5.2.2 Downloading Script Author Installation Package
Download the iesauthr.zip file from the Oracle Applications 11.5.6 or later APPL_
TOP.

Login
None required

Responsibility
None required

Prerequisites
� You must be using an Oracle Applications 11i-compliant Web browser.

� You must know the appropriate URL to access your Oracle Applications 
environment.

� You must have enough space allocated on the target computer to download 
and extract the Script Author files. The compressed file is approximately 80 
megabytes in size. This size may vary on your local machine.

Steps
1. From your Web browser, access the appropriate URL for your environment, 

using the following syntax, and press Enter.

http://<server>.<domain>:<port>/OA_HTML/download/ ies/iesauthr.zip. 

Fill in the server, domain, and port specific to your environment. For example:
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http://server1.yourcompany.com:7777/OA_HTML/download/ ies/iesauthr.zip

2. Your Web browser will prompt you to perform an action with the specified file. 
Select the option that allows you to save the file to your local filing system.

a. If you are downloading the files using the target computer, navigate to the 
desired directory and save the file.

After installation, you do not need to retain the installation package, since it 
will be accessible from the same URL at any time. Therefore, you may save 
the installation package in any location, including your default TEMP 
directory.

b. If you are downloading the files for installation on a different computer, 
save the file to any location, and transfer the ZIP file to the target computer.

See Also
Locating Script Author Installation Package

Preparing for Script Author Installation

Installing Script Author 11.5.6 or Later

5.2.3 Preparing for Script Author Installation
This task describes how to prepare the target computer for installation of Script 
Author 11.5.6 or later.

Login
None required

Responsibility
None required

Prerequisites
� You must have downloaded Script Author 11.5.6 or later from the APPL_TOP 

of your local environment.

� If required, you must have moved the Script Author installation package to the 
computer on which the Script Author will be installed. Script Author can be 
installed on a computer running any Microsoft Windows 95, 98, 2000, or NT 
operating system.
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� You must have enough space allocated on the target computer to accommodate 
the extracted Script Author files. Once extracted, the Script Author requires 
approximately 100 megabytes. This size may vary on your local machine.

Steps
1. Locate the Script Author installation package, typically named iesauthr.zip.

2. In the target directory, extract the ZIP file to a directory with the same name.

This will result in a directory named Iesauthr.

3. Review the readme.txt file located in the extracted path Iesauthr\Oracle 
Scripting Author Installation\readme.txt prior to installing.

See Also
Locating Script Author Installation Package

Downloading Script Author Installation Package

Installing Script Author 11.5.6 or Later

5.2.4 Installing Script Author 11.5.6 or Later
This task describes how to prepare the target computer for installation of Script 
Author 11.5.6 or later.

Login
None required

Responsibility
None required

Prerequisites
� You must have downloaded Script Author 11.5.6 or later from the APPL_TOP 

of your local environment and extracted the Script Author installation package.

� You must install the Script Author on a computer with a Microsoft Windows 
95, 98, 2000, or NT operating system. Typically, this must be a networked 
computer that can see the Applications server on the same side of the firewall.

� You must have read the readme.txt file included in the installation package.
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� You must have enough space allocated on the target computer to accommodate 
the installed Script Author files. Once extracted, the Script Author requires only 
approximately 22 megabytes. This size may vary on your local machine.

Steps
1. Start the Oracle Universal Installer by running setup.exe from path:

Iesauthr\Oracle Scripting Author Installation\install\win32\setup.exe

Oracle Universal Installer launches and the Welcome screen appears.

2. Click Next to continue.

3. In the File Locations screen, specify the destination directory for Oracle 
Scripting Script Author.

�  The Source area displays the path to the components available for 
installation.

� The Destination area displays the destination alias, and the default path to 
which Script Author will be installed.

In the Destination area, type the destination path or click Browse to choose 
a destination path. If the destination path does not have a name, type an 
alias for the destination path in the Name field. You can provide any alias 
for the purpose of installing Oracle Scripting Script Author.

Click Next to continue.

4. In the Installation Types screen, select an installation type and then click Next to 
continue.

Note: Do not modify the information in the Source area.

Note: The Script Author can be installed in any directory; 
installation into an Oracle Home directory is not required. If the 
target computer has an Oracle Home directory, this location is 
recommended and will typically default as the Destination. You 
may choose another destination if desired.
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5. In the Summary screen, verify the installation settings.

�  To make changes, click Previous to return to the appropriate screen.

�  To being the installation, click Install.

The Install screen appears, and Oracle Scripting Script Author is installed in 
the oracle\apps\ies\author directory of the destination path. The Oracle 
Universal Installer also creates an Oracle Scripting folder in the Programs 
menu.

When the installation is complete, the End of Installation screen appears.

6. Click Exit to close the Oracle Universal Installer.

This completes the installation of Scripting Author. After installing, you may delete 
the Script Author installation package if desired.

See Also
Locating Script Author Installation Package

Downloading Script Author Installation Package

Preparing for Script Author Installation

5.3 Implementing the Scripting Engine Component
As discussed in the Scripting Engine Component section in this document, the 
Scripting Engine provides for the processing of a script in runtime in either of two 
interfaces: a Java-based GUI (for agents), or an HTML-based GUI (for survey 
respondents). Implementation tasks for the Scripting Engine common to all 
operations are addressed first, followed by interface-specific implementation steps.

The following topics are included in this topic group:

Implementing the Scripting Engine

Implementing the Scripting Engine for the Agent Interface

Implementing the Scripting Engine for the Web Interface

Note: Each installation type installs the same components.
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See Also
Performing Top-Level Implementation Tasks

Implementing the Script Author Component

Implementing the Survey Component

5.3.1 Implementing the Scripting Engine
The implementation tasks detailed in this section are required for all Scripting 
Engine operations, regardless of the interface in which scripts are executed.

The following topics are included in this topic group:

Establishing Common IES Profile Settings

Setting Up Server Logging

Adding Custom Java Class Path to jserv.properties File

See Also
Implementing the Scripting Engine for the Agent Interface

Implementing the Scripting Engine for the Web Interface

5.3.1.1 Establishing Common IES Profile Settings
Setting system profiles determines the behavior of Oracle Applications. Set system 
profiles for all Oracle Scripting implementations, if required according to the 
Guidelines section below.

Login
Self-Service Login URL 

Responsibility
System Administrator

Prerequisites
None

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate login URL. Provide an Oracle Applications username and 
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password associated with the required responsibility as indicated above, and 
select the responsibility (if required) to reach the Navigator.

The Navigator will appear with the login responsibility in the title bar (e.g., 
Navigator — System Administrator).

2. In the Functions tab of the Navigator, navigate to Profile > System and click 
Open. 

The System Profile Values window appears. Above this, the Find System Profile 
Values window appears and has focus. These forms allow you to query and 
then view criteria specific to the site, application, responsibility, or user. Next 
you must fill out the query parameters to find system profile values for the 
Scripting application at the site.

3. In the Display area of the Find System Profile Values window, if not already 
checked, check the Site checkbox. Leave the Application, Responsibility, and 
User checkboxes unchecked.

4. If not already checked, check the Profiles with No Values checkbox.

This allows the query to return profiles that meet your search criteria but have 
no values associated with them yet (blank profiles).

5. In the Profile field, enter IES%.

IES is the product code for Oracle Scripting, including all Scripting Engine 
agent GUI and many Survey parameters.

6. Click Find.

The System Profile Values window populates, displaying all profile values for 
Oracle Scripting at the site.

7. Set the IES : Debug Mode profile on or off, in order to control the display of 
debugging and informational messages.

Note: Site is the highest and broadest level of Oracle Applications 
profile settings, and affects all Oracle Applications users unless a 
specific lower level is specified. By changing the search criteria 
from Site to any of the other values (Application, Responsibility, or 
User), you can query and set profiles for lower and more granular 
levels. A lower level profile setting, if populated, always takes 
precedence and supersedes any value set at a higher level.
5-18 Oracle Scripting Implementation Guide



Implementing the Scripting Engine Component
8. Save the system profile values by selecting Save and Proceed from the File 
menu.

The status line will indicate that records has been saved.

9. Select Find from the View menu to reach the Find System Profile Values 
window.

10. Ensure the Site checkbox is checked.

11. Leave the Application, Responsibility, and User checkboxes unchecked and 
the Profiles with No Values checkbox is checked.

12. In the Profile field, enter APPS SERVLET% and click Find.

The System Profile Values window populates, displaying the Apps Servlet 
Agent profile.

13. In the Site column, enter the URL for the Servlet zone of the enterprise Apache 
Web server. 

Syntax:

http://<servername>.<domain>:<Apache Web server port>/<servlet_zone>

Example:

http://server1.yourcompany.com:7777/oa_servlets

14. Save the system profile value by selecting Save and Proceed from the File 
menu.

The status line will indicate that one record has been saved.

15. Close the System Profile Values window by selecting Close Form from the File 
menu.

16. If continuing with implementation steps, proceed to the following procedure 
without logging out. If no other tasks are required, log out of Oracle 
Applications by selecting Exit Oracle Applications from the File menu. 

Guidelines
Following is information regarding each profile setting discussed in this procedure. 

Note:  You can also save the record by clicking the disk icon in the 
toolbar (fifth icon from the left, with a tooltip value of "Save").
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Debug Mode Type: Turning Debug mode on will log additional informational 
messages regarding Oracle Scripting and other operations. Scripting error 
message logs (at any time) and informational message logs (when debug mode 
is on) can be viewed by the CRM HTML-based server log viewer. This requires 
logging into CRM HTML applications from the eBusiness Center login as a user 
with the Interaction Center Server Log Viewer responsibility.

Apps Servlet Agent: This profile contains the Servlet zone of the enterprise 
Apache Web server. This setting is required for Apache Mid-Tier Architecture 
implementations of Oracle Scripting. If your implementation contains multiple 
Apache Web servers for different applications at the site, establish settings for 
the Apps Servlet Agent profile not by Site but by Application, using IES as the 
value for Oracle Scripting.

See Also
Setting Up Server Logging

Adding Custom Java Class Path to jserv.properties File

5.3.1.2 Setting Up Server Logging
When agents execute scripts in the Scripting Engine Java-based GUI using the 
Apache Mid-Tier architecture, or when survey respondents execute scripts in a Web 
browser, error messages are written to server logs. When the Debug mode is on, 
additional informational messages are also written to info logs.

Table 5–1 Scripting Engine Profile Options for All Implementations

Step Option Value

1 IES : Debug Mode Debug off or Debug on

2 Apps Servlet Agent <URL for the Servlet zone of the 
enterprise Apache Web server>

Note:  Server-side error and informational logs when executing 
the agent application in the Caching Architecture (pre-11.5.6 
implementations) are written to the JInitiator Java console. Also, 
client-side errors for Scripting Engine agent operations will 
continue to display in the JInitiator Java console.
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Implementation of server logging is outside the scope of this documentation. From 
an Oracle Scripting perspective, agents or administrators must have access to the 
Interaction Center Server Log Viewer responsibility to access log files to view error 
and informational messages. This procedure is described below.

Login
Self-Service Login URL 

Responsibility
System Administrator

Prerequisites
Server logging for interaction center technologies must already be implemented at 
the site to view server logs. However, the following procedure may be 
accomplished at any time.

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate login URL. Provide an Oracle Applications username and 
password associated with the required responsibility as indicated above, and 
select the responsibility (if required) to reach the Navigator.

The Navigator will appear with the login responsibility in the title bar (e.g., 
Navigator — System Administrator).

2. In the Functions tab of the Navigator, navigate to Security > User > Define and 
click Open. 

The Users window appears. From this window, begin selecting the user for 
whom you wish to assign the Interaction Center Server Log Viewer 
responsibility. 

3. With your cursor in the first tab field (User Name), from the View menu, select 
Query By Example > Enter to begin query mode for a particular user.

The selected tab field (User Name) changes from yellow to blue, and the cursor 
blinks, indicating that you can now enter your query information. 

Note:  You can also enter query mode to enter your search criteria 
by pressing F11 on your keyboard.
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4. Enter the resource or surname for which you are querying. You may use the 
wildcard character (percent sign) as part of your search. Upon entering your 
search criteria, from the View menu, select Query By Example > Run.

� For a successful query in which a single user meets the designated search 
criteria, the status line on the bottom left of the screen will display "Record 
1/1." Fields in the window populate with information pertaining to this 
user. 

� If multiple users meet the designated search criteria, the status line on the 
bottom left of the screen will display "Record 1/?," indicating more records 
are available. Information pertaining to the first user in the found set will 
display in the window. Navigate through the remaining records meeting 
your search criteria by using the Up and Down arrow keys on your 
keyboard, until you find the appropriate record.

In the lower half of the window, a gray region appears displaying information 
for the selected tab (Responsibilities or Securing Attributes). 

5. If not already active, select the Responsibilities tab. 

All of the responsibilities currently assigned to the queried user are displayed. 

6. Place your cursor anywhere in the Responsibilities table and click.

This will result in blue highlighting in that area of the table. 

7. If a blank row is visible in the responsibility table, click in it and proceed to step 
9. 

8. If no blank rows are visible in the responsibility table, click on any populated 
row in the table, then create a new row for the Interaction Center Server Log 
Viewer responsibility you will add. To add a new responsibility row, click the 

Note:  You can also run the query with the criteria you have 
entered by pressing CTRL- F11 on your keyboard.

Caution: Even if highlighting is already evident, perform this 
step. If you do not click here, you will create a new user instead of a 
new responsibility row for the current user if you select the New icon 
from the button menu in the next step. It does not matter where in 
the Responsibility table you click.
5-22 Oracle Scripting Implementation Guide



Implementing the Scripting Engine Component
first icon in the toolbar (a green plus sign icon which displays a tool tip of 
New).

A new row appears immediately below the portion of the Responsibilities table 
that was highlighted.

9. In the Responsibility column of the blank row, search for or enter the 
responsibility name, Interaction Center Server Log Viewer. Press the Tab key or 
select the ellipsis (...) towards the right of the Responsibility tab field. 

� You can enter the full responsibility name, or you can enter partial criteria 
followed by the percent wildcard. Oracle Applications will attempt to 
automatically validate and autofill based on the criteria you entered. If an 
exact match results, the remaining columns will be populated.

� If an exact match cannot be determined, a Responsibilities window appears 
on top of the Users window. Your search criteria appears in the Find tab 
field, with all results that meet your criteria appearing in a list below. 

� If many choices appear in the list, you may scroll through the list to find the 
appropriate responsibility. You may also refine your search criteria in the 
Find field and click Find. Highlight the appropriate choice in the list, and 
click OK. The Find window closes, and the appropriate criteria for all 
columns populates in the current row. 

Responsibility information should appear in the five columns displayed in the 
Responsibility table. By default, the Effective Date (From field) is populated 
with the SYSDATE. 

10. Change the date in the Effective Date From field to a prior date (yesterday’s 
date, the beginning of the current month, or other appropriate choice).

While an effective date starting with the SYSDATE may be effective 
immediately in some environments, best practices dictate that you ensure that 
the effective date you designate will take effect immediately in all 
environments.

Caution: Even if the responsibility table seems to display 
highlighting, ensure that you click anywhere in the table before 
clicking the New icon from the button menu. If you do not click 
here, you will create a new user instead of a new responsibility row 
for the current user.
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11. If desired, enter a date beyond which the responsibility will no longer be 
effective in the To field. This date must be later than the SYSDATE.

12. When satisfied that the values for the Interaction Center Server Log Viewer 
responsibility meet your implementation requirements, save the record by 
selecting Save and Proceed from the File menu.

13. If no other tasks are required, log out of Oracle Applications by selecting Exit 
Oracle Applications from the File menu. 

Guidelines
Assuming the server logging function is appropriately implemented, this user can 
now access the server logs for Oracle Scripting log messages.

See Also
Establishing Common IES Profile Settings

Adding Custom Java Class Path to jserv.properties File

5.3.1.3 Adding Custom Java Class Path to jserv.properties File

Any time a Script Author script references custom Java—regardless of whether that 
script will be executed in the agent interface or in a Web browser as a survey—you must 
have an appropriately configured JAR file available on the applications server, 
containing compiled Java classes referenced in the script. In the Apache Mid-Tier 
architecture for Oracle Scripting, that custom Java needs to be referenced in the 
Apache JServ classpath in order for the Scripting Engine to be able to call those 
classes at runtime. Following are steps to add a custom JAR file to the Apache Web 
server’s JServ configuration file, known as the jserv.properties file.

Note:  You can also save the record by clicking the disk icon in the 
toolbar (fifth icon from the left, with a tooltip value of "Save").

Caution:  There is more than one way to specify a class path for 
Apache. If the method described below is not supported by your enterprise 
implementation, consult with your Apache Web server administrator 
to determine the appropriate method for your environment. This 
may include identifying the classpath in a control file or another 
configuration.
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Login and Responsibility
To access the jserv.properties file you must have physical or Telnet access to the Web 
server, and have applmgr or sysadmin privileges. Use the appropriate login for 
these privileges in your environment.

Prerequisites
� A custom Java method must be written and tested.

� All custom Java methods must be compiled into class files. Oracle Corporation 
recommends compiling custom Java code for use with Oracle Scripting with 
JDK 1.1.8. For more information, see Compiling Custom Code Using JDK 1.1.8.

� All class files must be compressed into a Java Archive (JAR) format. For more 
information, see Supported Methods of Packaging Java Bean Code Into a JAR 
File in this document, and the "Packaging Java Bean Code Into a JAR File" 
subtopic in the Using Oracle Scripting section of Oracle Scripting Concepts and 
Procedures.

� All JAR files must be uploaded to the applications server in a specified 
directory. Any directory accessible to the Web server is acceptable. For ease of 
maintainability, Oracle Corporation recommends creating a directory named 
ies_custom on the JAVA_TOP (Oracle filing system on the applications server) 
specifically for storing custom JAR files for Oracle Scripting. 

Steps
1. Connect using Telnet to the enterprise system.

2.  Change to the directory where your Oracle HTTP Server is installed. Refer to 
the Appendix of your Oracle Applications Installation manual if you are not 
sure where to find this. 

3. Change to the directory in which the jserv.properties file resides.

Note:  The actual name of this file may include an underscore and 
the Apache JServ port (for example, jserv.properties_9404). For the 
purposes of this document, the Apache Web server configuration 
file will be referred to generically as the jserv.properties file. If you 
have any difficulties locating the file, consult with your Apache 
Web server administrator.
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The location of this file is environmentally dependent. It may be in one of the 
following paths:

<ORAHTTP_TOP>/Jserv/etc/jserv.properties

<ORAHTTP_TOP>/apache39/conf

The ORAHTTP_TOP variable may not be set for your environment, in which 
case the path will be fully qualified to identify the entire physical path in the 
filing system. If your configuration is different, consult with your Apache Web 
administrator to locate this directory.

4. Look in the file jserv.properties for a line beginning with wrapper.classpath. 

5. If this configuration file contains a wrapper.classpath entry, you can modify it to 
add the classpath of any custom JAR file your script references in this line. For 
example

wrapper.classpath=/d01/testora/iAS/Apache/xsu/xsu12.jar

6. Save your changes and exit.

Guidelines
� Back up your jserv.properties file prior to customization. After configuring and 

testing, also back up your customized jserv.properties file in a separate location.

� This process will have to be repeated any time you reference new classes in 
Oracle Scripting, regardless of whether the script is executed by agents in the 
Java GUI or by survey respondents in a Web browser.

Caution:  If there is no listing, consult with your Apache Web 
server administrator to determine the appropriate location to 
specify a classpath for your Apache environment in support of 
Oracle Applications.

Caution:  When you apply a patch, any customizations you have 
made to the jserv.properties file may be lost. In this case you will 
need to restore customizations to this file after patching.
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See Also
Establishing Common IES Profile Settings

Setting Up Server Logging

5.3.2 Implementing the Scripting Engine for the Agent Interface
The implementation tasks detailed in this section are required only for Scripting 
Engine operations for the Java-based interaction center agent application.

The following topics are included in this topic group:

Assigning Scripting Engine-Related Responsibilities to a User

Establishing IES Profile Settings for the Agent Interface

See Also
Implementing the Scripting Engine

Implementing the Scripting Engine for the Web Interface

5.3.2.1 Assigning Scripting Engine-Related Responsibilities to a User
The agent interface for the Scripting Engine is a Java bean that runs in an Oracle 
form. A script can be executed in the agent application by any Oracle Applications 
user with the appropriate responsibility.

Scripts can be launched in the agent application either in stand-alone mode 
(recommended for testing), or from an integrated application. In either case, you 
must have the appropriate responsibility for that application assigned to your 
Oracle Applications login.

Following is a summary of Oracle Applications responsibilities for using the 
Scripting Engine in the agent application:

Note:  If you write new Java methods supporting scripts already 
in production, you may wish to combine the compiled code in an 
existing JAR file (and re-uploading) so you need not update the 
jserv.properties file. Oracle Corporation recommends backing up 
custom JAR files prior to changes to any system in production, and 
storing the backups in a separate location.
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The Scripting User or Scripting Agent responsibility is required for a user to launch 
scripts in stand-alone mode.

The Customer Support responsibility is required to run the Oracle Support 
component of Oracle TeleService, from which a user can launch a script in the agent 
interface. 

The TeleSales Agent responsibility is required to run Oracle TeleSales, from which a 
user can launch a script in the agent interface. 

The Collections Agent or Senior Collections Agent responsibility is required for a 
user to launch Oracle Collections, from which a user can launch a script in the agent 
interface. 

For a full list of responsibilities that may be required for Oracle Scripting, see the 
Implementation Responsibility Matrix in the section Creating and Administering 
Oracle Scripting Users.

Steps to create Oracle Applications users, assign them responsibilities, and associate 
them with employees in the enterprise database are also discussed in that section, 
and detailed in Oracle Applications Interaction Center Implementation Guide.

See Also
Establishing IES Profile Settings for the Agent Interface

For a full list of responsibilities that may be required for Oracle Scripting, see the 
Implementation Responsibility Matrix in the section Creating and Administering 
Oracle Scripting Users.

Steps to create Oracle Applications users, assign them responsibilities, and associate 
them with employees in the enterprise database are also discussed in that section, 
and detailed in Oracle Applications Interaction Center Implementation Guide.

Requirement for HRMS Employee and CRM Resource
In a test environment, the Survey Administrator responsibility can be assigned to 
any Oracle Applications user. In a production environment, however, this user must 
be an existing HRMS employee. This employee must also be designated as a CRM 
Resource.

The processes involved to create employees (through either method, as discussed 
below) and any subsequent designation of employees as a CRM resource are 
applications-level administration steps. As such, these are outside the scope of this 
document. The discussion is included below because, for a production 
environment, these are prerequisite to all implementation steps. For more 
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information and detailed steps, see Oracle Applications Interaction Center 
Implementation Guide.

HRMS Employee
The HRMS employee is typically created in Oracle Human Resources Management 
System (HRMS), if licensed by an enterprise. For enterprises that have not licensed 
HRMS, the ability to create employees is also a scaled-down function of Oracle CRM 
Resource Manager. 

If HRMS is installed, Oracle Applications enforces the business rule of requiring the 
user to create a person and designate them as the person type "employee" within 
HRMS. If you attempt to create an employee using CRM Resource Manager while 
HRMS is installed, you will experience an error.

Creating an employee in HRMS is accomplished by a user that has been assigned 
the appropriate HRMS responsibility (in the United States, for example, the US 
HRMS Manager responsibility). 

If HRMS is not installed and licensed by an enterprise, the employee must be 
created using the CRM Resource Manager responsibility.

CRM Resource
After an employee is created, additional information (not required by HRMS) is 
required in order for CRM applications at the enterprise to appropriately reference 
this individual. If the employee is created using CRM Resource Manager, this 
information is part of the definition process.

If the employee is created using HRMS, employee information must subsequently 
be identified as a CRM resource. (By "resource," the concept of a person in the 
enterprise is inferred.) To do so, import the HRMS employee into CRM Resource 
Manager using the CRM Resource Manager responsibility. This process includes 
creation of a Resource Number and a corresponding Resource ID for this individual 
which is required by CRM applications. 

Regardless of which method is used to create the employee (using HRMS or CRM 
Resource Manager), this document refers to this employee as an HRMS employee. 

The other assumption that is a prerequisite for all Survey implementation steps is 
that this employee is identified as a CRM resource.

 For more information and detailed steps, see the Oracle Applications Interaction 
Center Implementation Guide.
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5.3.2.2 Establishing IES Profile Settings for the Agent Interface
Setting system profiles determines the behavior of Oracle Applications. To 
implement the Scripting Engine agent GUI, follow this procedure for all 
implementations.

Login
Self-Service Login URL 

Responsibility
System Administrator

Prerequisites
None

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate login URL. Provide an Oracle Applications username and 
password associated with the required responsibility as indicated above, and 
select the responsibility (if required) to reach the Navigator.

The Navigator will appear with the login responsibility in the title bar (e.g., 
Navigator — System Administrator).

2. In the Functions tab of the Navigator, navigate to Profile > System and click 
Open. 

The System Profile Values window appears. Above this, the Find System Profile 
Values window appears and has focus. These forms allows you to query and 
then view criteria specific to the site, application, responsibility, or user. Next 
you must fill out the query parameters to find system profile values for the 
Scripting application at the site.

3. In the Display area of the Find System Profile Values window, if not already 
checked, check the Site checkbox. Leave the Application, Responsibility, and 
User checkboxes unchecked.

4. If not already checked, check the Profiles with No Values checkbox.

This allows the query to return profiles that meet your search criteria but have 
no values associated with them yet (blank profiles).

5. In the Profile field, enter IES%.
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IES is the product code for Oracle Scripting, including all Scripting Engine 
agent GUI and many Survey parameters.

6. Click Find.

The System Profile Values window populates, displaying all profile values for 
Oracle Scripting at the site.

7. Set the following profiles as indicated. You can set these options in any 
sequence.

See the Guidelines section below for information on these settings.

8. Save the system profile values by selecting Save and Proceed from the File 
menu.

The status line will indicate that records has been saved.

Note: Site is the highest and broadest level of Oracle Applications 
profile settings, and affects all Oracle Applications users unless a 
specific lower level is specified. By changing the search criteria 
from Site to any of the other values (Application, Responsibility, or 
User), you can query and set profiles for lower and more granular 
levels. A lower level profile setting, if populated, always takes 
precedence and supersedes any value set at a higher level.

Table 5–2 Scripting Engine Implementation IES Site-Specific System Profile Options

Step Option Value

1 IES : IES ARCHITECTURE TYPE Apache Mid Tier/Servlet 
Architecture

2 IES : Scripting Panel Display Mode Display Multiple Panels at a 
time in Scripting window or 
Display Single Panel at a time in 
Scripting window

3 IES: PROXY SERVER NAME <Name of Proxy server if used 
for Scripting Engine agent GUI>

4 IES: PROXY SERVER PORT <Port of Proxy server if used for 
Scripting Engine agent GUI>
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9. Close the System Profile Values window by selecting Close Form from the File 
menu.

10. Select Exit Oracle Applications from the File menu to log out of Oracle 
Applications.

Guidelines
Following is information regarding each profile setting discussed in this procedure.

Architecture Type: The only supported architecture type for new Scripting 
Engine 11.5.6 implementations is the Apache Mid Tier/ Servlet Architecture. 

Scripting Panel Display Mode: There are two lookup values from which to 
choose: Display Multiple Panels at a time in Scripting window and Display 
Single Panel at a time in Scripting window. Using single-panel mode, only the 
current (active) panel will appear on the screen at any given time in the agent 
GUI. Under multi-panel display mode, the active panel will have focus, but 
panels previously visited will appear in the GUI, scrolling out of site. Panels 
that are not active are de-emphasized (they appear smaller and gray). Active 
panels display unformatted, spoken, instructional, and custom text in black, 
blue, magenta, and custom colors as designed. For more information, see the 
section "The Panel Display Area" in the Understanding Oracle Scripting > 
Understanding the Scripting Engine section of the Concepts and Procedures 
manual and online documentation.

Note:  You can also save the record by clicking the disk icon in the 
toolbar (fifth icon from the left, with a tooltip value of "Save").

Caution:  If Apache Mid Tier/ Servlet Architecture value is not in 
the list of values, and instead you see Two Tier Mode and Three 
Tier Mode, stop your work and see your systems administrator. 
This means your environment has not been upgraded to Oracle 
Applications 11.5.6. Do not select Three Tier Mode.

Caution:  New Scripting Engine implementations with this 
architecture profile configured for the Caching Architecture 
will not be supported.
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Proxy Server Name: This references the name of any proxy server required for 
using Oracle Scripting, and enables the use of HTTPS. This is only required for 
Scripting Engine agent GUI implementations using a Proxy server.

Proxy Server Port: This references the port number of the appropriate proxy 
server required for using Oracle Scripting, and enables the use of HTTPS. This 
is only required for Scripting Engine agent GUI implementations using a Proxy 
server.

See Also
Assigning Scripting Engine-Related Responsibilities to a User

5.3.3 Implementing the Scripting Engine for the Web Interface
The implementation tasks detailed in this section are required only for Scripting 
Engine operations running scripts in a Web browser as a survey.

In addition to these tasks, implementations requiring the Survey component must 
implement the implementation steps for accessing and using the Survey Admin 
console detailed in Implementing the Survey Component.

The following topics are included in this topic group:

Verifying or Adding a Guest User for the Respondent

Setting Display Server for Unix Environments

5.3.3.1 Verifying or Adding a Guest User for the Respondent
In order for survey respondents to take a survey, they typically click a URL that 
points to a specific survey deployment on the surveying enterprise’s Scripting 
specific Apache Web server. From an applications perspective, this requires the use 
of a guest login defined in CRM HTML-based applications. The guest login (user 
name and password) must be associated with a login created within Forms-based 
Oracle Applications by a user with the System Administrator responsibility. This 
login has no responsibilities associated with it. This provides the ability to create an 
Oracle Applications session for the (potentially anonymous) respondent with very 
limited access.

Some enterprises already have requirements for a guest user. Thus, to implement 
the Survey component of Oracle Scripting, one required implementation task is to 
verify whether the guest login exists in the relevant environment and, if not, to 
create a guest login (user name and password). 
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Unlike all previous tasks, this implementation task is performed in CRM 
HTML-based applications accessed by the HTML login page sometimes referred to 
as the Oracle eBusiness Center login.

Login
HTML Login URL

Responsibility
System Administrator 

Prerequisites
� A login for the guest user must have been created in Forms-based Oracle 

Applications by a user with the System Administrator responsibility. Ensure 
this guest user has no responsibilities associated with it. If such a user does not 
exist, create it. 

� The username is not important; for ease of administration, if creating the 
user specifically for use with the Survey component of Oracle Scripting, 
name the guest user iesguest.

� Assign a simple password (for example, iesguest or welcome). Ensure that 
the password will not expire. 

� Note the username and password for use in the procedure described below.

� To perform this procedure, you must have the System Administrator 
responsibility assigned to provide access to CRM HTML-based applications as a 
sysadmin.

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate login URL. Provide an Oracle Applications user ID and password 
associated with the required responsibility as indicated above.

The appropriate administrative console should appear, with the Home tab or 
primary function active.

� If a default CRM application GUI is already established for this user login, 
and it is not for systems administration, you may need to change the 
current responsibility. You need the System Administrator responsibility to 
perform this implementation task.
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� If this is the first time you are logging into CRM HTML-based applications, 
you may be asked to establish a default responsibility. In this case you will 
need to do so, log out, and log back in.

2. From the set of tabs at the top of the page, click the third tab from the left, the 
Settings tab.

The Settings page appears. There are three sub-tabs associated with the Settings 
page: Security, Site Preferences, and System.

3. Click the third sub-tab from the left, System.

A set of fourth-level navigation links will display on the left of the System page.

4. Click the last left-hand navigation hyperlink, Advanced.

The Advanced - Properties page appears. 

5. Select JTF from the View dropdown control. Using this control you can 
determine which properties display using the View dropdown control.

All advanced properties for JTF display, if any.

6. Scroll through the list to determine whether the JTF properties guest username 
and guest password have already been created.

If you see these JTF properties in the list, no new administrative steps are 
required, and you can sign out of this administrative console by selecting the 
Sign Out icon located at the top right of the screen, or continue to the next 
implementation step.

 If these properties do not exist, continue the following steps to create them.

7. Click the Create button. 

The Create Key page will display. The values stored in this table are stored in 
key value pairs. Sequence is not relevant to this procedure.

8. In the Key text field, type the key guest_username.

9. In the Value text field, type the value of a User ID that is designated for a guest 
login. 

Caution: If you cannot locate these properties, check the bottom 
right side of the page to determine if you must click Next before 
proceeding to create these properties. It is likely that not all JTF 
properties will appear on the first display page.
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CRM HTML-based applications use the term User ID for an Oracle 
Applications User Name. As described above, this User ID must have been 
created in Forms-based administration and have no responsibilities associated 
with it.

10. When you are satisfied that the guest user you have defined meets your 
implementation specifications, click Update at the bottom of the key details 
table. 

The Advanced - Properties page will again display.

11. Ensure the properties displayed are for JTF, and click the Create button. 

The Key Details page will display. 

12. In the Key text field, type the key guest_password.

13. In the Value text field, type the value of the corresponding password for the 
user identified by the User ID you defined in the previous step.

14. When you are satisfied that the guest password you have defined meets your 
implementation specifications, click Update at the bottom of the key details 
table. 

15. Sign out of this administrative console by selecting the Sign Out icon located at 
the top right of the screen, or continue to the next implementation step.

Guidelines
To verify that the guest user is properly set up, see Verifying the Implementation > 
Guest User Verification Steps.

See Also
Setting Display Server for Unix Environments

5.3.3.2 Setting Display Server for Unix Environments
Oracle Applications release 11.5.6 can dynamically generate and cache images with 
embedded text at runtime. These dynamic images are used, for example, to create 
buttons and tab menu bars displayed throughout various HTML-based transaction 
pages. 

JFC/SWING and AWT (graphics libraries that are standard components within 
Java) require access to the native library of the operating system to do anything 
with graphics processing (such as display a window, paint a picture, generate a GIF 
image, and so on).
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The Survey component of Oracle Scripting employs JFC/SWING and AWT on the 
middle tier, where GIF images are processed in support of dynamically generated 
reports with graphics, and to render a script in a Web browser using HTTP.

Java AWT on Windows servers (Windows NT, Windows 2000) does not need a 
display server to render the graphics dynamically. However, in order for Java AWT 
to perform dynamic image generation on Unix, you must specify an X Server that 
will be used as a display server to generate dynamic images. Images are generated 
and cached on the file system. Once these images have been cached, they need not 
be generated again. For this reason, the display server does not need to be a 
high-powered machine, nor is it required to be a dedicated server. However, it must 
be accessible by the Apache server that will call it.

To ensure graphics display functions in all Unix environments, there are two 
processes you should perform in a Unix environment:

� Modify jserv.properties to implement the Display Server identifier

� Reference the X Server in the apachectl or jservctl file (whichever is used in 
your environment to start the JServ).

Prerequisites
You must have an X Server up and running, on the network and able accessible 
from the Apache JServ machine.

Steps
1. Access the jserv.properties file.

This is typically located at <ORAHTTP_TOP>/Jserv/etc/jserv.properties on the 
Web server.

2. Make the following changes to implement the Display Server identifier.

This can be done through xhost +, or through a more secure xauth Unix 
command.

c. Add the following DISPLAY parameter immediately below the wrapper.bin 
variable. 

wrapper.env=DISPLAY=<xserver-hostname>
<xserver-displayport>

d. Replace <xserver-hostname> and <xserver-displayport> with the machine 
name and port number where the X Server is running.

Example:
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wrapper.env=DISPLAY=myxserver.mycorp.com:0.0

3. Reference the X Server in the apachectl or jservctl file:

Example:

export DISPLAY=myxserver.mycorp.com:0.0

Guidelines
All implementation tasks are complete. You must now verify the implementation as 
appropriate.

See Also
Verifying or Adding a Guest User for the Respondent

Setting Display Server for Unix Environments

5.4 Implementing the Survey Component
The tasks listed in this section are for implementing the Survey component of 
Oracle Scripting. After performing these steps, an administrator should be able to 
access the Survey Admin console to administer survey campaigns and survey 
resources, and deploy survey campaigns. Additionally, upon completion, a survey 
respondent should be able to participate in a survey using a Web browser.

Note that not all implementation tasks are required. Some are specific to list-based 
implementations. These are specified at the beginning of each task.

Note that any survey implementations requiring custom Java to be used in support 
of a script must also follow the implementation step Adding Custom Java Class 
Path to jserv.properties File.

Note: You can also reference a Windows NT machine that is 
running a Unix emulator such as Exceed. See the man (Unix 
manual) pages for xhost and xauth for more information. 

Note: Whichever file is used to start the JServ for your 
environment— apachectl or jservctl—should be modified to 
reference the X server. 
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This topic group includes the following topics:

Assigning Survey-Related Responsibilities to a User

Establishing IES Profile Settings for Survey at the Site Level

Establishing Required Non-IES System Profiles at the User Level

Assigning Fulfillment Administrator Role to Survey Administrator

Adding Survey Administrator User to Fulfillment Group

See Also
Performing Top-Level Implementation Tasks

Implementing the Script Author Component

Implementing the Scripting Engine Component

5.4.1 Assigning Survey-Related Responsibilities to a User
Following is a summary of Oracle Applications responsibilities for using Survey:

The Survey Administrator responsibility is required for a user to log into the Survey 
Admin console, from which survey campaigns are created, deployed, and managed.

The iSurvey User responsibility is required to run Concurrent Manager for 
processing and scheduling of concurrent programs discussed in the Administering 
Oracle Scripting section of this implementation guide.

Optionally, you can assign the JTF_FM_ADMINISTRATOR (Fulfillment 
administrator) responsibility, required to access Oracle One-to-One Fulfillment, to 
an Oracle Applications user with the Survey Administrator responsibility. In this 
way, the same user would have the ability to administer all aspects of Fulfillment 
required for list-based survey operations.

Note:  While assigning the Fulfillment administrator to a survey 
administrator user is not required, logging into Oracle Applications 
as a Fulfillment administrator is required in order to perform the 
implementation step Adding Survey Administrator User to 
Fulfillment Group. 
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For a full list of responsibilities that may be required for Oracle Scripting, see the 
Implementation Responsibility Matrix in the section Creating and Administering 
Oracle Scripting Users.

Steps to create Oracle Applications users, assign them responsibilities, and associate 
them with employees in the enterprise database are also discussed in that section, 
and detailed in Oracle Applications Interaction Center Implementation Guide.

See Also
Establishing IES Profile Settings for Survey at the Site Level

Establishing Required Non-IES System Profiles at the User Level

Assigning Fulfillment Administrator Role to Survey Administrator

Adding Survey Administrator User to Fulfillment Group

5.4.2 Establishing IES Profile Settings for Survey at the Site Level
This step is required for all Survey implementations. This implementation step 
establishes system profile settings for Oracle Scripting (product code IES) for all 
users at the site. System profile settings set at the site level affect the behavior of 
Oracle Applications for the entire enterprise. Some IES profiles may already be 
established if Oracle Scripting is used in the interaction center (with agents running 
scripts in the Scripting Engine). Different IES profile settings are applicable to the 
Survey component, and none conflict. Nonetheless, if any of the profiles discussed 
in this section are required to be set at a site level with different settings, you may 
set them at a lower level (such as User) to ensure survey operations are successful 
without disturbing other requirements. 

Login
Self-Service Login URL 

Responsibility
System Administrator 

Note:  If you cannot match the Fulfillment administrator 
responsibility name mentioned in this document, see the section 
Responsibility Names Versus Responsibility Keys in the 
Troubleshooting section of this document.
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Prerequisites
� An Oracle HRMS employee must already exist in the enterprise, must be 

available as a CRM resource, and must be associated with an Oracle 
Applications login. For more information, see Requirement for HRMS 
Employee and CRM Resource.

� This step can be performed before or after establishing system profile settings at 
the user level.

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate login URL. Provide an Oracle Applications username and 
password associated with the required responsibility as indicated above, and 
select the responsibility (if required) to reach the Navigator.

The Navigator will appear with the login responsibility in the title bar (e.g., 
Navigator — System Administrator).

2. In the Functions tab of the Navigator, navigate to Profile > System and click 
Open. 

The System Profile Values window appears. Above this, the Find System Profile 
Values window appears and has focus. This window allows you to view criteria 
specific to the site, application, responsibility, or user. Next you must fill out the 
search criteria to find system profile values for the Scripting application at the 
site.

3. In the Display area of the Find System Profile Values window, if not already 
checked, check the Site checkbox. Leave the Application, Responsibility, and 
User checkboxes unchecked.

4. If not already checked, check the Profiles with No Values checkbox.

5. In the Profile field, enter IES%.

IES is the product code for Oracle Scripting. The Survey component of Oracle 
Scripting employs the Scripting Engine to run scripts in a Web browser.

6. Click Find.

The System Profile Values window populates, displaying all profile values for 
Oracle Scripting at the site.
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7. Set the following IES profiles as indicated. You can set these options in any 
sequence. For information on these settings, see Guidelines below.

8. Save the system profile values by selecting Save and Proceed from the File 
menu.

9. If continuing with the next implementation task (Establishing Required 
Non-IES System Profiles at the User Level), skip to step 5 of that task. 
Otherwise, log out by selecting Exit Oracle Applications from the File menu.

Guidelines
For all implementations, proceed to the next task, Establishing Required Non-IES 
System Profiles at the User Level.

System Profile Value Notes
IES TIME FORMAT: When defining deployments for a survey campaign, you 
must establish deployment and response end dates and times. This requires a 
time format value (for example, HH:MI PM) to be set in this system profile in 
order to display in the Survey Admin console. Set this to the appropriate format 
based on the requirements provided to you by the campaign administrator.

Debug Mode: Turning Debug mode on for the Survey component will allow 
HTML client or JSP interpretation error messages to write to the CRM 
HTML-based server log viewer. These are automatically stored in the Apache 
server logs. Scripting Engine errors (interpretation of the script, custom code 
and respondent actions) will automatically store messages in this log 
regardless. For more information, see Survey Execution Errors in the 
Troubleshooting section.

Note:  If the Scripting Engine agent interface is already 
implemented at this site, then several relevant IES profile settings 
will already be established. Only the profile values relevant to 
implementing the Survey component are discussed herein. 

Table 5–3 Survey Implementation-Specific Site-Level IES System Profile Options

Step Option Value

1 IES: TIME FORMAT As required. Example:

HH:MI PM
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See Also
Assigning Survey-Related Responsibilities to a User

Establishing Required Non-IES System Profiles at the User Level

Assigning Fulfillment Administrator Role to Survey Administrator

Adding Survey Administrator User to Fulfillment Group

5.4.3 Establishing Required Non-IES System Profiles at the User Level
This step is required for all Survey implementations. In addition to setting site-level 
IES system profiles, some profiles must be set at the user level for appropriate 
Survey administration and use. This is a necessary part of your implementation.

Site-level profile settings affect every user at the site; lower level settings override 
the higher, more generic ones. The lowest and most specific profile setting level is 
user, which establishes behavior for a specific login (user name and password). This 
step includes one Internet Cartridge Exchange (ICX) profile and several Java 
Technology Foundation (JTF) profiles. These must be established for each survey 
campaign administrator (each person who must access the Survey Admin console), 
regardless of whether that user will create and define survey campaign and survey 
resource details or just monitor deployments and generate preconfigured report 
data on survey campaigns or on Scripting Engine scripts (e.g., access footprinting 
reports). 

Login
Self-Service Login URL 

Responsibility
System Administrator 

Prerequisites
� An Oracle HRMS employee must already exist in the enterprise, must be 

available as a CRM resource, and must be associated with an Oracle 
Applications login. For more information, see Requirement for HRMS 
Employee and CRM Resource.

� The Oracle Applications login must have the System Administrator 
responsibility assigned to provide access to Forms-based applications as a 
SysAdmin.
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� If the Survey administrator for whom you are setting the profiles requires a 
default application to be set for entering the JTF technology stack HTML-based 
applications from the HTML Login URL, you must first obtain the Survey 
RESPONSIBILITY_ID code, which is environmentally specific. Perform the 
procedures in the topic Determining the Survey Responsibility ID Code in the 
Administering Oracle Scripting section of this Implementation Guide prior to 
performing this task.

� This step can be performed before or after establishing IES system profile 
settings at the site level.

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate login URL. Provide an Oracle Applications username and 
password associated with the required responsibility as indicated above, and 
select the responsibility (if required) to reach the Navigator.

The Navigator will appear with the login responsibility in the title bar (e.g., 
Navigator — System Administrator).

2. In the Functions tab of the Navigator, navigate to Profile > System and click 
Open. 

The System Profile Values window appears. Above this, the Find System Profile 
Values window appears and has focus. This window allows you to view criteria 
specific to the site, application, responsibility, or user. In this case you must set 
user level profiles for the default language (profile ICX: Language) and some 
JTF default profiles. 

3. If the System Profile Values window has focus, select Find from the View menu 
to reach the Find System Profile Values window.

4. Perform the following in the Find System Profile Values window:

In the Display area of the Find System Profile Values window:

e. The Site checkbox is checked by default.

Click to uncheck it.

f. The Application, Responsibility, and User checkboxes are unchecked by 
default.

Check the User checkbox. In the User field, locate the username of the 
resource for whom you wish to establish these profiles. This includes, at 
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minimum, the single Survey administrator for whom the previous 
implementation tasks have been performed.

g. The Profiles with No Values checkbox is checked by default.

Leave this checkbox checked.

h. The Profile field is blank by default.

Enter ICX% in the Profile field.

i. Click Find.

The System Profile Values window populates, displaying all profile values 
for ICX parameters for this user at the site. ICX refers to the Internet 
Cartridge Exchange for Web-based transaction settings.

 The username populates the User field in the first row, the fifth and last 
column on the right

5. Scroll through the list and locate the ICX: Language profile row.

6. In the User column of the ICX: Language profile row, set the language to the 
appropriate language from the FND_LANGUAGES table. 

For example, for English in the United States, select American English.

7. Save the record and proceed.

The status line will indicate that one record has been saved.

8. Select Find from the View menu to reach the Find System Profile Values 
window.

In the Display area of the Find System Profile Values window, ensure the Site, 
Application, and Responsibility checkboxes are unchecked. 

Ensure the User checkbox is checked. In the User field, if not already 
appropriately populated, locate the username of the Survey administrator 
resource.

Ensure the Profiles with No Values checkbox is checked.

9. In the Profile field, enter JTF%.

JTF is the product code for Java Technology Foundation, representing 
Foundation applications such as Oracle One-to-One Fulfillment. These settings 
also determine the display for several parameters in the CRM Web-based 
application suite.

10. Click Find.
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The System Profile Values window populates, displaying all profile values for 
JTF parameters for this user at the site.

11. Set the following profiles as indicated. You can set these options in any 
sequence. For information on these profile settings, see Guidelines below.

12. After setting the JTF profiles as indicated, save and exit Oracle Applications.

Guidelines
For user logins that will primarily or solely access the Survey Admin console, you 
can establish the default CRM JSP application by setting the system profile JTF_
PROFILE_DEFAULT_RESPONSIBILITY. This determines which application GUI 
will display upon login to the eBusiness Application Suite.

For list-based survey campaign implementations, you must next perform the 
implementation task Assigning Fulfillment Administrator Role to Survey 
Administrator.

System Profile Value Notes
General: The settings above (such as default number of blank rows or default 
number of rows) are provided as recommendations. If there are business rules 
or requirements in your environment for other settings, let those requirements 
take precedence.

Default Application: This setting assumes this Survey administrator user does 
not already have other functions in JTF technology stack HTML-based 
applications accessible from the HTML Login URL. Should other 
responsibilities exist for this user, confer with your systems administrator or the 
specific user to determine whether to modify the existing setting. 519 as 

Table 5–4 Survey and JTF-Recommended User-Level System Profile Options

Step Option Value

1 JTF_PROFILE_DEFAULT_APPLICATION 519 <see note below>

2 JTF_PROFILE_DEFAULT_BLANK_ROWS 3 

3 JTF_PROFILE_DEFAULT_CSS jtfucss.css

4 JTF_PROFILE_DEFAULT_CURRENCY <Applicable currency. For 
example, USD for U.S. Dollars>

5 JTF_PROFILE_DEFAULT_NUM_ROWS 10

6 JTF_PROFILE_DEFAULT_RESPONSIBILITY <see note below>
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indicated above is the product code for Oracle Scripting. This setting is not 
environment-specific.

Default Responsibility: This setting determines the responsibility that is 
displayed when a user logs into JTF technology stack HTML-based applications 
from the HTML Login URL. If no other responsibilities existed for this user, the 
Survey responsibility should be entered. If this user already has other 
responsibilities, it may be a requirement to leave this setting. This setting is 
specific to each environment and must be discovered in the process described 
the topic Determining the Survey Responsibility ID Code in the Administering 
Oracle Scripting section of this Implementation Guide.

See Also
Assigning Survey-Related Responsibilities to a User

Establishing IES Profile Settings for Survey at the Site Level

Assigning Fulfillment Administrator Role to Survey Administrator

Adding Survey Administrator User to Fulfillment Group

5.4.4 Assigning Fulfillment Administrator Role to Survey Administrator
This step is only required for list-based Survey implementations. A user with the 
Fulfillment Administrator responsibility must also be assigned the Fulfillment 
Admin Role (JTF_FM_ADMIN). This role enables access to Oracle One-to-One 
Fulfillment’s GUI from within the Survey Admin console. You must assign this role 
to a user that has the Survey Administrator responsibility as well. 

Login
HTML Login URL

Responsibility
System Administrator 

Note: This step is not required for non-list-based survey campaign 
implementations, which will not be leveraging Fulfillment 
capabilities. 
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Prerequisites
� An Oracle HRMS employee must already exist in the enterprise, must be 

available as a CRM resource, and must be associated with an Oracle 
Applications login. For more information, see Requirement for HRMS 
Employee and CRM Resource.

� The Oracle Applications login must have the System Administrator 
responsibility assigned to provide access to CRM HTML-based applications as a 
sysadmin. This includes establishing the appropriate set of system profiles for 
site and user levels as discussed in previous implementation tasks.

� Oracle One-to-One Fulfillment does not need to be implemented at the 
enterprise to perform this step. Note, however, that Fulfillment must be 
implemented in order to use the Survey component of Oracle Scripting for 
list-based implementations, including for testing.

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate login URL. Provide an Oracle Applications user ID and password 
associated with the required responsibility as indicated above.

The appropriate administrative console should appear.

2. From the set of tabs at the top of the page, click the Users tab.

The Users page appears. If necessary, select the Users subtab (hyperlink) to 
display existing users.

3. Find the user for whom you want to assign the Fulfillment Admin role.

� You may search by User Name, First Name, or Last Name. 

� Select your preferred user search category from the Find Users or Enter 
Search Criteria dropdown menu.

� Enter your search criteria in the text field immediately to the right of the 
dropdown menu, and click Go.

In this step you are searching for the established survey administrator (the user 
to whom you previously assigned both Survey Administrator and Fulfillment 
Administrator responsibilities.

4. From the resulting list of records that matches your search criteria, click on the 
hyperlinked username of the appropriate user.

The User Detail page appears. Note that this is where the password for this user 
may also be changed if desired.
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5. Click on Roles at the bottom of the user detail information area.

 This results in the User-Role Mapping page, where two lists are displayed 
(Available Roles and Assigned Roles).

6. Locate JTF_FM_ADMIN role in the Available Roles list.

7. Highlight JTF_FM_ADMIN and select the > button to move the highlighted role 
to the Assigned Roles list.

8. Click Update.

9. Sign out of this administrative console by selecting the Sign Out icon located at 
the top right of the screen.

At this point, you have completed this implementation task. Perform the 
remaining steps to verify that you have successfully assigned the Fulfillment 
Administrator role to the Survey Administrator.

10. At the eBusiness Center login screen, enter the User ID and Password for a user 
with the Survey Administrator responsibility (use the login for the Survey 
administrator for whom you just assigned the Fulfillment administrator role). 
Upon entering the correct login information, click Go.

The Survey Admin console appears, with the Home tab active. The content 
displayed on this page (if any) is environmentally dependent.

11. Click the Fulfillment tab. Fulfillment functions should display.

If you can successfully enter the Fulfillment tab, displaying a Fulfillment 
sub-tab and displaying the Master Document page, you have verified that:

Note:  If clicking the button does not have the desired result, you 
may need to click directly on the > character (rather than the gray 
portion of the button) in order to specify that the highlighted role 
should move to the Assigned Roles list.

Note:  This GUI will only display automatically for Survey 
administrators for whom Survey has been specified as the default 
application GUI. This is described in implementation tasks 
Establishing Required Non-IES System Profiles at the User Level 
and Determining the Survey Responsibility ID Code.
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� You have appropriately assigned the Fulfillment Admin role to the Survey 
administrator user.

� Oracle One-to-One Fulfillment is implemented in your environment.

12. Sign out of this administrative console by selecting the Sign Out icon located at 
the top right of the screen.

Guidelines
� If you experience any issues with this implementation task, refer to 

Troubleshooting Fulfillment Admin Role Assignment in this Implementation 
Guide.

� For list-based implementations, the next required implementation task is to add 
this Survey administrator user to a Fulfillment Group.

� For non-list-based implementations, if you are using a Unix server you must 
complete the task Setting Display Server for Unix Environments. Otherwise, 
you have completed all tasks and must now verify your implementation.

See Also
Assigning Survey-Related Responsibilities to a User

Establishing IES Profile Settings for Survey at the Site Level

Establishing Required Non-IES System Profiles at the User Level

Adding Survey Administrator User to Fulfillment Group

5.4.5 Adding Survey Administrator User to Fulfillment Group
This task is only required for list-based implementations, and should be performed 
once per Survey administrator user. However, this step is not required for 
non-list-based survey campaign implementations, which will not be leveraging 
Fulfillment capabilities.

If you are already logged into CRM HTML-based applications, you can change 
responsibilities by clicking on the Profile icon and selecting a new responsibility for 
the current applications session.

Login
 HTML Login URL
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Responsibility
Fulfillment Administrator 

Prerequisites
� An Oracle HRMS employee must already exist in the enterprise, must be 

available as a CRM resource, and must be associated with an Oracle 
Applications login. For more information, see Requirement for HRMS 
Employee and CRM Resource.

� Oracle One-to-One Fulfillment does not need to be fully implemented at the 
enterprise to perform this step, as long as a Fulfillment group has been created. 
Note, however, that Fulfillment must be implemented in order to use iSurvey 
for list-based implementations, including for testing.

 Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate login URL. Provide an Oracle Applications user ID and password 
associated with the required responsibility as indicated above.

The appropriate administrative console should appear.

Upon clicking Go, the Home tab is active. The content displayed on this page (if 
any) is environmentally dependent.

2. From the set of tabs at the top right-hand side of the page, click the Group tab.

The Groups page appears, with the Group tab active. Under the Groups 
heading, a listing of all available Fulfillment Groups will display as an HTML 
table with hyperlinks.

Note:  The default Fulfillment Admin responsibility seeded with 
Oracle Applications is named JTF_FM_ADMINISTRATOR. Based 
on your environment, the Fulfillment administrator responsibility 
you use may have a different responsibility name. If you cannot 
find the appropriate responsibility name for your environment, 
consult with your systems administrator.
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3. Click on the appropriate Group Name hyperlink.

The Group Detail page appears.

4. In the Agents table under Group Detail, add the User Name of the agent you 
wish to add to the Fulfillment group in the text field under the Name column. 

This is the username of the Survey administrator.

5. In the Agents table under Group Detail, add the User Name of the agent you 
wish to add to the Fulfillment group in the text field under the Name column, 
and click Go. 

In this field, enter the User Name or ID of the Survey administrator.

If necessary, you can search for the appropriate User Name from the list of all 
available agents. You can narrow your criteria using the wildcard character %.

When you click Go, the page will refresh, with the User Name of the agent you 
selected added to the list.

6. Click Update to confirm your selection.

The Groups page will again result.

At this point, this implementation task is completed, and you have added the 
Survey administrator user to the appropriate Fulfillment Group. Perform the 
remaining steps to verify that this implementation task was successful.

7. Select the same Group Name hyperlink from the Groups page.

The Group Detail page appears.

8. Verify that the survey administrator username appears in the list of agents.

9. Sign out of this administrative console by selecting the Sign Out icon located at 
the top right of the screen.

Caution: A Fulfillment Group is required to perform this step. If 
no Fulfillment Groups are established, you must first establish one 
based on the requirements and procedures documented in Oracle 
One-to-One Fulfillment Implementation Guide and Oracle One-to-One 
Fulfillment Concepts and Procedures. After a Fulfillment Group has 
been appropriately established, return to this Implementation 
Guide and perform this step.
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Guidelines
� If your implementation is on a Unix environment, proceed to the task Setting 

Display Server for Unix Environments. Otherwise, for list- and non-list-based 
implementations, all implementation tasks are complete. You must now verify 
the implementation as appropriate.

� For troubleshooting tips regarding accessing the Survey Admin console, see If 
You Cannot See the Survey Admin Console.

� For troubleshooting tips regarding accessing Fulfillment tabs in the Survey 
Admin console, see Troubleshooting Fulfillment Admin Role Assignment.

See Also
Assigning Survey-Related Responsibilities to a User

Establishing IES Profile Settings for Survey at the Site Level

Establishing Required Non-IES System Profiles at the User Level

Assigning Fulfillment Administrator Role to Survey Administrator
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Administering Oracle Scripting

Administration of Oracle Scripting Survey Campaigns is discussed in detail in the 
Oracle Scripting online help and Oracle Scripting Concepts and Procedures Manual. 
The administration tasks listed here are Oracle Applications-level tasks directly 
related to implementing Oracle Scripting.

This topic group includes the following topics:

Determining the Survey Responsibility ID Code

Executing Concurrent Programs to Update Deployment Status

Executing Concurrent Programs to Summarize Survey Data

Executing Concurrent Programs to Send Fulfillment Requests for List-Based 
Surveys

6.1 Determining the Survey Responsibility ID Code
In order to establish a default application GUI to display upon login to CRM 
JSP-based applications, you must set the user profile setting JTF_PROFILE_
DEFAULT_RESPONSIBILITY.This step is described in the task Establishing 
Required Non-IES System Profiles at the User Level. Since this responsibility is 
environment-specific, you must perform the following task to obtain this value.

Prerequisites
� This step is required for obtaining the Survey product code specific to your 

environment. This is required for setting the JTF_PROFILE_DEFAULT_

Note: This step is not required for established users that must 
maintain a different default CRM application as their login GUI. 
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RESPONSIBILITY parameter indicated as the last item in the table Survey and 
JTF-Recommended User-Level System Profile Options

� This is required to establish the JTF_PROFILE_DEFAULT_RESPONSIBILITY 
system profile setting, which is a user-level profile setting.

� This step is not required if an Survey administrator already has a default 
responsibility set for using JTF technology stack HTML-based applications from 
the " and intends to keep that responsibility. For more information, consult your 
SYSADMIN.

� An Oracle HRMS employee must already exist in the enterprise, must be 
available as a CRM resource, and must be associated with an Oracle 
Applications login.

� For list-based implementations, you must have assigned the JTF_FM_
Administrator responsibility to a user with the Survey Administrator 
responsibility.

� This step, which results in the product code for the Survey component of Oracle 
Scripting, can be performed before or after establishing system profile settings 
for the Scripting application at the site level. It is required to set the last 
parameter for the user-level system profiles.

Before You Begin This Step
If you are already logged in as a user with the System Administrator responsibility, 
and are continuing from Implementation Step 3, begin from procedural step 4 in the 
section immediately below.

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate URL for your environment to log into Forms-based applications. 

Either the SSWA or Forms login is appropriate.

2. From the applications login screen, enter in the provided fields a User Name 
and Password for a user with the System Administrator responsibility, and click 
Connect. 

3. From the list of responsibilities, select System Administrator. 

4. In the Functions tab of the Navigator, navigate to Security > Responsibility > 
Define and click Open. 
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To give focus to the Navigator, select Navigator—System Administrator from 
the Window menu.

5. With your cursor in the first tab field (Responsibility Name), begin query mode 
to search for the Survey Administrator responsibility.

6. Enter the responsibility name for which you are querying, and run the query.

�  Remember that the Survey administrator responsibility is known to Oracle 
Applications as Survey Administrator. 

� You may use the wildcard character (percent sign) as part of your search. 
For example, you can enter %SUR%.

� If multiple responsibility records are returned, locate the appropriate record 
by using the Up and Down arrow keys on your keyboard.

7. Click in the Responsibility Name tab field. From the Help menu select 
Diagnostics > Examine. 

If asked for a password, enter the apps level password.

The Examine Field and Variable Values form will pop. There are three tab fields: 
Block, Field, and Value.

8. Place your cursor anywhere in the Field tab field and click the ellipses.

The Choose a field window results.

9. Select RESPONSIBILITY_ID from the resulting list of values and click OK.

10. Record the value in the Value tab field. 

This is the RESPONSIBLITY_ID for the Survey Administrator responsibility. 
This value is required to be entered into the JTF_PROFILE_DEFAULT_
RESPONSIBILITY profile setting referred to in the implementation task 
Establishing Required Non-IES System Profiles at the User Level.

11. Click Cancel to close the Examine Field and Variable Values form.

12. From the File menu, select Close Form.

6.2 Executing Concurrent Programs to Update Deployment Status
When you select define a survey deployment—the specific set of criteria for a 
survey cycle over a specified period of time—one set of criteria includes the 
deployment end date and time.
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A concurrent program, already defined within Oracle Applications release 11.5.6 or 
later, must be executed on a regular basis to check this deployment end date and 
time. This process occurs from the Concurrent Manager and is performed by a 
survey administrator. When a deployment has passed its deployment end date and 
time, the deployment is closed by this concurrent program, updating the status in 
the database from "Active" to "Closed."

This, in turn, changes the status of corresponding (parent) cycle and survey 
campaign from "Active" back to "Open," if there are no other active deployments 
under the same cycle and survey campaign.

Oracle Corporation recommends executing this concurrent program once daily at 
an off-peak time (a time when load on the system is not high). For example, this 
could be one of the closing operations an interaction center supervisor performs at 
the end of the day.

Login
Self-Service Login URL 

Responsibility
iSurvey User

Prerequisites
There are no prerequisites for executing this concurrent program. However, in order 
for this program to have any useful effect:

� The Survey component of Oracle Scripting must have been fully implemented.

� A survey campaign must already have been created and its children objects 
(survey cycle and survey deployment) defined.

� A deployment must have been made active.

� The deployment end date and time, as defined in the deployment detail and 
compared to SYSDATE, must be in the past.

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate URL for your environment to log into Forms-based applications. 

Use either the SSWA or Forms login, as appropriate.
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2. From the applications login screen, enter in the provided fields a User Name 
and Password for a user with the iSurvey User responsibility, and click 
Connect. 

3. From the list of responsibilities, select iSurvey User. If necessary, click OK to 
confirm your selection.

 The resulting menu will display the various options for concurrent processing

4. Run the Update Deployment Status concurrent program from the resulting list.

For specific details on executing or scheduling concurrent programs, please 
refer to Chapter 5 of Oracle System Administrator's Guide. 

For a description of these concurrent programs, refer to the Oracle Scripting 
online help or Oracle Scripting Concepts and Procedures.

5. After executing each concurrent program, log out of Forms-based Oracle 
Applications if desired by selecting Exit Oracle Applications from the File 
menu.

6.3 Executing Concurrent Programs to Summarize Survey Data
When interaction center agents execute a script, or when survey respondents 
participate in a survey, their individual answers are collected in the Oracle Scripting 
schema of the applications database. 

For generating footprinting reports (typically for the agent interface) or for 
generating reports on survey data, information must be moved into summary tables 
that make the data accessible to the reporting tools in the Survey Admin console 
under the Analysis tab.

Run this concurrent program prior to viewing any reports for the most current data, 
or schedule this program to execute on a regularly scheduled basis (for example, 
once daily at an off-peak time, when load on the system is not high).

Login
Self-Service Login URL 

Responsibility
iSurvey User
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Prerequisites
There are no prerequisites for executing this concurrent program. However, in order 
for this program to have any useful effect:

� The Survey component of Oracle Scripting must have been fully implemented.

� A survey campaign must already have been created and its children objects 
(survey cycle and survey deployment) defined.

� A deployment must have been made active.

� For survey reports, respondents must have participated in the survey. In this 
way, data is available in the IES schema of the Applications database to 
summarize for reporting purposes.

� For footprinting reports, the "Footprinting" option must be enabled in the 
deployed script executed by Scripting Engine interaction center users (agents).

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate URL for your environment to log into Forms-based applications. 

Use either the SSWA or Forms login, as appropriate.

2. From the applications login screen, enter in the provided fields a User Name 
and Password for a user with the iSurvey User responsibility, and click 
Connect. 

3. From the list of responsibilities, select iSurvey User. If necessary, click OK to 
confirm your selection.

 The resulting menu will display the various options for concurrent processing

4. Run the Summarize Survey Data concurrent program from the resulting list.

For specific details on executing or scheduling concurrent programs, please 
refer to Chapter 5 of Oracle System Administrator's Guide. 

For a description of these concurrent programs, refer to the Oracle Scripting 
online help or Oracle Scripting Concepts and Procedures.

5. After executing each concurrent program, log out of Forms-based Oracle 
Applications if desired by selecting Exit Oracle Applications from the File 
menu.

6. Summary data is now available to view in the Survey Admin console by 
accessing the Analysis tab. In order to access this console, you must log into 
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CRM HTML-based applications from the HTML Login URL with a user that 
has the Survey Administrator responsibility.

For a description of the steps to generate Survey or Scripting reports, refer to 
the Oracle Scripting online help or the Oracle Scripting Concepts and Procedures 
Manual.

6.4 Executing Concurrent Programs to Send Fulfillment Requests for 
List-Based Surveys

When you click Deploy for a list-based survey deployment, a concurrent request is 
generated which is scheduled to run at the deploy date and time (specified when 
defining a deployment). If the deploy date and time are in the past, the concurrent 
program executes immediately. The purpose of this concurrent program is to make 
a request to Oracle One-to-One Fulfillment to send out email invitations to the 
target population specified by the list.

If reminders are also established for this deployment, concurrent requests are also 
generated (one per reminder) to execute at the specified interval (in days) as 
defined for the deployment. These requests will execute at the appropriate interval. 
When the concurrent manager runs the request, it attempts to submit a Fulfillment 
request for this survey deployment.

If the request is successful, a Fulfillment Request ID will be generated. This is 
visible from the Survey Admin Console in the Deployment Detail screen, 
immediately above the Concurrent Request ID.

If the request is not successful, you can attempt to manually run this concurrent 
program using the steps below.

Once a Fulfillment request has been successfully submitted to Fulfillment, there is 
no communication with the Survey Admin console regarding any possible 
problems in executing the Fulfillment request. Thus, if necessary, obtain the 

Note: Upon selecting Deploy, as soon as the page refreshes, the 
corresponding Concurrent Request ID is immediately visible in the 
Deployment Detail page. You can use this Concurrent Request ID to 
monitor the Fulfillment Request submission through the Oracle 
Forms-based interface associated with the iSurvey User 
responsibility.
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Fulfillment Request ID from the Deployment Detail page of the Survey Admin 
console and attempt to remediate using Fulfillment debugging techniques.

Login
Self-Service Login URL 

Responsibility
iSurvey User

Prerequisites
There are no prerequisites for executing this concurrent program. However, in order 
for this program to have any useful effect:

� The Survey component of Oracle Scripting must have been fully implemented.

� Oracle One-to-One Fulfillment must have been fully implemented and 
configured, and a Fulfillment server must be functional.

� A list-based survey campaign must already have been created and its children 
objects (survey cycle and survey deployment) defined.

� The associated list must be valid and accessible to the system.

� A deployment must have been made active.

� The deployment date and time, as defined in the deployment detail and 
compared to SYSDATE, must be in the past.

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate URL for your environment to log into Forms-based applications. 

Use either the SSWA or Forms login, as appropriate.

2. From the applications login screen, enter in the provided fields a User Name 
and Password for a user with the iSurvey User responsibility, and click 
Connect. 

3. From the list of responsibilities, select iSurvey User. If necessary, click OK to 
confirm your selection.

 The resulting menu will display the various options for concurrent processing

4. Run the SUBMIT GROUP FM REQUEST FROM IES concurrent program from 
the resulting list.
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For specific details on executing or scheduling concurrent programs, please 
refer to Chapter 5 of Oracle System Administrator's Guide. 

For a description of these concurrent programs, refer to the Oracle Scripting 
online help or Oracle Scripting Concepts and Procedures.

5. After executing each concurrent program, log out of Forms-based Oracle 
Applications if desired by selecting Exit Oracle Applications from the File 
menu.

6. Fulfillment request status is visible in the Fulfillment Admin console. In order 
to access this console, you must log into CRM HTML-based applications from 
the HTML Login URL with a user that has the JTF_FM_ADMINISTRATOR or 
other Fulfillment admin responsibility.

See Also
� For more detailed description of how to use Oracle One-to-One Fulfillment, 

refer to the Oracle Scripting online help or Oracle Foundation Concepts and 
Procedures.

� For more information on implementing Oracle One-to-One Fulfillment, refer to 
Oracle Foundation Implementation Guide.

� For specific details on executing or scheduling concurrent programs, please 
refer to Chapter 5 of Oracle System Administrator's Guide. 

� For accessing the Survey Admin console, see If You Cannot See the Survey 
Admin Console.

� For accessing Fulfillment tabs in the Survey Admin console, see 
Troubleshooting Fulfillment Admin Role Assignment.

� For other troubleshooting hints and tips, see Survey Deployment and 
Fulfillment Troubleshooting
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Verifying the Implementation

The following topics are included in this topic group:

Script Author Verification Tasks

Scripting Engine Verification Tasks

Survey Component Verification Tasks

7.1 Script Author Verification Tasks
The following is a list of tasks you should perform to verify a successful Script 
Author implementation. Trained, knowledgeable individuals must perform these 
steps. The appropriate verification tasks to perform (rather than specific, 
step-by-step instructions for those verification tasks) are included in this section 
only, except where otherwise indicated.

The following topics are included in this topic group:

Identifying Script Author Verification Tasks

Building a Hello World Test Script

See Also
Scripting Engine Verification Tasks

Survey Component Verification Tasks

7.1.1 Identifying Script Author Verification Tasks
After installing the Script Author and implementing either the Scripting Engine 
agent GUI or the Survey Component, you should verify the implementation by 
performing the following:
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1. Open the Script Author, create, save, and deploy a simple script to the 
appropriate instance of the Oracle Applications database.

Step-by-step instructions to create and deploy a Hello World test script is 
provided in this section for this purpose.

2. Test a simple script with no associated custom Java.

The first test script to be deployed and executed should have no custom Java 
methods associated with it. Testing such a script in the agent interface from 
Oracle Forms verifies that:

� A script can be launched in the designated environment, independent of 
the technical considerations related to custom Java.

� You eliminate certain environmental variables as the cause of problems if 
this test succeeds and the subsequent test (launching and executing a script 
that calls custom Java methods) fails.

� Script Author 11.5.6 is compiling and deploying scripts successfully.

� Scripting User or Scripting Agent responsibility functions 
appropriately.

For survey deployments, testing a simple script with no Java in a Web browser 
further verifies that:

� Survey resources are appropriately defined.

� Survey campaign information is appropriately configured and a script 
questionnaire appropriately associated with a campaign.

� Survey Administrator responsibility functions appropriately.

3. Deploy and test a script with custom Java code. 

For this purpose we specifically recommend using the Regression Test Script 
posted on OracleMetaLink for that purpose. 

The Regression Test Script on OracleMetaLink has a Document ID of 124522.1

a. FTP custom Java to <JAVA_TOP>/ies_custom on the applications 
database.

b. Modify the Apache jserv.properties file to reference the class path of 
custom Java supporting the Regression Test Script.

c. Open Regression Test Script in Script Author 11.5.6 or later, save the file (to 
ensure it is 11.5.6-compatible), and deploy the Regression Test Script to the 
database.
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d. For survey implementations, create a survey campaign using the 
Regression Test Script.

e. Run through the script in the appropriate execution GUI.

If you can successfully deploy and test the Regression Test Script, you quickly 
verify that:

� A script with custom Java methods associated with it can be launched in 
the designated environment.

� The Apache Web server can locate and interpret the custom Java classes.

� The jserv.properties file is appropriately configured.

� Pending the appropriate configuration of environmental variables, a 
customized script will function properly in this environment.

See Also
Building a Hello World Test Script
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7.1.2 Building a Hello World Test Script
Step No. Required Step-by-Step Description Perform From

1. Required On the client PC which contains the Script Author, select the 
Start menu.

Windows Desktop

2. Required From the Programs listing, highlight Oracle Scripting, then 
select Scripting Author. This opens the Script Author 
development environment. 
Note: The first time you launch the Script Author, you will 
be prompted to select a default language from the database 
or select the default ("American" for American English). 
Select the appropriate choice. If you cannot connect to the 
database, select the Install Default option.

Windows Desktop

3. Required From the Oracle Scripting File menu, select New, or click the 
New Script icon from the Toolbar. Oracle Scripting creates a 
new, empty script within the Script Author’s visual layout 
region (the "canvas"). An icon called a Start node appears on 
the canvas, indicating that the new script has been started, 
and the Script Count in the Script Author’s Explorer area will 
be shown as 1. 

File menu or Script 
Author Toolbar

4. Required Click the Panel Insertion Mode icon (the blue sphere) from 
the Toolbar to indicate you wish to insert a new panel. 

 

Script Author 
Toolbar

5. Required Click once in the canvas somewhere below the Start node. 
This action places a panel icon (shown as a blue sphere) into 
the canvas. 
Note: Until you switch to another Toolbar object or the 
Toggle Selection Mode (selected in the next step), the current 
Toolbar object remains selected and will continue to place 
objects (in this case, panels) on the canvas each time the 
mouse is clicked in the work area. If you prefer to disable this 
feature, uncheck the "Sticky Mode" option under the File 
menu. The option to disable "Sticky Mode" lasts for the 
duration of the Script Author session. If you prefer this mode 
you must select it each time you launch the Script Author.

Script Author canvas
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6. Required Click the Toggle Selection Mode icon from the Toolbar to 
turn off the Panel Insertion mode. 
Note: If you turn off "Sticky Mode" as described in the step 
above, selecting the Toggle Selection mode (in all cases) will 
not be required. However, when using the same toolbar tool 
(dropping multiple objects or drawing multiple branches of 
the same type), you will be required to select the object from 
the toolbar each time, which is not required when "Sticky 
Mode" is enabled.

Script Author 
Toolbar

7. Required Right-click the panel that you just added to the script. The 
Script Author displays a drop down menu with the 
following options: Edit, Edit Blob Name, and Edit Blob 
Properties. 
Note: If the dialog displayed shows only two options, Edit 
and Edit Blob properties, then you have not correctly 
selected the Panel object. Left-click to close the menu and 
re-select the Panel object. 

Script Author canvas

8. Required Select the Edit Blob Properties option from the menu 
created by right-clicking on the new panel. The Script 
Author displays the Panel[n] Properties dialog.
Note: The Script Author automatically assigns numbering to 
each new panel created (represented by [n] above) to enforce 
unique panel names. When you type a value in the Name 
field of the panel properties (such as "Hello") and apply the 
change, the value you entered replaces the [n] as the new 
name of the panel you have just created. Thus, for example, 
Panel5 Properties becomes PanelHello Properties. For the 
sake of simplicity, the name of each new panel (the value of 
[n]) will be excluded in these instructions, and the dialog will 
be referred to generically as the Panel Properties dialog. 

Panel Properties 
dialog

9. Required In the Panel Properties dialog, input the following values in 
the prescribed fields:
 Name: hello
Comments: Leave blank
Label: Greeting

Panel Properties 
dialog

10. Required Click Apply in the Panel Properties dialog.
Note:  Clicking the Apply button saves the values entered or 
changed (just as if you had clicked the Ok button), but leaves 
the dialog open for additional work.

Panel Properties 
dialog
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11. Required Click the Answers property displayed on the left pane of the 
Panel Properties dialog. The right pane of the dialog changes 
to display a text area which will list any answers you define 
for the script. 
Note:  For a script to be syntactically correct, every panel 
must contain at least one answer that will trigger when the 
script is executed (i.e., that is established as the default for 
distinct branching).

Panel Properties 
dialog

12. Required Click the Add button, which is immediately below the 
Answers text area. The Answer Entry Dialog appears. 

Panel Properties 
dialog

13. Required Provide the following values for the fields in the Answer 
Entry Dialog:
Default for Distinct Branching: checkmark
Name: helloAnswer
UI Type: Button
Label for reporting: Leave blank

Answer Entry Dialog

14. Required From the bottom of the Answer Entry Dialog, click the Edit 
Data Dictionary button. The application displays the Edit 
Data Dictionary dialog. 

Panel Properties 
dialog

15. Required Select the Lookups tab. Edit Data Dictionary 
dialog

16. Required On the Lookups tab, click the Specify lookups radio button. Edit Data Dictionary 
dialog

17. Required Click the Add button. The application displays the Lookup 
entry dialog. 

Lookup entry dialog

18. Required In the Lookup entry dialog, assign the following values to 
the fields:
Display Value: Continue
Value: Continue
Click Ok to close the Lookup entry dialog and return to the 
Edit Data Dictionary dialog.
Click Ok to close the Edit Data Dictionary dialog and return 
to the Answer Entry Dialog. 

Lookup entry dialog

Edit Data Dictionary 
dialog
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19. Click Ok to close the Answer Entry Dialog. The answer that 
you have defined now appears in the Answers text area in 
the Panel Properties dialog. It should appear as an entry with 
the name Answer:helloAnswer (default).
Note: If the word "default" does not appear in parentheses 
next to the answer you have just defined, use the Edit button 
to re-enter the Answer Entry Dialog and click the Default for 
Distinct Branching checkbox. Click Ok to apply, and then go 
to the next step. 

Panel Properties 
dialog

20. Required Click Ok to close the Panel Properties dialog. On the canvas 
below the Start node, the panel for which you have just 
configured name and answer properties should appear.

Panel Properties 
dialog

21. Required Click once on the panel you have just created. When the 
markers appear around the panel to indicate that you have 
selected it, open the Panel Layout Editor (PLE).
Note: The Panel Layout Editor can be opened by selecting 
Panel Layout Editor from the Tools menu, by clicking on the 
Panel Layout icon from the Toolbar, or by entering the 
keyboard combination command CTRL-SHIFT-E. It can also 
be accessed by selecting the Panel Layout property 
displayed on the left pane of the Panel Properties dialog, and 
then selecting Panel Layout Editor from the Panel Layout 
details area.

Tools menu or Script 
Author canvas or 
keyboard

22. Required When the Panel Layout Editor opens in Script Author 11.5.6 
or later, representative controls for any answers you have 
defined appear on the page, with room above for text. Click 
once in the text entry area. From the toolbar, click the Set 
Spoken Text Font icon. Then enter the following text:
Hello, World! 
Note: The text is formatted as "Spoken Text," allowing 
one-click formatting to provide an easy visual clue. For 
agents, this is typically text that would be read to a customer 
during an interaction. For scripts run in the Web interface as 
a survey, this is an easy way to emphasis text or use one of 
two preexisting formats.

PLE Toolbar

23. Required Save the panel text you have created and exit the Panel 
Layout Editor. You can do this by selecting Save and then 
Exit (both from the File menu), or you can simply exit the 
Panel Layout Editor and click the Yes button when the 
Unsaved Changes dialog asks if you would like to save the 
changes you have made.

Panel Layout Editor 
or 
Unsaved Changes 
dialog
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24. Required Select the Group Insertion Mode icon from the Toolbar. Script Author 
Toolbar

25. Required Click once on the canvas, below the hello panel. The Script 
Author will place a Group object into the script at the 
insertion point. 

Script Author canvas

26. Required Click the Toggle Selection Mode icon from the Toolbar to 
turn off the Group Insertion mode. 

 Script Author 
Toolbar

27. Required Double-click the newly-added group. The Group Properties 
dialog is displayed.

Script Author canvas

28. Required Fill out the fields in the Group Properties dialog in the 
following manner:

Name: WrapUpGroup

Comment: Enables the Disconnect button

Note: The comment is not required. 

Group Properties 
dialog

29. Required Click Apply in the Group Properties dialog. Group Properties 
dialog

30. Required Click the Shortcut property from the items on the left pane 
of the Group Properties dialog. The right pane is re-written 
and a new field appears. You must fill it out as follows:

Shortcut: WrapUpShortcut

Note: This Shortcut name must appear exactly as typed 
here, with upper and lowercase text and no spaces. For 
scripts run in the agent application, the Scripting Engine 
associates the Disconnect button with any group containing 
the Shortcut property of WrapUpShortcut.

Group Properties 
dialog

31. Required Click OK in the Group Properties dialog. The dialog closes 
and the new group appears on the canvas below the hello 
panel.

A new group represents a second graph. The original graph 
on which the hello panel and the WrapUpGroup group 
reside is referred to as the Root Graph.

Group Properties 
dialog 

32. Required From the Script Author canvas, click once on the 
WrapUpGroup icon to select it. The selection markers will 
appear. 

Script Author canvas

33. Required Click the Go Down Into Child Graph icon from the 
Toolbar.

You will now see the child graph of the new group, which 
contains only a Start node.

 Script Author 
Toolbar
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34. Required Click the Panel Insertion Mode icon from the Toolbar and 
click once in the child graph below the Start node.

 

Script Author 
Toolbar

35. Required Click the Toggle Selection Mode icon from the Toolbar to 
turn off the Panel Insertion mode. 

Script Author 
Toolbar

36. Required Double-click the new panel to display the Panel Properties 
dialog. Click on the Properties property from the items on 
the left pane of the Panel Properties dialog, and enter the 
following values in the prescribed fields:
 Name: goodbye
Comments: Leave blank
Label: Last panel
Note: The Script Author "remembers" the last property panel 
or field location displayed in any similar dialog. Thus, you 
may need to select a different property or field in a given 
dialog in order to proceed with the steps indicated in these 
instructions.

Script Author canvas

37. Required Click Apply in the Panel Properties dialog. Panel Properties 
dialog

38. Required Click the Answers property displayed on the left pane of the 
Panel Properties dialog. The right pane of the dialog changes 
to display a text area which will list any answers you define 
for the script. 

Panel Properties 
dialog

39. Required Click the Add button to define your answer in the Answer 
Entry Dialog. 

Panel Properties 
dialog

40. Required Provide the following values for the fields in the Answer 
Entry Dialog:
Default for Distinct Branching: checkmark
Name: goodbyeAnswer
UI Type: Button
Label for reporting: Leave blank

Answer Entry Dialog

41. Required From the bottom of the Answer Entry Dialog, click the Edit 
Data Dictionary button. The application displays the Edit 
Data Dictionary dialog. 

Panel Properties 
dialog

42. Required On the Lookups tab, click the Specify lookups radio button. Edit Data Dictionary 
dialog

43. Required Click the Add button. The application displays the Lookup 
entry dialog. 

Lookup entry dialog
Verifying the Implementation 7-9



Script Author Verification Tasks
44. Required In the Lookup entry dialog, assign the following values to 
the fields:
Display Value: Finish
Value: Finish
Click Ok to close the Lookup entry dialog and return to the 
Edit Data Dictionary dialog.
Click Ok to close the Edit Data Dictionary dialog and return 
to the Answer Entry Dialog. 
Click Ok to close the Answer Entry Dialog. 

Lookup entry dialog

Edit Data Dictionary 
dialog

45. Required Click Apply in the Panel Properties dialog. Panel Properties 
dialog

46. Required Click the Panel Layout property displayed on the left pane 
of the Panel Properties dialog. The right pane of the dialog 
changes to display the Panel Layout details, including a 
Browse button from which you can import HTML, and a 
Panel Layout Editor button.

Panel Properties 
dialog

47. Required Click Panel Layout Editor.
The Panel Layout Editor for the goodbye panel appears.

Panel Properties 
dialog

48. Required In the Panel Layout Editor dialog, click once in the text entry 
area. From the toolbar, click the Set Spoken Text Font icon. 
Then enter the following text, followed by:
Goodbye, World! 
Press Enter to continue to the next line, and then click the Set 
Instruction Font icon. In the Text entry area, type the 
following text:
[Click the Finish button.]

Note: Instructional text is intended to provide instructions 
to the end user of the script. 

PLE Toolbar

49. Required Save the panel text you have created and exit the Panel 
Layout Editor. 
Click Ok to save and close the Panel Properties dialog. 
The goodbye panel is now visible below the Start node of 
this child graph.

Panel Layout Editor 
or 
Unsaved Changes 
dialog
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50. From the Script Author Toolbar, click the Termination Point 
Insertion Mode icon.

On the canvas, below the goodbye panel, click once to insert 
a Termination node. 
Note: A Termination node is required for each graph in a 
script, and exits the graph.

51. Required From the Script Author Toolbar, select the Default Branch 
Mode icon. When over the canvas, the cursor turns into a 
cross-hairs symbol, indicating that you can begin drawing a 
line to define flow from one object to another within the 
canvas.

 Script Author 
Toolbar

52. Required With the cursor displayed as a cross-hairs symbol, click on 
the Start node and drag to draw an arrow between the Start 
node and the goodbye panel. Release the mouse.

 The two objects are connected.

Script Author canvas

53. With the cursor displayed as a cross-hairs symbol, again 
click on the canvas, this time connecting the goodbye panel 
and the Termination node.

If you have disabled "Sticky Mode," you must again select 
the Default Branch Mode icon from the toolbar to 
accomplish this step.

You have now completed a syntactically correct graph. 
Return to the root graph to complete this script.

54. Required From the Script Author Toolbar, select the Go up to parent 
graph icon. 

The canvas now displays the root graph.

55. From the Script Author Toolbar, click the Termination Point 
Insertion Mode icon.

On the canvas, below the goodbye panel, click once to insert 
a Termination node. 
Note: For the root graph, the Termination node indicates the 
completion of the script.

56. Required From the Script Author Toolbar, select the Default Branch 
Mode icon. 

Connect the Start node to the hello panel, the hello panel to 
the WrapUpGroup object, and the WrapUpGroup object to 
the Termination node with default branches.

 Script Author 
Toolbar

57. Required Click the Toggle Selection Mode icon from the Toolbar to 
turn off the Default Branch insertion mode. 

Script Author 
Toolbar
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58. Optional Using click-and-drag techniques, select all the objects on the 
canvas (Start node, hello panel, Termination node, and 
Default branches). From the lower Tools menu, select the 
Align Selected Objects Vertically icon.
All highlighted items will align vertically, presenting a neat 
graph on the canvas.

Script Author 
Toolbar

59. Required At the File menu, select Save to save your work. This 
command can also be executed by selecting the Save Script 
(disk) icon in the Toolbar or by entering CTRL-S from the 
keyboard. 

Script Author File 
Menu or Script 
Author Toolbar or 
keyboard

60. Required In the resulting Script Chooser menu, you can save the script 
to your local file system or to the applications database. Fill 
in the following:
Location: Select the directory in which you wish to save the 
Script Author file.
Note: For location, Oracle Corporation recommends a child 
directory of the Script Author directory, for example (your 
path may differ): 
"[OraHome]\oracle\apps\ies\author\scripts."

File Type: Select the default Oracle CRM script file (.script, 
scr) option.
File name: helloWorldTestScript.script
Click the Save button to save the file in the selected 
directory. 

Script Chooser dialog

61. Required Even though you have saved and named your script in your 
operating system’s filing system, you still need to assign a 
name to the script which will be recognized from a database 
perspective. Right-click on any unpopulated section of the 
canvas to display two options, Edit and Edit Blob Properties, 
and select Edit Blob Properties to open the [Script Name] 
Properties dialog. You can also open this dialog by selecting 
Script Properties from the File menu.
Note: If the dialog displayed shows three options—Edit, Edit 
Blob Name, and Edit Blob Properties—then you have not 
correctly selected the Script properties dialog, but properties 
for another object. The global script itself is the Binary Large 
Object (Blob) for which you want to modify properties. In 
this case, left-click to close the menu and re-select the Script 
Properties following one of the methods above.

Script Author canvas 
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62. Required In the resulting global [Script Name] Properties dialog 
(which should currently be named something like Untitled1 
Properties), fill in the following:
Name: helloWorldTestScript
Comments: Leave blank.
Script language: As appropriate for your environment.For 
example, AMERICAN for American English.
Click the Ok button to save the global script properties and 
return to the canvas.
Note: For the Name field, fill in a name under which this 
script will be deployed to the database. We recommend 
using the same name as that you assigned to the .script 
file in the filing system, if practical.
Do not assign a file extension to this name.
For the Comments field, you may elect to fill this in with 
information you will find helpful to identify this particular 
script or script version. This field is for information only and 
is not processed in any way.
For the Script language field, enter the language in which 
this script is developed, based on the FND_LANGUAGES 
able of the Oracle 8i database. For this example, ensure this 
field reads AMERICAN, for American English.

Global [Script Name] 
Properties dialog 

63. Suggested Select Syntax Check from the Tools menu, or click the Check 
Syntax icon in the Toolbar. Assuming all the syntax in your 
script is correct, a status line at the bottom of the Author will 
display the message "Syntax check successful, with no 
errors." If the syntax check fails, correct any errors and check 
the syntax of the script again until successful.

Tools menu or Check 
Syntax Toolbar icon

64. Required At the File menu, select Save again, to ensure you save the 
Global Script properties you assigned.
Note: The method used to save the document is not 
important. You may elect to click the Save icon in the Script 
Author Toolbar or enter CTRL-S from the keyboard.

File Menu or Script 
Author Toolbar or 
keyboard

65. Required From the Tools menu, select Deploy Script. This displays the 
Deploy Script To dialog. Enter the host name, port, and SID 
for your specific instance of the Oracle Applications server, 
including the apps level user name and password.

Deploy Script To 
dialog
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66. Required To launch this script in the agent interface, you must perform 
the following actions:

� Log into Forms-based Oracle Applications with the 
appropriate responsibility to launch a script. 

For example, to launch the script in stand-alone mode, 
the user must have the Script User or Script 
Agent responsibility.

� Launch the Script Chooser form as appropriate.

For example, in stand-alone mode, select the Demo 
Form from the Navigator.

� Select the script name and language from the Script 
Chooser.

For example, select helloWorldTestScript/American, 
and click Start Script.

� Execute the script.

Forms-based 
applications

67. Required To launch this script as a survey in a Web browser, you must 
perform the following actions:

� Log into CRM Web-based Oracle Applications as a user 
with the Survey Administrator responsibility to 
access the Survey Admin console. 

access the Survey Admin console from the HTML Login 
URL.

� Define header, error page and final page resources.

For example, you can create references to preseeded test 
survey resources in the Survey Resources tab. These are 
named iessvytestheader.jsp, 
iessvytesterror.jsp and 
iessvytestthanku.jsp.

� Create a non-list-based survey campaign, cycle, and 
deployment. The survey campaign must identify a 
deployed 11.5.6 test script.

� Deploy the deployment and record the deployment ID 
(dID) from the Deployment detail page. The format 
should be as follows:

http://<server>.<domain>:<port>/OA_
HTML/iessvymain.jsp? dID=xx

� Enter the URL in a Web browser to launch an instance 
of the specified non-list-based deployment associated 
with a release 11.5.6 script.

� Execute the script.

Forms-based 
applications
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See Also
Identifying Script Author Verification Tasks

7.2 Scripting Engine Verification Tasks
There are two sets of verification tasks for the Scripting Engine, based on whether 
one or both interfaces were implemented at the enterprise. Follow the appropriate 
set or sets of verification tasks below.

 The following topics are included in this topic group:

Scripting Engine Agent Interface Verification Tasks

Scripting Engine Web Interface Component Verification

See Also
Script Author Verification Tasks

Survey Component Verification Tasks

7.2.1 Scripting Engine Agent Interface Verification Tasks
Scripting Engine verification tasks for the Java-based interaction center interface 
include the following:

� For Apache Mid-Tier Servlet Architecture implementations, using Apache Web 
Server verification URLs to ensure that servlets (particularly the Scripting 
Servlet) are configured and operational. See Apache Web Server Servlet 
Verification URLs below.

� Executing the Hello World test script in the agent application

� Obtaining and processing the Regression Test Script from OracleMetaLink, 
including:

For this purpose we specifically recommend using the Regression Test Script 
posted on OracleMetaLink for that purpose. The Regression Test Script on 
OracleMetaLink has a Document ID of 124522.1

� Deploying Regression Test to the database

� Uploading Regression Test custom JAR file to the server

� Referencing custom Java class path for Regression Test custom code in the 
jserv.properties file
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� Executing the Regression Test script in the agent application

7.2.1.1 Apache Web Server Servlet Verification URLs
In order to execute Oracle Scripting in the agent application using the Apache 
Mid-Tier architecture, the Scripting Servlet must be operational.

The following URL can be used to verify that the Scripting Servlet is properly 
configured and operational:

http://<servername>.<domain>:<Apache Web server 
port>/<servlet_zone>/oracle.apps.ies.client. 
application.ScriptingServlet

The following URL can be used to verify that the Apache JServ servlet engine is 
configured and operational:

http://<hostname>:<port>/<servlet_zone>/IsItWorking

The following URL can be used to verify that the AOL test servlet is configured and 
operational:

http://<hostname>:<port>/<servlet_zone>/oracle.apps.fnd. 
test.HelloWorldServlet

Note, however, that this servlet may have been removed by system administration 
and is not an indication of whether or not the Scripting Servlet will function.

7.2.2 Scripting Engine Web Interface Verification Tasks
Scripting Engine verification tasks for executing a script in the Web browser-based 
interface include the following:

� Verifying the Guest User setup.

The primary verification test that can be performed independent of survey 
campaign administration steps is the verification of the guest user setup.

� Specifying JSP resources.

� Creating a non-list-based survey campaign, cycle, and deployment.

� Deploying a deployment.

Performing any verification task other than testing the Guest User requires you to 
also perform all Survey implementation steps. These are in addition to Scripting 
Engine implementation tasks for all implementations and those required for the 
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Web interface, since testing a script in the Web interface requires a survey campaign 
to be defined and deployed.

 See Survey Component Verification Tasks for more information.

See Also
Script Author Verification Tasks

Survey Component Verification Tasks

7.2.2.1 Guest User Verification Steps
For Survey operations, ensure you have a guest user defined. If you did not 
establish the guest user JTF property, it is recommended that you verify the 
username and password for the guest user to ensure it is functioning.

Steps
1. Check the guest user name and password JTF properties.

For information on how to view the guest user settings, see Verifying or 
Adding a Guest User for the Respondent.

2. Log into CRM HTML-based applications by accessing the HTML Login URL.

3. Use the guest user name and guest password key value pairs.

4. If the following error results in the HTML admin console, the guest user is 
functioning properly:

This page is missing or not a valid HTML page.

This message indicates that there is an Oracle Applications username that has 
no responsibilities and no default application associated with it. This is 
appropriate for the guest user.

Note: Since testing for all customized scripts is recommended at 
the lowest HTML interpretation engine available, steps for 
implementing the Scripting Engine for the agent interface are 
recommended to be performed for all implementations. For more 
information, see New In This Release > Compiling Custom Code 
Using JDK 1.1.8 in the introduction to this implementation guide.
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7.3 Survey Component Verification Tasks
To test the survey component, Oracle Corporation recommends creating a survey 
campaign using an already deployed Oracle Scripting release 11.5.6 script (such as 
Regression Test or Hello World) and defining a non-list-based survey campaign, 
cycle, and deployment. 

Step-by-step instructions to accomplish the verification tasks below are detailed as 
appropriate in this implementation guide, and in the Oracle Scripting Concepts and 
Procedures Manual and Oracle Scripting online help.

After making the deployment active, if you can execute the deployment you have 
verified the following, in two categories:

Survey Implementation Steps
� Assigning the Survey Administrator responsibility to an existing or new 

Oracle Applications user.

� Creating, modifying, or referencing JSP survey resources and ensuring they are 
present in the $OA_HTML directory on the server.

� Defining survey resources, a survey campaign, cycle, and deployment in the 
Survey Admin console.

� Deploying a deployment.

� Ensuring you can participate in a survey using a Web browser.

Further, if the test script contains custom Java, you have verified:

Scripting Engine Survey Implementation Steps
� Uploading custom JAR file to the server.

� Referencing custom Java class path in the jserv.properties file.

For specific information on creating a survey campaign, refer to the Oracle Scripting 
Concepts and Procedures Manual.

Scripting Engine Survey Reporting Steps
To confirm Survey reporting, you must execute several surveys and then perform 
the non-Fulfillment administrative steps for concurrent programs.

After you do this, attempt to view reports in the Analysis tab of the Survey Admin 
console. Succeeding in this step verifies the following:

� Validating the minimum requirement of JDK 1.2 on the application server.
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� Assigning the iSurvey User responsibility to an existing or new Oracle 
Applications user.

� Ensuring Survey Summary tables are updated via concurrent programs

See Also
Script Author Verification Tasks

Scripting Engine Verification Tasks
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Diagnostics and Troubleshooting

This topic group includes the following topics:

Common Implementation Errors

Common Verification or Execution Errors

Survey Deployment and Fulfillment Troubleshooting

Log Files and Error Messages

8.1 Common Implementation Errors
This topic group includes the following topics:

Responsibility Names Versus Responsibility Keys

Survey Implementation Errors

8.1.1 Responsibility Names Versus Responsibility Keys
If you cannot locate a responsibility name as described in this or other Oracle 
documentation, your environment may have been customized. In such an event, 
you should research the responsibility key to determine a match. For example, the 
typical responsibility name for an administrator of Oracle One-to-One Fulfillment is 
JTF_FM_ADMINISTRATOR. In some implementations, the responsibility key is 
JTF_FM_ADMINISTRATOR but the responsibility name may have been changed 
(for example, to Fulfillment Administrator).

Compare a responsibility key against its name using the following procedure.
oting 8-1



Common Implementation Errors
Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate URL for your environment to log into Forms-based applications. 

Either the SSWA or Forms login as appropriate.

2. From the applications login screen, enter in the provided fields a User Name 
and Password for a user with the System Administrator responsibility, and click 
Connect. 

3. From the list of responsibilities, select System Administrator. If necessary, click 
OK to confirm your selection.

4. In the Functions tab of the Navigator, navigate to Security > Responsibility > 
Define and click Open. 

The Responsibilities form results.

5. Enter query mode by pressing F11 on your keyboard or selecting View > Query 
by Example >Enter.

The form fields turn blue, indicating query criteria can be entered.

6. Click in the third tab field, Responsibility Key, and enter your query criteria.

You may use the wildcard character (percent sign) as part of your search. 

7. Execute the query by pressing CTRL-F11 on your keyboard or selecting View > 
Query by Example >Run.

If multiple records are returned, locate the appropriate record by using the Up 
and Down arrow keys on your keyboard.

8. Compare the Responsibility Key value with the Responsibility Name (in the 
first field) to determine the appropriate responsibility name for your 
environment.

Use that responsibility name to perform your implementation or administration 
steps.

8.1.2 Survey Implementation Errors
This topic group includes the following topics:

General Implementation Errors

If You Cannot See the Survey Admin Console

Troubleshooting Fulfillment Admin Role Assignment
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8.1.2.1 General Implementation Errors
The responsibility for administering the Survey component of Oracle Scripting is 
known to Oracle Applications as Survey Administrator. Do not confuse the Survey 
Administrator responsibility (required for administering survey campaigns) with 
the iSurvey User responsibility (required for executing or scheduling concurrent 
programs). 

When you are logged into Oracle Applications as a system administrator and are 
searching for responsibilities in Forms-based applications, it is recommended to 
search using the percent wildcard character, for example "%SURVEY%", because:

� Searching under "iSurvey" will only result in finding the iSurvey User 
responsibility, which does not have the required administrative privileges to access 
the Survey Admin console.

� Searching under "Survey" will only result in finding the Survey Administrator 
responsibility, which does not have the required privileges to administer, schedule, 
or run concurrent programs.

8.1.2.2 If You Cannot See the Survey Admin Console
If you cannot successfully view the Survey Admin console:

� Check that the Web server and database are up and running in your 
environment.

� Check that you are entering the correct HTML Login URL for your specific 
instance into the Web browser’s location or address field. For example, the 
syntax for accessing Oracle CRM Web-based Oracle Applications is:

http://<server>.<domain>:<port>/OA_HTML/jtflogin.jsp

� Check that the User ID and Password used to access the HTML Login URL 
have been created in Oracle Forms administrative screens by a user with the 
System Administrator responsibility, and that the user has been assigned the 
Survey Administrator responsibility.

� Check that the appropriate profile settings have been established for the 
application at the site level, and for the application at the user level (the User 
Name in Forms-based applications matches the User ID and Password you 
used to access the JTF HTML-based application).
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8.1.2.3 Troubleshooting Fulfillment Admin Role Assignment

If You Cannot See Fulfillment Page
If you can successfully enter the Survey Admin console, but cannot view the 
Fulfillment page:

� Check that Fulfillment has been implemented appropriately and the Fulfillment 
server is up.

� Check that you appropriately assigned the JTF_FM_ADMIN role.

� Check that after moving the JTF_FM_ADMIN role into the Assigned Roles list, 
you clicked Update. 

� Ensure that all the Fulfillment (fm.db) objects in the database are valid.

If you can successfully enter the Fulfillment tab, displaying a Fulfillment sub-tab 
and displaying the Master Document page, you have verified that:

� You have appropriately assigned the Fulfillment Admin role to the Survey 
administrator user.

� Oracle One-to-One Fulfillment is implemented in your environment.

8.2 Common Verification or Execution Errors
The following topics are included in this topic group:

Script Author Deployment Errors

Script Author Script Verification

Scripting Engine Agent Interface Errors

Survey Administration Errors

8.2.1 Script Author Deployment Errors
Problem:   Deploying a script to the database with the Author fails. 

Solution 1: The tablespace for the IES_DEPLOYED_SCRIPTS table may not be large 
enough. Particularly indicative is the scenario in which previous scripts were 
deployed to the database without difficulty. To resolve, increase the size of the 
tablespace (usually named USER_DATA) to an appropriate size (based on database 
usage and other installed applications). Consult your database documentation for 
details. 
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Solution 2: Connection to the Oracle Applications database instance has failed. This 
would result from one of the following two causes: (1) the database is down, or (2) 
connection information was incorrectly entered. Connection information required 
includes Connection Name (optional) and the following required fields: Host Name 
(the name of the database host), Port Number (the TNS listener port number), SID 
(the database instance name), User Name and Password (both require apps level).

See Also
� Check with the database administrator if the database is down.

� Refer to the Oracle Scripting Concepts and Procedures Manual or Oracle Scripting 
Online help for more information on connection information. 

8.2.2 Script Author Script Verification
When testing a script, it is not enough to ensure the script will launch in the 
appropriate interface (in the Java interface for agents, or in a Web browser for 
surveys). You must also test each path in the script to ensure all commands are 
functioning as expected. It is important to ensure each component is functioning on 
its own and in consonance with all others. From the standpoint of the script itself, 
one must test:

� The "call guide" or "survey" (the script document developed with Script 
Author)

� All custom Java methods developed to support the script

� All PL/SQL procedures attached as commands to panels, blocks, branches, etc.

� All Blackboard commands

� All Forms commands

� All Constant commands

� All Delete actions

8.2.3 Scripting Engine Agent Interface Errors
The following topics are included in this topic group:

Troubleshooting Applet Security and Signing

Pre-11.5.6 Script Launching Error

Resolving JInitiator Connection Error in Caching Architecture
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8.2.3.1 Troubleshooting Applet Security and Signing
Problem: A yellow bar appears on the bottom of all Forms windows that reads 
Warning: Applet Window.

This is a security configuration issue. From a Scripting perspective, you cannot 
launch Scripts after logging into Forms-based applications.

Solution 1 (Client): This may be an indication that the proper security certificate 
has not been installed on the client JInitiator. Improper security configuration on the 
client can lead to a variety of problems in Oracle Scripting. Among them, the ability 
to copy and paste to and from fields in Scripting will be disabled. Be sure to 
properly configure applet security on each client machine. First, empty your Oracle 
JInitiator cache and try logging in again. If the yellow bar reappears, uninstall and 
re-install Oracle JInitiator.

Solution 2 (Server): This may be an indication that the Applications JAR files have 
not been signed properly on the server. For more details on proper security 
configuration, consult your Oracle Applications installation documentation.

8.2.3.2 Pre-11.5.6 Script Launching Error
Problem: Attempting to launch a script from the Script Chooser in an Oracle 
Scripting 11.5.6 environment that was compiled and deployed with a previous 
version of the Script Author will result in errors.

This problem occurs regardless of whether you attempt to launch the script from an 
integrated Oracle Forms application, or whether you attempt to launch the script in 
stand-alone mode by using the Scripting User or Scripting Agent responsibilities.

A blank Scripting agent interface appears, with two error messages displaying, one 
on top of another.

Error Messages
The error messages will be similar to the following:

1. An unexplained error occurred.

2. oracle.apps.ies.framework.server.ScriptData; Local class not compatible: 
stream classdesc 
serialVersionUID=3705110615200071234 local class 
serialVersionUID=5531446994268563988

Solution: In order to remedy this problem, open the offending script in Script 
Author 11.5.6 or later, recompile by performing a syntax check, save the updated 
script, and redeploy to the database.
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8.2.3.3 Resolving JInitiator Connection Error in Caching Architecture
Problem: When attempting to launch a script, you get an AOLJ 
NotConnectedException error message. This problem can occur when using Oracle 
Scripting in the Caching Architecture.

Error Messages
The error messages in the Java console will be similar to the following:

AuthService - Validating user IESTEST ...failed
AOLJ_JAVA_EXCEPTION (MESSAGE=Not able to create new database connection. 
Cause:sun.applet.AppletSecurityException:
  checkconnect.networkhost1)
  SECURITY-No gateway reconnect
  SYSTEM-ERROR (MESSAGE=checkconnect.networkhost1)
  .........
oracle.apps.ies.integration.common.exception.NotConnectedException: Not 
Connected Exception
          at java.lang.Throwable.<init>(Compiled Code)
          at java.lang.Exception.<init>(Compiled Code)
          at 
oracle.apps.ies.integration.common.exception.IntegrationException.<init>(Int
egrationException.java:34)
          at 
oracle.apps.ies.integration.common.exception.NotConnectedException.<init>(No
tConnectedException.java:34)
          at 
oracle.apps.ies.client.proxyBean.ProxyBeanStateImpl.throwNotConnectedExcepti
on(ProxyBeanStateImpl.java:144)
  .........

Cause: In Oracle JInitiator's control panel, the Network Access setting Applet Host 
means that the applet only has privileges to communicate with a single server (the 
Web server from which it was downloaded). Setting the Network Access in Oracle 
JInitiator Properties to Unrestricted allows the applet to communicate with any 
server on the network.

Solution: Set the Network Access control panel to unrestricted.

Steps
1. From the Windows task bar, click Start.

2. Select JInititator Control Panel <version> from the Programs menu.

The JInitiator control panel, labeled Oracle JInitiator Properties, appears.
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3. Select the Basic tab, if not active.

4. In the Network Access field, select Unrestricted.

5. Click Apply.

6. Close the control panel, or make other changes as desired.

See Also
OracleMetaLink Note 145962.1, Jinitiator Network Access Setup for Scripting in 
Caching Architecture

8.2.4 Survey Administration Errors
Problem: The following error results in the Web browser when you click the Survey 
Campaign tab in the Survey Admin console:

IES_SVY_SELECT_ALL_SURVEYS-Error selecting surveys
No further information

Cause:  JTF Application Object Model (AOM) properties are not correctly set.

Solution: Check to see if the following JTF properties are set in that environment, 
and correct accordingly.

Login
HTML Login URL

Responsibility
System Administrator 

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate login URL. Provide an Oracle Applications user ID and password 
associated with the required responsibility as indicated above.

The Oracle Applications system administration console should appear. You will 
see several tabs, including Home, Users, Settings, Deployment, Diagnostics, 
Performance, and Design.

2. Click the Settings tab (third tab from the left).

The Introduction page for Settings will result. The sub-tabs include Security, 
Site Preferences, and System.
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3. Click the System tab (third tab from the left).

A navigation tree on the left side of the page displays. 

4. Click the last link, Advanced.

The Advanced Properties page displays.

5. From the View dropdown menu, select JTF.

Advanced properties for JTF will display in a list, if any. 

6. Compare values in list and adjust or create accordingly as indicated below.

� These values are provided in key value pairs.

� To edit an existing value, click the hyperlink and modify the values per the 
table below.

� To create a new key value pair, click Create and add values as indicated in 
the table below.

� You can add multiple values to a single key by adding values in a separate 
sequence line when defining or modifying key values. 

This is the only time the sequence line is required; sequence number is 
otherwise not relevant.

� When each record is updated or created, click Update at the bottom of the 
Key Details table.

� Upon completion, exit the application by clicking Sign Out at the top of the 
admin console.

Table 8–1 Key Value Pairs for JTF AOM Advanced Properties

Key Value Value

Sequence

service.fwobject.class 0 oracle.apps.jtf.aom.base.FrameworkObject

service.oracle.apps.jtf.aom.services.
dataaccess.persistence.PersistenceS
erviceFactory.desc

0 Persistence.fwobject

service.oracle.apps.jtf.aom.services.
dataaccess.queryinterface.QueryInt
erfaceFactory.desc

0 Query.fwobject
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8.3 Survey Deployment and Fulfillment Troubleshooting
The following are troubleshooting tips specifically regarding undelivered 
Invitations or Reminders for list-based survey campaigns. Invitations and 
Reminders are HTML Master Documents sent by Oracle One-to-One Fulfillment to 
invite or remind an already invited individual to participate in a survey campaign.

service.oracle.apps.jtf.aom.services.
transaction.TransactionProviderSer
viceFactory.desc

0 TransactionProvider.system

service.factories 0 oracle.apps.jtf.security.perm.AuthorizationServiceFactory

oracle.apps.jtf.coreservices.appscontext.AppsContextServiceF
actory

 oracle.apps.jtf.coreservices.logging.LoggingFactory

 
oracle.apps.jtf.aom.services.transaction.TransactionProviderS
erviceFactory

1 oracle.apps.jtf.security.auth.AuthServiceFactory

oracle.apps.jtf.security.dataaccess.DacServiceFactory

oracle.apps.jtf.coreservices.objectbox.ObjectBoxServiceFactor
y

oracle.apps.jtf.aom.services.dataaccess.persistence.Persistence
ServiceFactory

2  oracle.apps.jtf.profile.ProfileServiceFactory

oracle.apps.jtf.profile.ProfilePersistenceServiceFactory

oracle.apps.jtf.activity.ActivityServiceFactory

oracle.apps.jtf.activity.ActivityQueryServiceFactory

oracle.apps.jtf.activity.ActivityQueryServiceFactory

oracle.apps.jtf.aom.services.dataaccess.queryinterface.QueryI
nterfaceFactory

3 oracle.apps.jtf.profile.ProfileQueryServiceFactory

Table 8–1 (Cont.) Key Value Pairs for JTF AOM Advanced Properties

Key Value Value

Sequence
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Background
When you click "Deploy" for a list-based survey deployment, a concurrent request 
is generated which is scheduled to run at the deploy date and time (specified when 
defining a deployment). The purpose of this concurrent program is to make a 
request to Oracle One-to-One Fulfillment to send out email invitations to the target 
population specified by the list.

Upon selecting Deploy, the status of the deployment changes from "Open" to 
"Active." If the status of the corresponding parent objects (Cycle and Survey 
Campaign) status were "Open," the status of each will change to "Active."

As soon as the page refreshes, the corresponding Concurrent Request ID is 
immediately visible in the Deployment Detail page. You can use this Concurrent 
Request ID to monitor the Fulfillment Request submission through the Oracle 
Forms-based interface associated with the iSurvey User responsibility.

When the request executes, either it will succeed or fail to complete.

� Successful Request:  A successful request is indicated in the Request Detail 
form as Phase: Complete, Status: Normal. Such a status indicates that the request 
was executed, but does not necessarily indicate that the Fulfillment request has 
successfully been received by the Fulfillment server. This distinction is important 
because it helps determine how to fix any emerging problem. Additional 
information is available in the Requests list by clicking View Log on the 
appropriate request. If a request was executed but there was an internal error, 
the log may indicate the presence of such an error. For example, if a Survey 
Admin user deploying the survey was not associated with a Fulfillment group, 
this would be indicated in the log. 

� Request Not Completed:  A failed request is indicated in the Request form as 
Phase: Complete, Status: Error. Such a status indicates that the request has been 
executed but was not completed. See below for more information.

If the request is successful, a Fulfillment Request ID will be generated. This is 
visible from the Survey Admin Console in the Deployment Detail screen, 
immediately above the Concurrent Request ID.

This request can be tracked using the Fulfillment tabs within the Survey Admin 
console, using this Fulfillment Request ID. If necessary, the same ID can be used by 
a Fulfillment administrator, accessing the full functionality of Oracle One-to-One 
Fulfillment by logging into the Fulfillment Admin console.

Once a Fulfillment request has been successfully submitted to Fulfillment, there is 
no communication with the Survey Admin console regarding any possible 
problems in executing the Fulfillment request. Thus, if necessary, obtain the 
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Fulfillment Request ID from the Deployment Detail page of the Survey Admin 
console and attempt to remediate using Fulfillment debugging techniques.

Fulfillment Request Failure Signs
In Concurrent Manager, a Fulfillment request that was not completed can be 
detected in the Request form as Phase: Complete, Status: Error. 

Additional information to help determine why a request failed may be visible by 
clicking View Log in the Request form

In the Survey Admin console, when deploying a list-based survey, the status is set 
to "Active" upon a successful request to Concurrent Manager. However, if the status 
of the deployment changes back to "Open," this may indicate a failure to execute the 
Fulfillment request.

Once a Fulfillment request has been successfully submitted to Oracle One-to-One 
Fulfillment, the Fulfillment Engine then needs to process it. Only successful 
processing by the Engine results in an email message being sent out and the 
subsequent receipt of respondent data for a list-based survey campaign.

Query Failure
The Fulfillment Engine will fail if the query associated with the Master Document 
fails. Therefore, once a Fulfillment ID is generated, use Fulfillment debugging 
methods to troubleshoot the failure point within Oracle One-to-One Fulfillment.

Troubleshooting Recommendations
� Log into Forms-based applications and check the Phase and Status of the 

concurrent request. Additional information to help determine why a request 
failed may be visible by clicking View Log in the Request form of the 
Concurrent Manager.

� Failure may indicate Fulfillment implementation, configuration issues, or 
invalid Fulfillment packages.

� You may also need to check Fulfillment configuration, implementation, or that 
the Fulfillment server is functioning.

� For Fulfillment information, refer to Oracle Foundation Implementation Guide.

Scenario: You have successfully executed a concurrent program, and a Fulfillment 
request has been successfully submitted to Fulfillment. However, once the 
deployment date and time have passed, no survey responses are allowed 
(deployment is not valid, is not active, or you are using an invalid URL).
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Suggestion 1: Check the Survey Admin console to see if the response end date has 
already passed or the status has changed from Active to Closed or Cancelled. 

Suggestion 2: Check the invitation to see if the URL in the email link is in the 
appropriate format as indicated below:

http://<server>.<domain>:<port>/OA_HTML/iessvymain.jsp? dID=xx&rID=xxxxxxxx 

where dID = the deployment ID and rID = the unique respondent ID 

If the URL associated with the hyperlink is incorrect, you must fix the query 
associated with the Fulfillment Master Document in the template used for that 
survey. Then you must resubmit the request via Concurrent Manager. 

Suggestion 3: Check the Fulfillment Admin console to determine if there is a 
Fulfillment server problem.

Scenario: If the Fulfillment request indicates Phase: Completed, Status: Error, you 
can resubmit the request. To resubmit it:

1. Copy the parameters from the Request Detail form.

2. Return to the Navigator.

3. Navigate to Survey Administration > Requests > Run.

4. Select "Single Request" from the Submit a New Request dialog and click OK.

The Submit Request form will appear.

5. In the Names field, enter "SUBMIT GROUP FM REQUEST FROM IES" and 
press Tab.

You can enter partial criteria and use the % wildcard character, if desired.

The Parameters dialog will appear.

6. One at a time, enter the parameters you copied from the failed request, and 
click Submit. 

There are 9 parameters, each separated by a comma. If nothing appears before a 
comma, that parameter is null and can be left blank.

7. After clicking submit, a dialog will appear with a request ID. Copy the request 
ID and use this to track your request.
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8.4 Log Files and Error Messages
Error and informational messages for the Scripting Engine agent GUI and some 
error messages for the Survey component are written to IES log files. 

This topic group includes the following topics:

Oracle Scripting Execution Errors and Error Logging

Viewing IES Server Logs

8.4.1 Oracle Scripting Execution Errors and Error Logging
When executing the Scripting Engine, any resulting errors are stored in various 
places and viewed differently based on the genesis of the error. 

This topic group includes the following topics:

Errors in the Scripting Engine Agent Interface

Errors in the Scripting Engine Web Interface

Server Logging and Debug Mode

8.4.1.1 Errors in the Scripting Engine Agent Interface
� When an agent is running a script, if an error occurs on the client end (from the 

Forms client), this error is written to the JInitiator Java console.

To view the JInitiator Java console, select the Show Java Console option in the 
Basic tab of the Oracle JInitiator Properties dialog accessed from the JInitiator 
Control Panel (typically Start > Programs > JInitiator Control Panel [Version]).

� If an error occurs in the servlet or session, this error is written to the IES server 
logs.

For example, if an action calls a Java method that does not exist, this is a server 
error.

For more information on server logs, see Server Logging and Debug Mode.

Note: The deployment detail page will still indicate the original 
request ID. This will not be updated; ensure you use the new 
request ID to track your request.
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8.4.1.2 Errors in the Scripting Engine Web Interface
When a respondent is taking a survey, errors are distinguished by the two 
components of the JSP layer:

1. The Scripting HTML client, which takes the script and renders HTML.

2. The survey-specific layer that wraps the output to the HTML client in 
survey-specific functionality (such as checking Deployment IDs for a valid 
deployment URL).

In general:

� Any errors in the Scripting Engine session or generic HTML client layer are 
logged, in detail, in the IES server log. 

A summarized version of the error is passed back and displayed by the Web 
browser.

� Any errors occurring in the survey-specific layer are displayed by the Web 
browser.

If you have set the JTF debug mode on, survey-specific debug messages, as well 
as other debug information, will be logged in JTF-specific server logs.

From a Survey perspective, the Scripting Engine is a set of Java classes on the 
middle tier that receives requests from the JSP layer (including the message to 
launch a script), and processes them. All business logic as determined by the survey 
questionnaire script, custom code or database calls, and respondent actions are 
evaluated by the Scripting Engine, which passes processing information to the JSP 
layer to interpret, which in turn sends information to the Web browser to display. 
Scripting Engine errors are automatically stored in the server and can be viewed 
with the CRM HTML-based server log viewer, regardless of the debug mode.

Errors in the interpretation of the survey questionnaire script, custom code or 
database calls, and respondent actions will automatically store error messages in the 
server and can be viewed with the CRM HTML-based server log viewer. These 
errors are written to the server logs regardless of debug being on or off. Additional 
informational messages are also stored in the server logs when debugging mode is 
enabled.

JSP Layer Errors
The Java Server Pages layer includes a survey functionality component and an 
HTML client component in the middle tier. When a request to process a URL linked 
to a particular survey campaign deployment is received in the middle tier, it is 
evaluated by the survey processing component. This component receives the 
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request, processes it, and validates it. If there is an error (such as invalid 
deployment ID, invalid URL or invalid date due to an expired or inactive 
deployment), the survey processing component generates an error message to be 
sent to the Web browser. The error message is displayed in the Web browser as an 
error page. Viewing the source of the page from the browser may provide 
additional information regarding the error, such as stack trace messages useful for 
troubleshooting. 

If valid, the request is sent to the HTML client component, which sends a request to 
the Scripting Engine. The HTML client component serves as a broker between 
processing occurring in the Scripting Engine and the survey processing component, 
which passes information to the Web browser to display.

8.4.1.3 Server Logging and Debug Mode
Like other Oracle Applications, Oracle Scripting allows error messages—and other 
informational messages—to be logged upon request.

For Oracle Scripting-specific messages, this is accomplished by setting the IES 
system profile setting IES : Debug Mode to Debug on. Details on how to set this 
profile are contained in the section Establishing Common IES Profile Settings.

When Oracle Applications ships, the IES profile setting IES : Debug Mode is null. 
There are two possible values: Debug off and Debug on. Both the unset (null) value 
and the Debug off value result in no logging of debug or other informational 
messages. 

When the profile is set to Debug on, these messages will be logged. For agents using 
Scripting in the interaction center, setting this profile to Debug on will also result in 
numerous error and debug message dialogs appearing upon runtime of the 
Scripting agent application. This mode is typically used to debug issues and is 
generally set to the Debug off value.

The Survey component (the JSP layer) uses pre existing JTF logging facilities to log 
messages in debug mode. Thus, errors related to Scripting or Survey functionality 
may be contained in IES or JTF logs, based on the cause of the error.

8.4.2 Viewing IES Server Logs
Server logs are viewed from the HTML Login URL following the steps below.

Login
HTML Login URL
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Responsibility
Interaction Center Server Log Viewer or Interaction Center Server Manager

Steps
1. Using an Oracle Applications 11i-compliant Web browser, access the 

appropriate login URL. Provide an Oracle Applications user ID and password 
associated with the required responsibility as indicated above.

The Oracle Call Center Technology administration console should appear.

2. In the Log Messages tab, click the Summary Report subtab.

3. Click Server Name and select a server.

4. Click Server Type and select a server type (for example, Scripting), then click 
Go.

Error logs will be listed under the Error column and informational messages 
under the Information column. 

5. To view detailed reports, click the appropriate message type hyperlink.
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Upgrading from a Previous Release

Oracle Scripting release 11.5.6 is a major functional release and includes significant 
improvements and changes. Some of the new features or aspects of Oracle Scripting 
may impact production environments using previous releases of Oracle Scripting 
11i and custom scripts. This section is provided to guide you through the changes 
with minimum impact.

The steps required to migrate any Oracle Scripting 11i environment to release 11.5.6 
include:

� Implementation Upgrade Tasks

� Installation of Updated Script Author

� Converting, Re-Deploying, and Testing Scripts

A.1 Implementation Upgrade Tasks
Implementation upgrade tasks include:

� Upgrading to Oracle Applications 11.5.6 or Later

� Modifying System Profile Settings

� Referencing Custom Java

See Also
� Installation of Updated Script Author

� Converting, Re-Deploying, and Testing Scripts
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A.1.1 Upgrading to Oracle Applications 11.5.6 or Later
In order to use Oracle Scripting 11.5.6, you must upgrade Oracle Scripting to release 
11.5.6 or later. This is accomplished either by executing a Rapid Install for 11.5.6 or 
by upgrading with the appropriate CRM Family Pack for 11.5.6. 

A.1.2 Modifying System Profile Settings
To execute Oracle Scripting in the Scripting Engine agent interface, you must 
change the IES : IES ARCHITECTURE TYPE  profile upon upgrading to release 
11.5.6 or later. The profile options for this system profile setting have changed, as 
has the recommended architecture. 

Guidelines
1. For upgrading to the new Apache Mid-Tier architecture, select the value 

Apache mid tier/Servlet architecture.

2. For using Oracle Scripting 11.5.6 in the Caching Architecture, select the value 
Caching Architecture (replacing Two Tier Mode).

Note that using Oracle Scripting in the Caching Architecture will only be 
supported as follows:

a. For customers previously using this architecture in a production 
environment.

b. For a limited amount of time, as designated by Oracle Support Services, 
and no later than the release of Oracle Applications release 11.5.7.

3. The previous value, Three Tier Mode, has been removed. Do not use this setting 
under any circumstance.

Note: Oracle Applications must generally be at the same patch 
level (for example, release 11.5.6) to function appropriately. 
Upgrading to release 11.5.6 can be achieved using the appropriate 
series of patches that meets your specific application requirements, 
or using the appropriate Oracle Platinum version to support a 
release 11.5.6 upgrade. Appropriate patching is prerequisite of a 
successful Oracle Scripting implementation and is not addressed 
herein. For more information, see OracleMetaLink or contact your 
Oracle Support representative.
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See Also
For more information, see New in this Release > Profile Setting Modifications in the 
introduction to this document.

A.1.3 Referencing Custom Java
There are two types of custom Java used in association with Oracle Scripting:

� Custom Commands

� Custom Java Beans

A.1.3.1 Custom Commands
The most common type is custom Java methods written using Oracle Scripting APIs 
to provide additional functionality to a script using a Command (for example, 
branch actions, embedded values in panel text, statements defining parameters for a 
conditional or indeterminate branch, and so forth).

These Java commands always run in the Java Virtual Machine (JVM) designated by 
architecture type. Thus:

� If using the Caching Architecture, the JVM is provided by JInitiator on the client 
workstation. In this case, your code must be compiled to JDK 1.1.8 or earlier.

If using the Caching Architecture, see Guidelines above for caveats.

� If using the Apache Mid-Tier architecture, the JVM is provided by the Apache 
JServ (which can be JDK 1.1.8, 1.2, or 1.3). The compiling restrictions are based 
on the JDK used by your version of Apache.

The following topics are included in this topic group:

� Referencing Custom Commands in the Caching Architecture

� Referencing Custom Commands in the Apache Mid-Tier Architecture

A.1.3.1.1 Referencing Custom Commands in the Caching Architecture  Using the Caching 
Architecture of Oracle Scripting in releases 11.5.4 and 11.5.5, the appsweb.cfg file 
was required to be modified:

a. To reference custom Java in support of custom commands,

b. To obtain JDBC classes, and 

c. To obtain AOL/J classes.
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Installation of Updated Script Author
If you are upgrading an Oracle Scripting implementation using the Caching 
Architecture, you must still modify the appsweb.cfg file to reference custom Java 
code (as well as to download JDBC classes to the client workstation). Modification of 
the appsweb.cfg file to obtain AOL/J classes is no longer required. For details, see Appendix 
D of the Oracle Scripting Implementation Guide release 11.5.4 or 11.5.5, as appropriate.

A.1.3.1.2 Referencing Custom Commands in the Apache Mid-Tier Architecture  Using the 
new Apache Mid-Tier Architecture, the class path of the jserv.properties file 
on the Apache Web server must be modified to reference custom Java. The 
requirement to upload custom Java classes to the applications server has not 
changed. 

For more information, see Adding Custom Java Class Path to jserv.properties File.

A.1.3.2 Custom Java Beans
The second type of custom Java to support Scripting is custom java code compiled 
in a UI Java Bean that is used to replace an entire panel in the runtime session. This 
is always run by JInitiator, which at this time must be compiled to JDK 1.1.8 or 
earlier. When JInitiator on the client supports JDK later than 1.1.8, this information 
will appear in the Certify section of OracleMetaLink.

A.2 Installation of Updated Script Author
You must install the Script Author component in order to create, modify, or deploy 
scripts to the applications database. Further, any existing (pre-11.5.6) script must be 
converted to an 11.5.6 (or subsequent) version of the Script Author prior to execution 
in the Scripting Engine provided by Oracle Applications 11.5.6 or later.

The method for obtaining the Script Author has changed in release 11.5.6. Details on 
obtaining Script Author for Oracle Scripting release 11.5.6 or later is described in 
detail in the Implementing the Script Author Component section of this document.

Note: If using the Caching Architecture, see Guidelines in this 
section for caveats.

Note: IWhile substitution of an entire panel with a Java Bean is still 
supported, substituting an answer (or panel node) with a Java bean 
is no longer supported as of release 11.5.6 and later.
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See Also
� Implementation Upgrade Tasks

� Converting, Re-Deploying, and Testing Scripts

A.3 Converting, Re-Deploying, and Testing Scripts
When accessing the Script Chooser Forms window to launch a script in the 
Scripting Engine agent interface, all scripts deployed to the database (not just 11.5.6 
scripts) will be listed. Nonetheless, only scripts that have been recompiled in Script 
Author 11.5.6 or later will be executable in the 11.5.6 or later Scripting Engine.

This is true regardless of whether the scripts are launched from an integrated 
application (Oracle TeleSales, Oracle TeleService, or Oracle Collections), or when 
launching in stand-alone mode.

Thus, any previously deployed scripts required to be executed in Scripting Engine 
release 11.5.6 or later must be opened in a matching 11.5.6 or later Script Author, 
converted (by saving), re-deployed, and tested.

Steps
The following is a list of the recommended steps for conversion and redeployment:

1. Determine which scripts in the production environment must be converted 
(i.e., which scripts will be run in the 11.5.6 environment).

2. Prepare a test environment that has the 11.5.6 release of Scripting (including 
the 11.5.6 version of Script Author) installed.

3. For each script identified in Step 1, locate in your script archive (the source 
.script file that was used to deploy the script to the production 
environment).

Note: IEnsure that all scripts to be converted are still supported. 
For example, there are two qualifications:

While substitution of an entire panel with a Java Bean is still 
supported, substituting an answer (or panel node) with a Java bean 
is no longer supported as of release 11.5.6 and later.

Scripts that contain multiple answers in a panel may not use the 
"button" UI type. The only supported use of a button UI type is for 
a panel with a single answer definition.
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4. Make a backup copy of the script.

5. Launch the release 11.5.6 or later version of the Script Author.

6. Open the script file (identified in Step 3 above) in the Script Author. 

The Script Author will warn you that you are converting the script to be 
compatible with the 11.5.6 version of the Script Author only, and if you save 
this script, you will no longer be able to read it with a pre-11.5.6 version of 
the Script Author.

7. Save the converted script.

8. Choose Tools > Deploy Script to re-deploy the script to the test 
environment.

You are now ready to execute this script in the test environment.

9. Run the script in the Scripting Engine agent interface and test the 
re-deployed script.

10. After verifying that no new problems have been introduced, follow the 
same process to re-deploy the script to the production environment.

Note: If you are unable to locate the exact .script file that was 
used to deploy the script currently in use in the production 
environment, you can obtain a copy of this script from the 
production database itself. To do so, from the Script Author, select 
the Database tab of the Open Script dialog to open scripts directly 
from the referenced database.

Note: If you select Save from the Script Author, the pre-11.5.6 
script will be saved in the same location, appended with a file 
extension of .previous. Thus, if the previous script were named 
sample.script, the 11.5.6 version of the script will now be named 
sample.script, and the earlier version will be retained as 
sample.script.previous.

Warning: If you use the Save As command, ensure you provide a 
new name for the converted script, since the <filename>.previous 
copy will not be created. 
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If you discover any issues, correct the script, redeploy, and test until 
successful.

11. Repeat this process for each script identified in Step 1.

Guidelines
To ensure no confusion between source script files, consider creating separate 
folders or directories on the Script Author workstation, identifying scripts by Script 
Author version (at minimum, discriminating between pre-11.5.6 scripts and 11.5.6 
or later scripts). Move any <filename>.previous copies of updated scripts into the 
appropriate pre-11.5.6 directory.

See Also
� Implementation Upgrade Tasks

� Installation of Updated Script Author
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Abbreviations and Acronyms

Abbreviations and Acronyms

Acronym Definition

AIM Application Implementation Methodology

ANI Automatic Number Identification

AOM Application Object Model

API Application Programming Interface

CRM Customer Relationship Management 

CTI Computer-Telephony Integration

DBA Database Administrator

DNIS Dialed Number Identification Service

ERP Enterprise Relationship Planning

GIF Graphics Interchange Format

GUI Graphic User Interface

HR Human Resources

HTML HyperText Markup Language

HTTP HyperText Transfer Protocol

HTTPS HyperText Transfer Protocol – Secure

IG Implementation Guide
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Product-Related Acronyms

JAR Java Archive

JDBC Java Database Connectivity

JDK Java Development Kit

JSP Java Server Pages

JTF Java Technology Foundation

JVM Java Virtual Machine

PL/SQL Programming Language/Structured Query Language

SID System Identifier

SQL Structured Query Language

sysadmin Systems Administrator

UI User Interface

URL Uniform Resource Locator

Acronym Definition

AI Oracle Advanced Inbound

AO Oracle Advanced Outbound

eMC Oracle eMail Center

HRMS Oracle Human Resources Management System

ICX Internet Cartridge Exchange

IH Oracle Interaction History

OES Oracle Email Server

OTM Oracle Telephony Manager

OTS Oracle TeleSales

OMO Oracle Marketing Online

Acronym Definition
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Oracle Product Designations

Acronym Definition

AMS Oracle Marketing Online

IEO Oracle Interaction Center Technology

IES Oracle Scripting

IEM Oracle eMail Center

JTF_FM Oracle One-to-One Fulfillment

OES Oracle Email Server
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Glossary

Campaign

A focused effort to achieve a particular goal from a targeted population over a 
specific period of time for a particular business purpose. 

CRM Resource Manager

Oracle CRM Resource Manager is a responsibility included with a Rapid Install of 
Oracle CRM Applications so that HRMS person types (most often, employees) 
required by Oracle products can be created. It does not have the full functionality of 
HRMS. Note that if HRMS is installed, HRMS employees must be created using that 
tool and cannot be created with CRM Resource Manager.

Cycle

A Cycle is a repeatable survey event, utilizing the same script. Multiple cycles will 
also allow the same survey to be given through different media types, when 
supported. Multiple cycles are typically used to measure the same characteristics at 
a different moment in time. 

Deployment

An instance of a survey and cycle within a survey campaign; this refers to a single 
instance or execution of a survey campaign; for list-based deployments this refers to 
a specific set of lists and templates. 

eBusiness Center login

One of the names for the HTML-based login screen to access CRM applications built 
on the JTF technology stack. Sometimes referred to as the JTF login. 
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Error Page

This survey resource is a JSP file (or pure HTML with a JSP file extension) that 
displays as a full page any time an error results during survey participation (when a 
respondent is taking a survey). For example, an error might occur if a resource is 
unavailable, the script designated by the survey campaign information is not 
loaded, or other unexpected conditions are encountered. This page may contain 
graphics in GIF or JPEG format.

Final Page

This survey resource is a JSP file (or pure HTML with a JSP file extension) that 
displays after the last panel in the survey questionnaire has been viewed by the 
survey respondent, It typically includes a thank-you message to the survey 
respondent, and indicates to the survey respondent that the survey has ended 
successfully. This page may contain graphics in GIF or JPEG format, and optionally 
may contain a hypertext link, for example to the enterprise’s home page.

Header Page

This survey resource is a JSP file (or pure HTML with a JSP file extension) that 
displays at the top of each page throughout the survey session, except the Error and 
Final pages). Just below the Header, the content placed in the panel text editor for 
that panel (if any) will display, followed by all answer definitions in the panel (each 
in its own horizontal row). The Header Page often contains corporate logos or other 
standardized graphics in GIF or JPEG format.

Oracle HRMS

Oracle HRMS is a full-featured enterprise Human Resources Management System. 
It is an ERP application using Oracle Forms technology to manage human resources 
used by a variety of ERP and CRM applications.

Invitation

An e-mail message, inviting potential survey respondents to participate in the 
survey. Each e-mail message contains a customized link to the specified survey.

JTF Login

One of the names for the HTML-based login screen to access CRM applications built 
on the JTF technology stack. Sometimes referred to as the eBusiness Center login. 

List

The list of potential survey respondents who will receive an invitation to participate 
in the questionnaire. List members may also receive reminders to participate in a 
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survey, which includes the survey end date. Lists are built using OMO’s List 
Management feature. Use of list-based surveys requires OMO.

Reminder

An e-mail message, reminding potential survey respondents (already invited to take 
a survey) of the last day to participate. For anonymous deployments, all list 
members will receive reminders. For non-anonymous deployments, only list 
members who have not yet responded will receive reminders.

Respondent

An individual responding to a request for information (in the form of participating 
in a questionnaire). For list-based survey campaigns, respondents are list members 
who responded to an e-mailed invitation to participate in the survey.

Sample

The population from which information is solicited by survey.

Script

This file (built using the Script Author component of Oracle Scripting) contains the 
business rules and text for the single script (for the agent interface) or survey 
questionnaire (for the Web interface) employed by a given survey campaign.

Survey Campaign

Using the Survey component, this is the super class that contains the Script object, 
the Cycle objects, and Deployment objects. The actual questions/answer choices are 
defined in the Script. 

Survey Questionnaire

Set of questions built using the Script Author component of Oracle Scripting for 
execution in the Scripting Engine as a survey questionnaire, typically to gather 
feedback, obtain market data, tabulate opinion, measure satisfaction, or otherwise 
collect data directly from specific (customers, employees, prospects) or non-specific 
target populations.

Survey Resource

One of four JSP-format files (or pure HTML files saved with a JSP file extension) 
that provide functionality to a survey when executed in the HTML GUI. For 
list-based survey campaigns, these are the Header Page, Error Page, and Final Page. 
The Header displays as the top of each HTML page. The Final Page is displayed 
after a survey questionnaire has been completed, whereas the Error Page is reached 
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when an error condition in taking the survey occurs. For iSupport hosted survey 
campaigns, there is a separate Error page. These are uploaded into the $OA_HTML 
directory on the applications server and are served by the Web server as 
appropriate.

SYSDATE

This refers to the current Systems Date of the database. When creating records in a 
database the SYSDATE is typically time-stamped as creation date, and SYSDATE is 
also used as a default setting for creating responsibilities from an Oracle 
Applications perspective.

Template

A "mail-merge" template, built using Oracle One-to-One Fulfillment. Templates are 
employed by the Survey component of Oracle Scripting for invitations and 
reminders to participate in a survey. A template includes an associated query and 
also identifies the Fulfillment Master Document into which to perform a merge 
prior to sending to the Fulfillment server.
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